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The Adobe PhotoshopTM program is photo-retouching, image-editing and color
painting software for the novice and professional alike. This guide describes the 
Adobe Photos hop program, from its basic functions to its advanced photodesign 
and color printing features. 

The book contains six sections. 

Section 1: Getting Started 

Section 1 explains how to start using Adobe Photos hop software, including how 
to create new documents, open and save documents, and work with several 
documents open at once. The section explains the different image types and for
mats with which the Adobe Photoshop software works. 

Chapter I, "Managing Documents," describes the steps involved in creating new 
Adobe Photoshop documents, opening existing documents and documents 
saved in other file formats, and saving documents in the Adobe Photoshop 
format and in other file formats. The ability to save in a variety of file formats 
allows you to use images created or edited in Adobe Photoshop software in other 
application programs and on other computer platforms. 

Chapter 2, "Scanning, Importing, and Exporting Images," discusses how to scan 
images, and how to import documents and export Adobe Photoshop documents 
so the documents can be used on other computer platforms and in other appli
cations. 

Section 2: Using the Adobe Photoshop Toolbox 

Section 2 describes the Adobe Photos hop toolbox and gives a detailed description 
of how the tools work. 

Chapter 3, "Managing the Toolbox," gives a brief overview of all the tools in the 
toolbox and how they work. 

Chapter 4, "Controlling the Artwork and Screen Display," describes how to zoom 
in and out from an image for a more detailed or greater view, scroll through a 
window, change the window display, and use rulers to make measurements on 
an image. 

Chapter 5, "Using the Painting Tools," explains how to use the painting tools to 
alter an image or to create original artwork. The painting tools include the pencil 
tool, line tool, paint brush, paint bucket, and airbrush tools. 

Chapter 6, "Using the Editing Tools," covers how to use the editing tools to 
retouch or customize an image. The editing tools include the eraser, the smudge 
tool, the blur tool, and the sharpen tool. 
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xvi User Guide 

Chapter 7, "Painting and Editing Tool Options," explains additional features 
common to the painting and editing tools that allow you to choose a brush shape 
for each tool and specify the opacity (transparency) of the paint used by the tool. 

Chapter 8, "Using the Type Tool," explains how to add type to an image to create 
a poster or special effect, and it covers how to choose a type font, size, and type 
styles. 

Chapter 9, "Making Selections," covers various selection techniques including 
using selection commands and tools and their options to select part of an image 
based on the similarity of pixel colors. 

Chapter 10, "Using the Fill Tools," describes how to fill part of an image. It also 
explains how to select colors to paint and fill an image with a solid color. 

Chapter 11, "Selecting Colors," includes the various ways to select the foreground 
and background colors that are used by the Adobe Photoshop program tools, 
including from an image, and from either the Color Picker or the Color Wheel 
dialog box. 

Section 3: Basic Image Editing 

Section 3 covers how to edit an image, including how to cut, copy, paste, resize, 
and transform images. 

Chapter 12, "Cutting and Pasting Selections," shows how to cut, copy, and paste 
a selection within an image. Pasting instructions include pasting a selection inside 
and behind another selection, and using paste controls to determine precisely 
how a selection appears when it is pasted onto an image. 

Chapter 13, "Transforming Images" discusses how to transform an image by 
rotating, skewing, or stretching. 

Chapter 14, "Resizing Images" describes how to crop an image to eliminate extra
neous portions, and resize and change the resolution of an image. 

Section 4: Advanced Image Editing and Color Correction 

Section 4 describes how to convert images to different image types,! make color 
corrections, edit an image's color table, and changing the color levels of pixels. It 
also describes how to use filters to modify images. 

Chapter IS, "Converting Images and Working with Channels," describes how to 
convert images of one type to another in preparation for printing the image, how 
to edit a document's color table to adjust or correct the colors in an image, and 
how to manipulate an image's channels, or further alter the image. 

Chapter 16, "Making Color Corrections," discusses the procedures for changing 
the colors in an image by comparing or mapping the colors of pixels in the image 
to other colors. This chapter also contains information on how you can use the 
Adobe Photoshop program to adjust the color levels of pixels. Included are the 
procedures to adjust the brightness, contrast, and gamma in an image. 
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Chapter 17, "Using Filters to Modify Images," describes the many filters available 
with Adobe Photoshop software to alter an image, and how to use them. It 
explains how to use filters to soften, sharpen, offset, outline, and brighten an 
image, and create such special effects as adding noise. It also describes how to 
create a custom filter. 

Section 5: Printing Images 

Section 5 explains the procedures for printing images, including printing half
tones and color separations. 

Chapter 18, "A Printing Overview," introduces basic concepts of printing and 
how to prepare an image for printing. It explains how to print a halftone of a 
gray-scale image, including the ability to print registration and crop marks, 
calibration bars, borders, and labels on images .. 

Chapter 19, "Printing Halftones, " explains in detail how to print a halftone of a 
gray-scale image. It shows how to specify the screen frequency and angle, and 
how to specify the dot shape used for the screen. This chapter also explains how 
to make calibrations to compensate for different printers and printing presses. 

Chapter 20, "Producing a Color Separation," covers the procedures for printing a 
four-color separation of a color image. The chapter explains how to calibrate the 
image to be printed using the on-screen display, and how to compensate for 
density changes on the output device. It also explains how to make the required 
calibrations of the four separations, and how to compensate for different printers 
and printing presses. 

Chapter 21, "Tips and Troubleshooting," contains tips and techniques as well as 
solutions to problems you may encounter when making color corrections, print
ing images, using the Adobe Photos hop program, and using the program in con
junction with the Adobe Illustrator'" program. 

Section 6: Reference Material 

The Appendix, "Photoshop Color Swatches," contains color swatches for adjust
ing the color displayed on your monitor. The Glossary defines terms used 
throughout the user guide. 

Before beginning to use the Adobe Photoshop program, you should set up your 
Macintosh and be familiar with its use. You should know how to use the mouse 
and standard Macintosh menus. If you need to review these techniques, refer to 
your Macintosh documentation. 
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Introduction 

Welcome to the Adobe Photoshop program. 

A darkroom on the desktop, the Adobe Photos hop program is extraordinary 
photo-retouching, image-editing, and color painting software for pixel-based 
images. Whether you are a professional or a novice, with the Adobe Photoshop 
program you'll quickly be able to enhance, retouch, and compose scanned 
images, original artwork, and other pixel-based graphics on the Macintosh. 

The Adobe Photoshop program is a sophisticated graphics application program 
designed to allow graphic artists, photographers, desktop publishers, and other 
people who work with graphic images to create and manipulate digital images. 
You can use Adobe Photoshop tools and commands to paint new images or re
touch existing digital images that were created by a scanner, video capture equip
ment, or some other means. 

The Adobe Photoshop program supports a variety of pixel-based images in more 
than a dozen formats. As a result, the Adobe Photoshop program is a versatile, 
powerful tool useful in applications from photo retouching and color separation 
to animation, and on a variety of platforms, from monochrome to 32-bit color 
systems. 

You'll find that the Adobe Photos hop program excels as an art production tool, 
whether you are an art director or electronic publisher who needs to merge and 
edit color images, a photographer who wants to retouch proofs, or a graphic de
signer who is creating original or composite artwork including collages and photo 
montages. The software is equally useful to printers and service bureaus that want 
to generate color separations, to animators who want to colorize images and pro
duce audio-visual materials quickly, and to artists who want to create new art
work using the latest media and tools. 

With the Adobe Photoshop program, you work with bitmapped images that are 
composed of a series of dots or picture elements ("pixels"). When you "paint" in 
a pixel-oriented program like Adobe Photoshop, you change the colors of pixels. 
The number of colors that you can work with at a time depends on the amount 
of color information available for each pixel. On an 8-bit color system, a maxi
mum of 256 different colors can be displayed simultaneously. On a 24- or 32-bit 
color system, over 16 million different colors can be displayed at one time. The 
amount of information lIsed for each pixel affects the file sizes of images: a 24-bit 
RGB image has three times as much information as an 8-bit gray-scale version of 
the same image, and so takes up three times as much disk space. 

You can use the Adobe Photos hop tools to create an original image, while image 
processing functions allow you to edit scanned and other digitized images. With 
the painting tools in the Adobe Photoshop program, you can add lines to an 
image, fill an image with color, and spray-paint on parts of an image as if you 
were using an airbrush to retouch a photograph. 

1 
Petitioner Exhibit 1026 Page 21



You can edit images in many ways. You can crop images and perform transfor
mations on images, such as rotating, skewing, and flipping. You can also use the 
many filters in the Adobe Photos hop program to modify images by sharpening 
and blurring an image, and creating mosaic and facet effects. 

Adobe Photoshop software allows you to perform color correction on images, too. 
You can adjust the levels of color in an image, as well as the brightness and 
contrast. You can also use the Adobe Photoshop program to change the resolu
tion at which the image is printed on a printer or film recorder, or output to some 
other media. 

I 
When you are ready to generate a hard copy of an image, the Adobe Photoshop 
program includes the ability to create and print halftones and colo~ separations. 
You can automatically convert images that are in the RGB (red, green, and blue) 
format, which is commonly used to display images on-screen, into [the CMYK 
(cyan, magenta, yellow, and black) format used to print images on a printing 
press. I 
Image types that the Adobe Photoshop program supports include bit mapped, 
gray-scale, indexed color, RGB, CMYK; and hue, saturation and brightness (HSB); 
hue saturation, and luminance (HSL), and multichannel images. Supported 
image formats include the default Photoshop and Raw formats; formats suitable 
for graphics and page layout applications including EPS, MacPaint®, PICT, Pixel
Paint®, and TIFF formats; those useable by PIXAR workstations, Scitex image
processing, and Commodore Amiga computers; a format for Targa video boards; 
and a format for ThunderScan. I 
The Adobe Photos hop program stores images in channels, similar in concept to 
a plate in a four-color (four-plate) printing process. A bitmapped irrlage and gray
scale image are single-channel images; RGB, HSL, and HSB images have three 
channels; CMYK images have four channels. In addition, alpha channels can be 
added to an image to manipulate the image and store masks. 

Throughout this user guide, references are made to adjusting color levels. For the 
sake of conSistency, this term applies to all image types, whether color or gray
scale. 

Wh tyou need 

2 User Guide 

• Macintosh II, IIx, IIcx, llci, SE, or SE/30 

• Hard disk 

• 2 megabytes random-access memory (RAM) 

• Apple system software version 6.0.2 or later 

In addition, a gray-scale or color monitor is recommended, and a Macintosh
compatible scanner is optional. 
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Using this book 
This book is divided into six sections. For information about creating new docu
ments, opening, closing, and saving documents, you should read the chapters in 
Section 1, "Starting Out Using the Adobe Photoshop Program." If you are inter
ested in learning how to use the painting, editing, fill, selection, and other tools 
to create an original image or edit an existing image, you should read the chapters 
in Section 2, "Using the Adobe Photoshop Toolbox." 

For information about basic image editing, see Section 3, "Basic Image Editing." 
To learn how to make color corrections in an image and perform advanced image 
editing, you should read the chapters in Section 4, "Advanced Image Editing and 
Color Correction." If you want to know how to output an image, you should read 
the chapters in Section 5, "Printing Images." Section 6, "Reference Material" in
cludes the Photoshop Color Swatches, the Glossary and the Index. 

The Adobe Photoshop program package 
The Adobe Photos hop program package contains 

• The program disk 

• The tutorial disk, containing two sample images 

• A program disk containing software designed by third-party software 
developers 

• The calibration disk 

• Adobe Photoshop User Guide 

• Adobe Photos hop Tutorial 

• The Adobe Photoshop Quick Reference Card 

• Registration card and envelope 

Registration 
Adobe Systems wants to keep you informed of the latest changes and improve
ments made to the Adobe Photoshop program and provide technical support if 
needed. To do that, we need to know who you are. Please fill out the enclosed 
registration card and mail it to us. 

You must send in your registration card to receive technical support. The card 
also lists ownership benefits. 

Third-party development 
Adobe Systems is interested in working with third-party software developers on 
the continual enhancement of the Adobe Photoshop program. 

If you are interested in writing a plug-in module to support your input or output 
device, or in adding additional file formats, please contact Adobe Systems. 
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Section 1: Getting Started 
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Beginning with a scan of grape leaves, the artist selected individual elements to paste 
into the new design . The Feather command was used to soften the edges of the 
selections. The Rotate and Paste Into commands were used to position the elements. 

The background was created by first converting a copy of the grape leaves image to 
gray-scale. The gray-scale image was then pasted on top of the original color image of 
the grape leaves. Paste controls were used to make the gray-scale image slightly 
transparent, allowing some of the original color to show through. 

~. 
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(' Chapter 1: Managing Documents 

Adobe Photoshop software works with original artwork or with existing images 
that were created by other applications or digitized by a scanner, video camera, 
or other means. Whether created or imported into the Adobe Photoshop pro
gram, images are stored as documents and displayed within windows. To use the 
Adobe Photoshop images included on your tutorial disk, you simply open the 
images. 

This chapter explains how to begin using the Adobe Photoshop program, and 
how to open, save, and manage image documents. 

To work with an image, you open the document that contains the image. The 
document displays the image in a window. 

Before you start to use the Adobe Photos hop program, turn on your computer 
and check to make sure that you have everything you need. See "What you 
need," in the Introduction earlier in this guide for a description of the require
ments. 

Make a backup copy of the program disk that you can work with. If you need help 
making a backup copy, see your Macintosh user guide for instructions. Use the 
backup copy to install the Adobe Photoshop program on your hard disk. 

Double-click on the Adobe Photos hop program disk icon on the desktop. The first 
time you start the program, a dialog box appears asking you to personalize your 
copy of the program. 

Please personalize your copy of Adobe PhotoshopTt': 

Name: II 
~==============~ 

Organization: I 
~========~----~ 

Serial # :1 L-_______ ----' 

OK Cancel 

Type your name and the name of the organization you work for, if applicable. 
Enter the serial number listed on your Adobe Photos hop registration card or 
manuals, and click OK. 
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Adobe Photoshop software works with original artwork or with existing images

that were created by other applications or digitized by a scanner, video camera,

or other means. Whether created or imported into the Adobe Photoshop pro-

gram, images are stored as documents and displayed within windows. To use the

Adobe Photoshop images included on your tutorial disk, you simply open the
images.

This chapter explains how to begin using the Adobe Photoshop program, and

how to open, save, and manage image documents.

To work with an image, you open the document that contains the image. The

document displays the image in a window.

Before you start to use the Adobe Photoshop program, turn on your computer

and check to make sure that yOu have everything you need. See ”What you

need,” in the Introduction earlier in this guide for a description of the require-
ments.

Make a backup copy of the program disk that you can work with. If you need help

making a backup copy, see your Macintosh user guide for instructions. Use the

backup copy to install the Adobe Photoshop program on your hard disk.

Double-click on the Adobe Photoshop program disk icon on the desktop. The first

time you start the program, a dialog box appears asking you to personalize your

copy of the program.

Please personalize your copy of Hdohe Photoshop”:

 
Type your name and the name of the organization y0u work for, if applicable.

Enter the serial number listed on your Adobe Photoshop registration card or
manuals, and click OK.
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6 User Guide 

When you first start out using the Adobe Photoshop program, you are asked to 
create a preferences file . The preferences file holds the preference sJttings you 
choose in the Adobe Photoshop program. The preference settings int lude the sep
aration setup information, display options, and options for exportihg informa-

I 

tion to the Clipboard. The settings you save are used in all Adobe Photoshop 
documents. \ 

I You can change the name of the file as well as its location. You shopld keep the 
I preferences file in a separate folder outside of the System folder. The location of 

\ 

the preferences file governs which hard drive the Adobe Photos hop program uses 
for virtual memory. If your system does not have enough random-actess memory 

I (RAM) to store large documents, Adobe Photoshop uses virtual meniory, which 
accesses the hard disk, to automatically write and read image data t6 and from 

I 
your hard disk. Make sure that you locate your preferences file on a disk that has 

I enough space and speed for your needs. \ 

The location of the preferences file also determines where the Adobe Photoshop 
program looks for plug-in modules. Plug-in modules are third-party Iideveloped 
programs that extend the capabilities of the Adobe Photoshop program to 
interface with new scanners and non-standard printers, to support additional file 
formats, and to include advanced, special effects filters. \ 

The first time you use the Adobe Photoshop application, a dialog box appears, 
asking you to locate the preferences file. 

To create a new preferences file: 

1.11 ~~::::w;s dialog box appears. 

2 Use the drive and directory buttons (if necessary) to choose where you want to 

\ 
store the file. I 

3 As an option, type the desired name for the preferences file. By default, the file 
is named lipS Prefs." 

4 Click Save. 
~ 

A new preferences (PS Prefs) file is created and stored in the specified location on 

disk. \ 

When you start and quit the Adobe Photos hop program, the software looks for 
the preferences file. If the preferences file has been moved from the Ialst location 
where the program found it, a dialog box appears, asking you to locate the file . 
I I 
ITo locate the preferences file: 

1. Iuse the drive and directory buttons to locate the preferences file. 

2. e liCk the preferences file name. 

3. Click OK. 
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The Adobe Photos hop program will store the location of the preferences file and 
access the file automatically when you start up the application in the future. 

After you have performed these preliminary steps, the Adobe Photoshop program 
startup screen appears, followed by the program's desktop. 

~~ Q. 
~T 
~ IF: '" ~~ 
6?' (1 

.z(. .I 
£tJ 
6 /j 

~ 
I~LlOI 

You are ready to open a document and start working. 

Opening images 
Images that you are not currently working on are stored in documents on disk. 
When you work on an image in the Adobe Photoshop program, the image is nor
mally displayed inside a window. 

The Adobe Photoshop program opens and displays all documents at 72-dpi 
screen resolution. This may cause a document to appear enlarged on-screen if the 
resolution of the original image is greater than 72 dpi. For example, a document 
that you scanned in at 300 dpi will be displayed at 72 dpi and therefore, will 
appear larger on-screen; however, the document will print at the same size as the 
original image. 

Opening a new document 

When you create a new Adobe Photos hop document, you can specify the size of 
the overall image area, the image's resolution, and whether you want to create a 
gray-scale or an RGB color image. 
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You are ready to open a document and start working.

Opening images

Images that you are not currently working on are stored in documents on disk.

When you work on an image in the Adobe Photoshop program, the image is nor-

mally displayed inside a window.

The Adobe Photoshop program opens and displays all documents at 72-dpi

screen resolution. This may cause a document to appear enlarged on-screen if the

resolution of the original image ls greater than 72 dpi. For example, a document

that you scanned in at 300 dpi will be displayed at 72. dpi and therefore, will

appear larger on-screen; however, the document will print at the same size as the

original image.

Opening a new document

When you create a new Adobe Photoshop document, you can specify the size of

the overall image area, the image’s resolution, and whether you want to create a

gray-scale or an RGB color image.
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Resolution, here, refers to the number of pixels per inch that are used in the 
image. This "image resolution" determines how much information is used in the 
image and how much information will be sent to the printer when you print it. 
The image resolution is measured in pixels per inch, whereas the resolution of 
output devices (such as printers) is measured in dots per inch (dpi). You can out
put images at resolutions of more than 2500 dpi on an imagesetter, but you nor
mally won't use an image resolution that high because the printer doesn't require 
that much information to produce high-quality results. In addition, an image at 
a resolution of 2500 dpi would result in a document probably several hundred 
megabytes in size. 

The resolution you specify for new documents affects the amount of lin formation 
used in the document, which in turn affects the quality of the output and the 
amount of disk and memory space the document requires. By default, the Adobe 
Photoshop program selects RGB color as the image type, 512-pixels-by-512-pixels 
for the width and height, and 72 pixels per inch for the resolution. If you cut or 
copy a selection in an existing image and then create a new document into which 
you will paste the selection, the dimensions of the selection on the Clipboard are 
automatically entered in the Width and Height text boxes. 

When you specify the size and resolution, you can also specify the units of mea
sure you want to use. For the width and height, you can choose pixels, inches, 
centimeters, points, picas, or columns as the units. You can choose either pixels 
per inch (pixels/inch) or pixels per centimeter (pixels/cm) as the units for the 
resolution. 

The current background color displayed in the toolbox becomes the background 
color for your new image. 

To create a new Adobe Photoshop document: 

1. Choose New from the File menu. 

The New dialog box appears. 

New ... 

Width: 

Height: 

Resolution: 

Mode: 

I (piHels) 

.-----......,11 (piHels) 

'---__ --'II (piHels!inch) 

o Gray Scale 
@ RGD Color 

n OK D 
( cancel) 
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Resolution, here, refers to the number of pixels per inch that are used in the

image. This "image resolution” determines how much information is used in the

image and how much information will be sent to the printer when you print it.

The image resolution is measured in pixels per inch, whereas the resolution of

output devices [such as printers) is measured in dots per inch (dpi). You can out-

put images at resolutions of more than 2500 dpi on an imagesetter, but you nor-

mally won’t use an image resolution that high because the printer doesn’t require

that much information to produce high-quality results. In addition, an image at

a resolution of 2500 dpi would result in a document probably several hundred

megabytes in size.

The resolution you specify for new documents affects the amount of information

used in the document, which in turn affects the quality of the output and the

amount of disk and memory space the document requires. By default, the Adobe

Photoshop program selects RGB color as the image type, SlZ-pixels-by-S 12-pixels

for the width and height, and 72 pixels per inch for the resolution. If you cut or

copy a selection in an existing image and then create a new document into which

you will paste the selection, the dimensions of the selection on the Clipboard are

automatically entered in the Width and Height text boxes.

When you specify the size and resolution, you can also specify the units of mea-

sure you want to use. For the width and height, you can choose pixels, inches,

centimeters, points, picas, or columns as the units. You can choose either pixels

per inch (pixels/inch] or pixels per centimeter (pixelsfcm) as the units for the
resolution.

The current background color displayed in the toolbox becomes the background

color for yOur new image.

To create a new Adobe Photoshop document:

1. Choose New from the File menu.

The New dialog box appears.

New...

width: 5l2

Height: 512

Resolution: '22 (pixels/inch]

Mode:

O Gray Scale
(é) HEB Color
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2. To change the default settings, click Gray Scale if you want to create a gray-scale 
image. 

3. To select the units of measure, position the pointer on the box beside the param
eter you want. Press down the mouse button. 

A pop-up menu appears. 

4. Holding down the mouse button, drag to highlight the units you want. Release 
the mouse button. 

5. To enter values for the parameters, type a value for the width in the Width text 
box, and press the Tab key. 

6. Enter a value for the Height in the Height text box, and press the Tab key. 

7. Enter a value for the desired resolution in the Resolution text box. 

8. When you have finished defining the parameters for the new image, click OK. 

A new, untitled document appears. 

Opening existing documents 

To open existing Adobe Photos hop documents as well as documents saved in 
other file formats in the Adobe Photos hop format, follow these steps. 

1. Choose Open from the File menu. 

The Open dialog box appears. 

161 Photoshop Images I 
D Faucet ~ c::::J HD 100 

D Fire Engine 
D Flowers 
D Horses Driue 
D Koala 
D Machine 
D Ram Open 

Cancel 

File Format: Photoshop nOK 

2. Use the drive and directory buttons, if necessary, to locate the folder that con
tains the document you want to open. 

3. Click the document. 

4. Click Open. 
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2. To change the default settings, click Gray Scale if you want to create a grayuscale

.— image.

3. To select the units of measure, position the pointer on the box beside the param-

eter you want. Press down the mouse button.

A pop-up menu appears.

4. Holding down the mouse button, drag to highlight the units you want. Release
.m. the mouse button.

5. To enter values for the parameters, type a value for the width in the Width text

" box, and press the Tab key.

6. Enter a value for the Height in the Height text box, and press the Tab key.

7. Enter a value for the desired resolution in the Resolution text box.

" 8. When you have finished defining the parameters for the new image, click OK.

A new, untitled document appears.

Opening existing documents

To open existing Adobe Photoshop documents as well as documents saved in

._. other file formats in the Adobe I’hotoshop format, follow these steps.

1. Choose Open from the File menu.

The Open dialog box appears.

H (:7 Photoshop Images

D Faucet

._. D Fire Engine
D Flowers
El Horses
D Koala

D Machine
D Flam

File Format: Photoshop

 
2. Use the drive and directory buttons, if necessary, to locate the folder that con'

" tains the document you want to open.

3. Click the document.

4. Click Open.
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Resizing a newly opened document 

If the image you open appears enlarged, you may want to resize it to print the 
image at its original size or to view the entire image on-screen. 

I 
To display the current dimensions of the image, position the pointer on the size 
box in the lower-left corner of the image, and Option-click. If the dimensions of 
your image have changed, you can change the image size using the Size/Ruler 
option in the Page Setup dialog box in the File menu; the option ",\ill cause the 
image to print at its accurate size, but will not affect how the image appears on
screen. If your image has been enlarged and you would like to see the entire image 
on-screen, use the zoom tools. 

It is recommended that you do not use the Resample command in the Image 
menu to resize the newly opened image, because you could alter the pixel infor
mation in the image and irretrievably lose image information. For more informa
tion about the resampling feature, see "Resampling images precisely," in Chapter 
14, "Resizing Images." 

Working with multiple documents 

10 User Guide 

You may sometimes want to have several Adobe Photoshop documents open at 
the same time and switch back and forth between them. Alternating between 
windows can be useful when you want to compare two versions of the same 
image or use one image to correct the color in another. 

Only one document can be the active window at a time. You can work only in 
the active window, with the exception of when you use the eyedropper tool. The 
eyedropper tool is unique because it allows you to select colors from an inactive 
document window without activating the window. To switch between windows, 
you can click on the window you want to activate, or you can choose the window 
you want to activate from the Window menu. I 

To select the active window when working with multiple documents: 

1. Select any of the tools in the toolbox except the eyedropper tool. 

2. Click the window you want to activate; or choose the desired window from the 
Window menu. 

J 
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Saving documents 
When you save a new document for the first time, you specify the name of the 
document and where on disk you want to store it. You should save a new docu
ment at an early stage to preserve the work you have done on it. You should also 
save existing documents periodically to protect the changes you made. 

By default, all new documents are saved in the Adobe Photoshop file format . 

To save a document: 

1. Choose Save from the File menu. 

If the document has never been saved, the Save As dialog box appears. 

161 Photoshop I mages I 
~'.) Hw:e1 ;Q: 
D rin> t rl9ifH1 

D n DWU$ 

D HOrH~$ 
,'~ Knnh 
~'.) M<H h i m~ 

Saue this document as: 

IlimUl@1 

File Format: I Photoshop 

2. Type a name for the document. 

=HD 100 

Driue 

Saue 

Cancel 

3. Use the drive and di rectory buttons (if necessary) to choose where you want to 
store the document. 

4. Click Save. 

The document is saved on disk with the specified name and in the specified 
location. 
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Saving documents

When you save a new docrlment for the first time, you specify the name of the

document and where on disk you want to store it. You should save a new docrr-

ment at an early stage to preserve the work you have done on it. You should also

save existing documents periodically to protect the changes you made.

By default, all new documents are saved in the Adobe l’hotoshop file format.

To save a document:

1. Choose Save from the File menu.

if the document has never been saved, the Save As dialog box appears. 

a Photoshop Images

i: Faucet

1'); Fire angina
if: flowers Eugecia'x. . ‘ .

use we Brine
if: Kassie

El": Mai nine

Save this document as:

File Format: Photoshop
 

2. Type a name for the document.

3. Use the drive and directory buttons (if necessary) to choose where you want to
store the document.

4. Click Save.

The document is saved on disk with the specified name and in the specified
location.
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Saving a copy of a document 

You can also automatically create and save copies of a document using the Save 
As command. The Save As command also allows you to save Adobe Photoshop 
format documents in other file formats. For information about saving documents 
in other file formats, see the section, "Exporting images," in Chapter 2, "Scan
ning, Importing, and Exporting Images." 

To save a copy of a document: 

1. Choose Save As from the File menu. 

The Save As dialog box appears. 

2. Type a name for the copy. 

3. Use the drive and directory buttons (if necessary) to choose where you want to 
store the copy. 

4. Click Save. 

A copy of the active document is saved on disk with the name and in the location 
you specified. 

Closing documents 
When you have finished working on a document, you can close it to store it. If 
you close a document that contains unsaved changes, an alert dialog box will ap
pear to ask if you want to save the changes. Click No to close the document and 
discard any changes you made since you last saved the document. Click Cancel 
to resume working on the document. Click Save to save the changes. If the doc
ument has never been saved in the Adobe Photoshop file format, the Save dialog 
box will appear. 

To close a document, choose Close from the File menu, or click the close box on 
the active window. 

Quitting the Adobe Photoshop program 

12 User Guide 

When you have finished using the Adobe Photoshop program, choose the Quit 
command from the File menu. If there are any documents open that contain un
saved changes, the program will prompt you to save the changes. 
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Chapter 2: Scanning, Importing, and Exporting Images 

Images can be brought into the Adobe Photoshop program by scanning a photo
graph, slide, or image, or by importing electronic artwork created with a drawing 
program. You can import an image document in one format, and export it in 
another, depending on your needs. As a result, you can easily transfer Adobe 
Photoshop documents to other applications and computer platforms. 

You can save Adobe Photoshop documents as encapsulated PostScripfID files or 
TIFF documents, then place the documents in your page layout program. You can 
also export Adobe Photoshop documents in formats that can be read by IBM®
compatible and Commodore Amiga® computers, PIXAR® workstations, and 
Scitex® image-processing systems. 

Scanning images 
The Adobe Photoshop program in conjunction with certain brands of scanners 
allows you to control the process through which a hard copy of an image, such 
as a photograph or a slide, is converted into a digital image. 

Adobe Photoshop software directly interfaces with any scanner that has an Adobe 
Photos hop-compatible scanner driver. Check with your scanner manufacturer to 
determine the compatibility of your scanner driver. 

To install the desired driver, simply drag it into the same folder that contains your 
Adobe Photoshop preferences file; this folder should not be the System folder. All 
plug-in modules are loaded when the Adobe Photos hop program starts. So if the 
Adobe Photos hop program is running when you install the plug-in module, you 
must quit the program and restart it. 

If the scanner you are using does not have an Adobe Photos hop-compatible 
scanner driver, you can use the manufacturer's software to scan your images, save 
them as TIFF or PICT files, and import them into the Adobe Photos hop program. 

Importing images 
The Adobe Photoshop program allows you to import documents in 14 formats in
cluding Photoshop, Raw, EPS, TIFF, PICT File, PICT Resource, Amiga IFF/ILBM, 
CompuServe GIF, MacPaint, PIXAR, Pixel Paint, Scitex CT, TGA (Targa), and 
ThunderScan. You can also import documents in file formats that the Adobe 
Photoshop program does not support by using a plug-in module for the format. 
Plug-in modules are discussed later in this chapter in the section "Using plug-in 
modules to import and export images." 

If the four-character code, called the "file type," is set correctly, you can use the 
Open command to open the document, and Adobe Photoshop will automatically 
select the correct file format. 
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You should use the Open As command if you know that the file type of the 
document is incorrect and you want to open the document in the correct format, 
or if you want to open a document in the Raw format. As an example, if you 
transfer a TIFF document from an MS-DOS® system to the Macintosh, the file 
type of the document is often TEXT instead of the correct TIFF. In this case, you 
should use the Open as command to open the file as a TIFF document in the 
Adobe Photos hop program. If the program is unable to open the document in the 
format you have specified, an alert box will appear. 

The default file format when you use the Open As command is the Raw format. 
The Raw format is a highly flexible file format designed to accommodate images 
saved in undocumented formats, such as those created by scientific applications. 
When you open a document in the Raw file format, a dialog box appears for you 
to specify the parameters of the image so that the Adobe Photoshop program can 
open the document correctly. The information includes the width and height of 
the image (in pixels), the number of channels in the image, and the length of the 
header (in bytes). The header precedes the actual image information, and could 
include such information as the name of the application that created the docu
ment. Each character in the header (including spaces) represents one byte. 

If you are uncertain of some of the document information, you can enter the in
formation you know, then use the Guess button. The Adobe Photoshop program 
then estimates the other values based on the size of the document, which appears 
in the top left corner of the dialog box, and the values you have entered. (The size 
is measured in bytes. Each byte represents 1 pixel per channel in the image.) 

As an example, suppose you know the size of the header in the document, but 
you don't know the height and width of the image. You can enter the header's 
size in the Header text box, then click Guess. The Adobe Photoshop program will 
guess the number of rows and columns that comprise the image based upon the 
document's size on disk and the size of the header. 

You can use the Swap button to change the default orientation assigned the 
image. The Guess option assumes that the image has a landscape orientation, 
with the width greater than the height. If you click Swap, the width and height 
values are automatically reversed. 

To import a document in the Raw format: 

1. Choose Open As from the File menu. 

The Open As dialog box appears . 

2. Use the drive and directory buttons, if necessary, to locate the folder that 
contains the document you want to open. 

3. Click the document. 

4. Click Open. 

---
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The Specify parameters dialog box appears. 

Specify parameters of 
(129600 bytes) 

Width: (piHels) 

(piHels) Height: 1360 

Channels: 11 
~==---, 

Header: LIO ____ ...J (bytes) 

K OK D 
( Cancel 1 

Swap 

Guess 

S. Specify the document information by entering the width, height, number of 
channels, and header (if desired). 

6. To estimate the document's size parameters, enter either the correct height and 
width values to estimate the header size, or enter the correct header size to esti
mate the height and width. Click Guess. 

The Adobe Photos hop program estimates the appropriate value or values and au
tomatically enters the information in the dialog box. 

7. To reverse the order of the width and height values, click Swap. 

8. When you have finished entering information about the document, click OK. 

The document is opened. 

If you want to open the document into a format other than Raw, follow the steps 
below. 

To import a document in a file format other than Raw: 

1. Choose Open As from the File menu. 

The Open As dialog box appears. 

2. Position the pointer on the box beside File Format. 

3. Press down the mouse button. 
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The Specify parameters dialog box appears.

Specify parameters of

[129600 bytes]

width: (piflelsl

Height: [piuels]

Channels: El

Header: CI {bytes}  
. Specify the document information by entering the width, height, number of

channels, and header (if desired).

. To estimate the document’s size parameters, enter either the correct height and
width values to estimate the header size, or enter the correct header size to esti-

mate the height and width. Click Guess.

The Adobe I’hotoshop program estimates the appropriate value or values and au«

tomatically enters the information in the dialog box.

. To reverse the order of the width and height vaiues, click Swap.

. When you have finished entering information about the document, click OK.

The document is opened.

if you want to open the document into a format other than Raw, follow the steps
below.

To import a document in a file format other than Raw:

. Choose Open As from the File menu.

The Open As dialog box appears.

. Position the pointer on the box beside File Format.

. Press down the mouse button.
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The pop-up menu listing the file formats supported by the Adobe Photos hop 
program appears. 

Ie Photoshop Images I 
D Faucet =HD 100 

D Fire Engin Photoshop 

D Flowers Amiga IFF/ILBM 1: jH( t 

D Horses CompuSerue GIF 
EPS 

Driue 

D Machine MacPaint ............................... 

D Ram Open 

Cancel 

PiHelPaint 
"'Raw nOK 

SciteH CT 
TGA 
ThunderScan 
TIFF 

4. Holding down the mouse button, drag to highlight the file format in which the 
document will be opened. 

S. Release the mouse button. 

The chosen file format appears in the box. 

6. Select the document from the directory window and click Open. 

Exporting images 

16 User Guide 

The Adobe Photoshop program allows you to export documents in 14 different 
file formats: Photos hop, Amiga IFF/ILBM, CompuServe GIF, EPS, MacPaint, PICT 
File, PICT Resource, PIXAR, Pixel Paint, Raw, Scitex, TGA, ThunderScan, and TIFF. 
The ability to export images allows you to use the Adobe Photoshop images in 
other applications and on other computer platforms. 

You can save Adobe Photoshop documents as EPS or TIFF documents, then place 
these documents in page layout programs that support these file formats. You can 
also save Adobe Photoshop documents in formats that can be read by Commo
dore Amiga and IBM-compatible microcomputers, PIXAR workstations, and 
Scitex image-processing systems. 

Petitioner Exhibit 1026 Page 3816

The pop-up menu listing the file formats supported by the Adobe Photoshop
program appears. 

 til Photoshop Images

El Faucet

III Fire Engio Photoshop
D Flowers Flrniga IFFz’lLBM
D Horses CompuServe GIF
I] Koala EPS
D Machine MacPaint .........................................

D Ram PIET File
PICT Resource
PIHHR

PiHeIPaint
«Haw

SciteH ET
TEH
ThunderScon
TIFF

 

  
  
  

  

 

  

 

 

 

 
  

   
 

 File Format:

4. Holding down the mouse button, drag to highlight the file format in which the

document will be opened.

5. Release the mouse button.

The chosen file format appears in the box.

6. Select the document from the directory window and click Open.

Exporting images

The Adobe Photoshop program allows you to export documents in 14 different
file formats: Photoshop, Amiga IFFIILBM, CompuServe GIF, BPS, MacPaint, PICT

File, PlC'l‘ Resource, PIXAR, Pixell’aint, Raw, Scitex, TGA, ThunderScan, and TIFF.

The ability to export images allows you to use the Adobe Photoshop images in

other applications and on other computer platforms.

You can save Adobe Photoshop documents as EPS or TIFF documents, then place

these documents in page layout programs that support these file formats. You can

also save Adobe Photoshop documents in formats that can be read by Commo-

I dore Amiga and IBM—compatible microcomputers, PIXAR workstations, and

I Scitex image-processing systems.
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Certain file formats do not support some of the image types available in the 
Adobe Photoshop program. For example, you can't save an RGB image in the 
MacPaint format because the MacPaint format only accepts black-and-white 
image data. Formats that aren't available are dimmed. The options available for 
each format are discussed in the section that follows. Where dialog boxes appear 
with options, they are displayed. 

Export formats 
The file formats, and the information that can be specified when exporting an 
image in the file format, are described below. 

Photoshop 

Photoshop is the default file format for saving newly created images. 

Amiga IFF/ILBM 

The Amiga Interchange File Format (IFF)/Interlaced Bitmap (ILBM) format is used 
to transfer documents to and from Commodore Amiga computers. You can spec
ify the image resolution from 1 bit to 8 bits per pixel. 

Amiga IFF I I LBM Options ... 

Resolution: 

o 1 bitipiHel 
o 2 bits/piHel 
o 3 bits / piHel 
o 4 bits/piHel 
o 5 bits/piHel 
o 6 bits / piHel 
o 7 bits/piHel 
® 8 bits/piHel 

[ OK 1 
( cancel) 
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Certain file formats do not support some of the image types available in the

Adobe Photoshop program. For example, you can’t save an RGB image in the

MacPaint format because the MacPaint format only accepts black-and-white

image data. Formats that aren’t available are dimmed. The options available for

each format are discussed in the section that follows. Where dialog boxes appear

with options, they are displayed.

Export formats

The file formats, and the information that can be specified when exporting an

image in the file format, are described below.

 
Photoshop

Photoshop is the default file format for saving newly created images.

Amiga IFFIILBM

The Amiga interchange File Format (II-‘13).ilnterlaced Bitmap (ILBM) format is used

to transfer documents to and from Commodore Amiga computers. You can spec-

ify the image resolution from 1 bit to 8 bits per pixel. 

Hmiga IFF/ILBM Options...

Resolution:

0 l bitfpinel
O 2 bits/pine]

O 3 hiisz’pinel
O 4 bitsr’pinel
C" 5 hils/pinel

O 6 bitsipinel
O7 Ditsfpinel
{it 8 bitsfpinel
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CompuServe GIF 

I The CompuServe® Graphics Interchange Format (GIF) is commonly used to 
upload documents to the CompuServe Information Service, and to pass docu
ments between other types of computers. You can specify the image resolution 
from 1 bit to 8 bits per pixel. 

EPS 

18 User Guide 

CompuSerue GIF Options ... 

Resolution: 

o 1 bit/piHel 
o 2 bits/piHel 
o 3 bits/pi He I 
o 4 bits/pi He I 
o 5 bits/pi He I 
o 6 bits/piHel 
o 7 bits/piHel 
@ 8 bits/pi He I 

n OK l 
( cancel) 

The Encapsulated PostScript file (EPS) format is used by graphics applications. 
You can choose preview PICT and encoding options for documents to be saved 
in the EPS format. You can also specify if you want the halftone and transfer 
function information saved with the document. 

Some graphics applications, like Adobe Illustrator 88"', let you display or "pre
view" a PICT representation of a PostScript language image saved in the EPS 
format. The PICT preview image gives you an idea of what the image will look 
like when it is printed and allows you to accurately place the image on the page. 
The Adobe Illustrator 88 program lets you preview a monochrome, I-bit per pixel 
PICT image. Other applications let you display a 4-bit or 8-bit per pixel image, 
which can contain color. 

. ) 

. ) 
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You also have the option of saving a CMYK document as five separate EPS docu
ments . This allows you to save color separations in a format that can be read by 
certain applications that use this format, like QuarkXPress®. Four of the docu
ments will contain the color information: one document for the cyan informa
tion, one for the magenta, and so on. The fifth document will contain a prCT 
preview of the image and a low-resolution PostScript language version for proofs. 

When you save a bitmap-type image in EPS format, you have the option of 
making the white areas in the document appear transparent. 

EPS encoding options 

The encoding options control what type of information is saved in the docu
ment, either ASCII or binary. The binary option results in a file that is about half 
the size of an image saved with the ASCII encoding option and takes half as long 
to transfer to the printer. However, some applications (such as Aldus PageMaker® 
and FreeHand®) do not support binary EPS documents. For these applications, 
you should select the ASCII encoding option. 

Saving halftone screen and transfer function information 
in EPS documents 

You can choose to include halftone screen information, including the frequen
cies and angles of the screens, and transfer function information (dot gain cali
bration) with an EPS document. If you include this information, and place it in 
another application, such as Adobe Separator''', the PostScript interpreter will use 
this information and override the application's own settings when the color sep
arations are generated. 

EPS Options ... 

Preuiew PI CT: 

o None 
@ 1 bit/piHel 
o 8 bits / piHel 

Encoding: 

@ASCII 
o Binary 

D I nclude Halftone Screens 
D I nclude Transfer Functions 

n OK D 
( Cancel) 
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You also have the option of saving a CMY‘K document as five separate EPS docu-

ments. This allows you to save color separations in a format that can be read by

certain applications that use this format, like QuarkXPress®. Four of the docu-

ments will contain the color information: one document for the cyan informa-

tion, one for the magenta, and so on. The fifth document will contain a PiC’l‘

preview of the image and a low-resolution PostScript language version for proofs.

When you save a bitmap-type image in EPS format, you have the option of

making the white areas in the document appear transparent.

EPS encoding options

The encoding options control what type of information is saved in the docu-

ment, either ASCII or binary. The binary option results in a file that is about half

the size of an image saved with the ASCII encoding option and takes half as long

to transfer to the printer. However, some applications (such as Aldus PageMaker®

and FreeHand®) do not support binary EPS documents. For these applications,

you should select the ASCII encoding option.

Saving halftone screen and transfer function information
in EPS documents

You can choose to include halftone screen information, including the frequen-

cies and angles of the screens, and transfer function information (dot gain cali-

bration) with an BPS document. if you include this information, and place it in

another application, such as Adobe Separator'", the l’ostScript interpreter will use
this information and override the application's own settings when the color sep-

arations are generated.

EPS Options...

Preview PICT: Encoding:

C} None :3} HSCII

I5] I bitfpiHel C} Binary
Q 8 hits/pinel

[I Include Halftone Screens
[I Include Transfer Functions 
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MacPaint 

The MacPaint format is commonly used to transfer bitmapped images between 
Macintosh applications. You can only save Adobe Photoshop images that are in 
the Bitmap image type in the MacPaint format. You can choose to have the image 
either centered on the page when it is opened or placed in the upper left corner 
of the page. To select the placement option you want, click Center or Top-Left 
Corner, then click OK. 

MacPaint Options ... 

Position on Page: 

@ Center 
o Top-Left Corner 

n OK D 
[ Cancel 1 

PICli File 

20 User Guide 

The PICT format is widely used among Macintosh graphics and page layout 
applications as an intermediary file format used to transfer documents between 
applications. 

You can specify the resolution of the image, from 1 bit per pixel to 32 bits per 
pixel. The 8-bits per pixel System Palette option lets you automatically select the 
system color table as the color table used for the image. This option allows you to 
make sure the colors in the selection are displayed properly within applications 
that do not recognize custom color tables used to create an image. 

PI CT File Options ... 

Resolution: 

o 1 bit/piHel 
o 2 bits/piHel 
o 4 bits/pi He I 
o 8 bits/piHel 
o 8 bits/piHel, System Palette 
o 16 bits/piHel 
@ 32 bits/pi He I 

OK 

( Cancel 1 

J 
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MacPaint

The MacPaint format is commonly used to transfer bitmapped images between

Macintosh applications. You can only save Adobe Photoshop images that are in

the Bitmap image type in the MacPaint format. You can choose to have the image

either centered on the page when it is opened or placed in the upper left corner

of the page. To select the placement option you want, click Center or Top-Left

Corner, then click OK.

MacPaint options...

Position on Page:

(E) Center

0 Top-Left turner 
PICT File

User Guide

 

'I‘he PICT format is widely used among Macintosh graphics and page layout

applications as an intermediary file format used to transfer documents between

applications.

You can specify the resolution of the image, from 1 bit per pixel to 32 bits per

pixel. The 8—bits per pixel System Palette option lets you automatically select the

system color table as the color table used for the image. This option allows you to

make sure the colors in the selection are displayed properly within applications

that do not recognize custom color tables used to create an image.

PIET File Options...

Resolution:

0 l hit/piHeI

C} 2 bitsz’piuel
C} 4 hitsx'piuel
OB hits/pixel

C) B Dits/piael, System Palette
C) 16 hits/pixel
® 32 hits/pixel
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PICT Resource 

PIXAR 

The PICT resource allows you to export an Adobe Photoshop document as a start
up screen or include the document as a PICT resource in an application program. 

You can specify information about the document that determines how the 
resource will be used. If you want to use the image as a resource in an application 
program, you must enter the information the application needs to make use of 
the resource including the file type and file creator IDs, the resource ID, the re
source name, and the image's resolution. The default file type is SCRN, the de
fault file creator is SBIM, the default resource ID is 0, the default resource name 
is the document's name, and the default resolution is determined by the image 
type. You can change the resolution or other parameters. 

PI CT Resource Options ... t OK ~ 
[ Cancel J 

File Type: 1'1IiJ:- 1 
File Creator: lOB I M 

Resource 10: 10 
~==~----------~ 

Resource Name: LI U_n_t_i_tl_e_d_-_l _________ -' 

Resolution: 

o 1 bitipiHel 
o 2 bits/piHel 
o 4 bits/piHel 
o 0 bits/piHel 
o 0 bits/piHel, System Palette 
o 16 bits/piHel 
@ 32 bits/piHel 

PIXAR workstations are designed for high-end graphics applications, such as 
work involving three-dimensional images and animation. 

When you select the PIXAR option, you can specify the file type and file creator 
information for the document. The default file type is (PXR) and file creator 
(SBIM). However, you can change these settings. The file type must be set to PXR 
if you want to use the Open command to open the document in the Adobe 
Photoshop application. 
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PICT Resource

PIXAR

 

The PICT resource allows you to export an Adobe Photoshop document as a start

up screen or include the document as a PICT resource in an application program.

You can specify information about the document that determines how the

resource will be used. If you want to use the image as a resource in an application

program, you must enter the information the application needs to make use of

the resource including the file type and file creator 105, the resource ID, the re—

source name, and the image’s resolution. The default file type is SCRN, the de—

fault file creator is 8131M, the default resource 10 is 0, the default resource name

is the document’s name, and the default resolution is determined by the image

type. YOU can change the resolution or other parameters.

PICT Resource (lotions...

FileTgpe: SCRN _
File Creator: BBIM

Resource ll]:

Resource Name: Untitled~l 

Resolution:

0 l bitipinel
O 2 hits/pine]

O 4 hitsfpinel
C) 8 hitsfpinel

O B hits/pinel, System Palette
016 bitss’pinel
{it 32 bits/pixel
 

PIXAR workstations are designed for high-end graphics applications, such as

work involving three-dimensional images and animation.

When you select the PIXAR option, you can specify the file type and file creator

information for the document. The default file type is {PXR} and file creator

(8131M). However. you can change these settings. The file type must be set to PXR

if you want to use the Open command to open the document in the Adobe

Photoshop application.
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To edit the file type and file creator settings, double-click in the text box of the 
parameter you want to change, then type the information. When you are ready 
to save the document, click OK. 

PI HAR Options ... 

File Type: 1mm.1 
File Creator: 18811'01 1 

[ OK U 
[ Cancel) 

Pixel Paint 

I 

Raw 

22 User Guide 

The PixelPaint file format allows a document to be opened in the PixelPaint and 
PixelPaint Professional graphics applications. You can specify the image size 
(canvas) you want to use and whether you want the image to appear in the center 
of the canvas or in the top left corner when you open the document. 

PiHelPaint Options ... 

Canuas Size: 

0512 by 512 piHels 
@ 576 by 720 piHels 
o 1024 by 768 piHels 
o 1024 by 1024 piHels 

Position on Canuas: 

@ Center 
o Top-left Corner 

[ OK U 
( Cancel) 

The Raw format is a flexible file format for transferring documents between 
different applications and computer platforms. 

You can specify the file type, file creator, and header information about the 
document. 

. ) 
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The file type is generally a four-character !D that identifies the file; for example, 
TEXT identifies the document as an ASCII text document. The file creator also is 
generally a four-character !D. Most Macintosh applications have a unique file 
creator!D that is registered with the Apple Computer Developer Services group. 
The header is the number of bytes of information that will appear at the begin
ning of the document, before the actual image information. The value you enter 
for this parameter defines the number of zeroes that will be placed at the front of 
the document. The zeroes act as place holders in the document. After you save 
the document, you can use a file editing program, like Symantec Utilities for 
Macintosh (SUM) II®, to replace the zeroes with header information. 

You can choose to save the image in an interleaved or non-interleaved format. If 
you choose the interleaved format, the color bands (red, green, and blue, for 
example) are stored sequentially. The choice you make depends on the require
ments of the application you plan to use to open the document. 

Raw Options ... 

File Type: 1 filM 1 

File Creator: 1 ???? 

Header: Llo __ ---' 

Saue image in: 

@ Interleaued Order 
o Non-interleaued Order 

n OK D 

[ cancel) 

Scitex CT 

TGA 

The Scitex Continuous Tone (CT) format is available for CMYK color images and 
gray-scale images. Scitex computers are used for high-end image processing. 
Contact Scitex to obtain utilities that will allow you to transfer a document saved 
in the Scitex CT format to a Scitex system. When you select the Scitex CT option, 
the active Adobe Photoshop document is converted directly to the Scitex format; 
no dialog box appears to allow you to select options for the conversion. 

The TGA format is designed for use on systems that use TrueVision® video boards, 
and is commonly supported by MS-DOS color applications. The format is also 
known as "Targa," in reference to the TARGA® videographics board manufac
tured by TrueVision. 

You can choose the resolution you want if you are saving an RGB color image. 
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The file type is generally a four-character ID that identifies the file; for example,
TEXT identifies the document as an ASCII text document. The file creator also is

generally a four-character ID. Most Macintosh applications have a unique file

creator [[3 that is registered with the Apple Computer Developer Services group.

The header is the number of bytes of information that will appear at the begin-

ning of the document, before the actual image information. The value you enter

for this parameter defines the number of zeroes that will be placed at the front of

the document. The zeroes act as place holders in the document. After you save

the document, you can use a file editing program, like Symantec Utilities for

Macintosh (SUM) [13, to replace the zeroes with header information.

You can choose to save the image in an interleaved or non-interleaved format. If

you choose the interleaved format, the color bands (red, green, and blue, for

example) are stored sequentially. The choice you make depends on the require-

ments of the application you plan to use to open the document.

Haw Options...

File Type:

File Creator:

Header:

Save image in:

(El Interleaved Order
ONon-interleaued Order
 

Scitex CT

TGA

The Scitex Continuous Tone (CT) format is available for CMYK color images and

gray-scale images. Scitex computers are used for high-end image processing.

Contact Scitex to obtain utilities that will allow you to transfer a document saved

in the Scitex CT format to a Scitex system. When you select the Scitex CT option,

the active Adobe Photoshop document is converted directly to the Scitex format;

no dialog box appears to allow you to select options for the couversion.

The TGA format is designed for use on systems that use TrueVision® video boards,

and is commonly supported by MS—DOS color applications. The format is also

known as "'l‘arga,” in reference to the TARGA® videographics board manufac-

tured by TrueVision.

You can choose the resolution you want if you are saving an RGB color image.
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ThunderScan 

TIFF 

24 User Guide 

ThunderScan® is a hardware and software package used to scan images. 

You can specify the number of bits of information per pixel (the resolution) you 
want to save with the document. 

ThunderScan Options ... 

Resolution: 

o 1 bit/piHel 
o 4 bits / piHel 
@ 5 bits/piHel 

E OK ] 

( Cancel) 

The Tagged-Image File Format (TIFF) is used to exchange documents between 
different applications and different computer platforms. You can choose to save 
Adobe Photos hop documents in a format that can be read by either Macintosh or 
IBM PC computers. You can also choose to compress the document to a smaller 
size automatically by clicking the LZW Compression check box. 

11 FF Options ... 

Format: 

o IBM PC 
@Macintosh 

o lZW Compression 

E OK ] 

( Cancel) 
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Saving documents in different file formats 
When you save a document in another file format, you use the pop-up menu in 
the Save As dialog box. The pop-up menu lists the file formats that the Adobe 
Photoshop program supports. Once you select a file format, in most cases, a 
dialog box containing options for the format will appear. 

To save an Adobe Photoshop document in another file format: 

1. Choose Save As from the File menu. 

The Save As dialog box appears. 

2. Type the name for the document. 

3. Use the drive and directory buttons (if necessary) to choose where you want to 
store the document. 

4. Position the pointer on the box next to File Format. 

5. Press down the mouse button. 

A pop-up menu appears listing the file formats the Adobe Photoshop program 
supports. 

File Format: ../Photoshop 
Amiga IFF/llBM ~ 
CompuSerue G I F 
EPS 
H<H Pnin t 
PICT File 
PI CT Resource 
PIHAR 
PiHelPaint 
Raw 
SciteH CT 
TGA 
ThunderScan 
TIFF 

6. Holding down the mouse button, drag to highlight the format in which you 
want to save the active document. Release the mouse button. 

7. Click Save. 

The options dialog box for the selected file format appears . 

8. Select the options you want by clicking the appropriate check box or radio 
button. 

9. When you are finished selecting the parameters you want, click OK. 

When you save an Adobe Photoshop document in a different fil e format, a 
unique document icon identifying the selected file format is used for the 
document. 
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Saving documents in different file formats

When you save a document in another file format, you use the pop-up menu in

the Save As dialog box. The pop-up menu lists the file formats that the Adobe

Photoshop program supports. Once you select a file format, in most cases, a

dialog box containing options for the format will appear.

[\J

To save an Adobe Photoshop document in another file format:

1. Choose Save As from the File menu.  
The Save As dialog box appears.

2. Type the name for the docriment.

3. Use the drive and directory buttons (if necessary] to choose where you want to
store the document.

4. Position the pointer on the box next to File Format.

5. Press down the mouse button.

A pop~up menu appears listing the file formats the Adobe Photoshop program

supports.

File Format: JPhotoshop x

flmiga IFF/ILBM
CompuServe GIF
EPS
Mat i’aia?

PlCT File
PICT Resource
PIHHH

PiaelPaint
Haul
Scitefl CT
TGH

ThunderScan
TIFF

 
6. Holding down the mouse button, drag to highlight the format in which y0u

want to save the active document. Release the mouse button.

7. Click Save.

The options dialog box for the selected file format appears.

8. Select the options you want by clicking the appropriate check box or radio
button.

9. When you are finished selecting the parameters you want, click OK.

When you save an Adobe Photoshop document in a different file format, a

unique document icon identifying the selected file format is used for the
document.
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Usimg plug-in modules to import and export images 

User Guide 

Plug-in modules are software programs developed by third-party vendors in con
junction with Adobe Systems to extend the standard Adobe Photoshop program. 
The program modules are distributed on floppy disks and are represented as 
icons, like application and utility programs. The instructions for using the 
program are shipped with the module. 

Modules are available that allow you either to import (acquire) images from 
devices such as scanners, or export images to devices such as printers that are not 
supported by the Apple® printer drivers. Acquire modules allow you to control a 
scanner or video frame capture system, or to decompress a document. Export 
modules let you save an Adobe Photoshop document in a file format not support
ed by the standard Adobe Photoshop program, or let you export images to devices 
such as printers that are unavailable through the Chooser. 

To use an acquire or export module, you must install a copy of the module in the 
folder containing your preferences file. Once installed, the module will be active 
under the File menu when you select either the Acquire or Export command, de
pending on the type of module you are using. For detailed instructions on using 
plug-in modules with the Adobe Photos hop program, refer to the appropriate 
documentation included with the third-party software disk. 

' ; ; 
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Section 2: Using the Adobe Photoshop Toolbox

 



The designer scanned in three photos of sand, a fish, and an anemone as 35mm slides, 
and combined them in this illustration. She increased overall brightness in the images 
using the adjust levels controls to bring out as much detail in the shadow areas as 
possible. She blurred the sand and screened it to create a background texture, then 
rotated and cropped the plant image to fit within the foreground area. Using a separate 
file, the designer selected the fish and rotated its position, then copied and pasted the 
fish into the plant image. Petitioner Exhibit 1026 Page 50

 The designer scanned in three photos of sand, a fish, and an anemone as 35mm slides,
and combined them in this illustration. She increased overall brightness in the images
using the adjust levels controls to bring out as much detail in the shadow areas as
possible. She blurred the sand and screened it to create a background texture, then
rotated and cropped the plant image to fit within the foreground area. Using a separate
file, the designer selected the fish and rotated its position, then copied and pasted the

fi5h into the plant image. Petitioner Exhibit 1026 Page 50
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The Adobe Photoshop tools in the toolbox allow you to paint, select, edit, and 
change your view of images. All of the tools are represented by icons that reflect 
the name of the tool and its function. The toolbox is a floating palette. This 
means that you can move it around the screen and it will float above the image, 
allowing you to paint beneath it. You can move the toolbox to a more convenient 
location, or hide it to make more room on the screen. 

This chapter gives a brief overview of the tools in the toolbox and tells you how 
to control the toolbox. 

To select the tool you want to use, click the tool in the toolbox. 

~ File Edit M !Hjp ! m<~ 9(~ Se ie( t Window 
;;gg;;;; ;g j;;;;m;;;m 
r-, r-' , , I I 
L_~ '-~ 

P ·x· ., 
~~ Q. 

1z1: T 
~ lit! 

"" I' .9 ~ 
tlr J 
£ tp 

6 /j 

~ 
I~DOI 

The tool is highlighted. Also, the arrow pointer changes into the pointer 
(cursor shape) appropriate for the selected tool when you position it in the active 
window. 
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Chapter 3: Managing the Toolbox

The Adobe Photoshop tools in the toolbox allow you to paint, select, edit, and

change your view of images. All of the tools are represented by icons that reflect

the name of the tool and its function. The toolbox is a floating palette. This

means that you can move it around the screen and it will float above the image,

allowing you to paint beneath it. You can move the toolbox to a more convenient
location, or hide it to make more room on the screen.

This chapter gives a brief overview of the tools in the toolbox and tells you how
to control the toolbox.

To select the tool you want to use, click the tool in the toolbox.

File Edit Maize image §a§e<t window

 

 
The tool is highlighted. Also, the arrow pointer changes into the pointer

(cursor shape} appropriate for the selected tool when you position it in the active
window.
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I 
To use the tool on the image: 

1. Position the tool pointer on the image where you want to use the tool. 

11. Press down the mouse button. 

II Drag the pointer across the image. 

11. Release the mouse button when you have finished using the tool. 

To move the toolbox, position the pointer on the gray bar at the top of the tool-

box. I 
Hold down the mouse button. Drag until the toolbox is where you want it, then 
release the mouse button. 

,..-, , - , 
I I I I 
L_..J '-_ ,/ 

r · · · ········~······ ·· · · ·i 

.. 1 

To hide the toolbox: 

11. Press the Tab key to hide the toolbox. 

21 p,,,, the T.b key .g.in to "di'play the toolbox. 
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To use the tool on the image:

Position the tool pointer on the image where you want to use the tool.

Press down the mouse button.

Drag the pointer across the image.:“f-“Pi‘
Release the mouse button when you have finished using the tool.

To move the toolbox, position the pointer on the gray bar at the top of the tool—
box.

Hold down the mouse button. Drag until the toolbox is where you want it, then
release the mouse button.

File Edit Moth? intege sew: LllindouJ

 
 

To hide the toolbox:

1. Press the Tab key to hide the toolbox.

2. Press the Tab key again to redisplay the toolbox.
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Tool overview 
Below is a brief description of all of the tools in the toolbox. The tools are 
arranged in the toolbox according to their functions. The categories for tools are 
selection tools, viewing tools, text tools, fill tools, painting tools, editing tools, 
and miscellaneous tools. The toolbox also contains color and screen mode 
controls. 

Selection tools 

The lasso tool 

You can use the lasso tool to define any arbitrary selection area. The lasso tool 
operates like a freehand tool, and lets you trace the outline of a selection. 

The rectangular and elliptical marquee tools 

The rectangular marquee makes rectangular and square selections, and the ellip
tical marquee makes elliptical and round selections. The options available for 
both tools are very similar. For example, you can specify a certain fixed size, as 
well as a height-to-width ratio, for each marquee tool. 

The magic wand tool 

The magiC wand is a versatile selection tool that allows you to select images based 
upon the color similarities of adjacent pixels. You can select part of an image 
without tracing it, and you can also choose how extensive you want the selection 
to be. For example, you can choose either to select just the dark hair of a person 
in an image, or the person's lighter clothing as well. 

The eyedropper tool 

The eyedropper tool selects the current foreground and background colors from 
colors in an image. The foreground color is used by the painting tools. 

Viewing tools 

I 0 I The grabber tool 

The grabber tool lets you scroll through an image that is too large to fit in the 
active window. You can scroll in any direction without using the scroll bars on 
the window by temporarily switching from one of the painting tools to the 
grabber tool. 

The zoom tool 

The zoom tool allows you to zoom in on an image to perform close, detailed work 
on an image, or zoom out to get an overall view. 
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D The cross hair pointer 

The cross hair pointer works in conjunction with the tools to give greater preci
sion. When used with a painting, editing, or selection tool on an image, the <oross 
hair pointer allows you great accuracy by focusing the "hot spot" of the cross 
hairs (the dot in the middle of the cross hairs) on the areas where you are using 
the tool. To use the cross hair pointer, press the Caps Lock key. 

Release the Caps Lock key to resume using the tool's normal painter. 

Text tools 

IT] The type tool 

The type tool enters pixel-based type on an image. You can select a number of 
options for the type you enter, including the font and point size for type, and 
select style options such as underlining and italics. 

Fill tools 

User Guide 

I ~ I The paint bucket tool 

The paint bucket tool fills areas with the foreground color. The paint bucket tool 
fills pixels that are similar in color, in a similar way to the magic wand. Using the 
paint bucket tool, you can fill a discrete part of an image, such as a chair or an 
animal, simply by clicking on it. 

The blend tool 

The blend tool creates a gradient fill that displays a gradual transition from the 
foreground color to the background color. 

) Petitioner Exhibit 1026 Page 54

E The cross halr pointer
The cross hair pointer works in conjunction with the tools to give greater preci-

sion. When used with a painting, editing, or selection tool on an image, the cross

hair pointer allows you great accuracy by focusing the “hot spot" of the cross

hairs (the dot in the middle of the cross hairs} on the areas where you are using

the tool. To use the cross hair pointer, press the Caps Lock key.

 
Release the Caps Lock key to resume using the tool‘s normal pointer.

Text tools

The type tool

The type tool enters pixel-based type on an image. You can select a number of

options for the type you enter, including the font and point size for type, and

select style options such as underlining and italics.

Fill tools

The paint bucket tool

The paint bucket tool fills areas with the foreground color. The paint bucket tool

fills pixels that are similar in color, in a similar way to the magic wand. Using the

paint bucket tool, you can fill a discrete part of an image, such as a chair or an

animal, simply by clicking on it.

The blend tool

The blend tool creates a gradient fill that displays a gradual transition from the

foreground color to the background color.
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Painting tools 

The pencil tool 

The pencil tool creates either freehand or straight, hard-edged lines. The pencil 
tool includes an auto-erase option that allows you to change pixels that are the 
foreground color to the background color. 

The line tool 

The line tool creates straight lines. You can specify the thickness of lines (line 
weight) you create, and create lines with arrowheads. Lines created using the line 
tool are anti-aliased. Anti-aliasing smoothes out the edges of lines so they do not 
appear jagged. 

I )' I The paint brush tool 

The paint brush tool paints the foreground color into the image. The marks left 
by the paint brush tool are more diffused than the pencil tool's marks. The paint 
brush tool paints marks with soft edges. 

The airbrush tool 

The airbrush tool lays down a diffused spray of paint on an image. You can 
control the pressure of the paint and the rate it is sprayed on the image. 

The rubber stamp tool 

The rubber stamp tool picks up a sample of an entire image, and places an exact 
copy or a modified version of the selection elsewhere in the same image or in 
some other image. The rubber stamp options control the way a selected image, 
pattern, or texture is painted onto the image. The Revert option allows you to 
restore part of an image to the last version you saved. 

Editing tools 

The cropping tool 

The cropping tool selects part of an image and discards the un selected portion. 
You define the cropping area by dragging a rectangular selection marquee around 
the image, or by specifying the size of the selection area you want, and placing 
the selection marquee around the selection. 

The eraser tool 

The eraser tool changes pixels to the background color. This has the effect of 
"erasing" the pixels. You can change just the pixels you drag through or the 
entire image. You also can use the eraser to restore part of the image to the last 
version you saved. 
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The smudge tool 

The smudge tool simulates the effect of a finger dragging through wet paint. 
When you use the smudge tool, the colors of the pixels you drag through are 
gradually dispersed until the smudge fades out completely. 

The blur tool 

The blur tool blurs part of an image. The blur tool produces a less focused image 
by diffusing colors in the pixels to which the tool is applied. 

[JSJ The sharpen tool 

The sharpen tool sharpens part of an image. As you drag through part of an 
image, the sharpen tool increases the contrast between adjacent pixels. This 
results in a sharper, more focused image. 

Color Icontrols 

32 User Guide 

Foreground color indicator 

The foreground color indicator on the toolbox displays the current foreground 
color. Many of the painting tools paint with the foreground color. By clicking the 
foreground color indicator, you can display the Color Picker dialog box, which 
you can use to select a new foreground color. 

Background color indicator 

The background color indicator on the toolbox displays the current background 
color. The background color is used as the background in new documents and 
appears in place of parts of the image you cut or delete. By clicking the back
ground color indicator, you can display the Color Picker dialog box, which you 
can use to select a new background color. 
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The smudge tool

The smudge tool simulates the effect of a finger dragging through wet paint.

When you use the smudge tool, the colors of the pixels you drag through are

gradually dispersed until the smudge fades out completely.

The blur tool

The blur tool blurs part of an image. The blur tool produces a less focused image

by diffusing colors in the pixels to which the tool is applied.

The sharpen tool

The sharpen tool sharpens part of an image. As you drag through part of an

image, the sharpen tool increases the contrast between adjacent pixels. This

results in a sharper, more focused image.

Color controls

Foreground color indicator

The foreground color indicator on the toolbox displays the current foreground

color. Many of the painting tools paint with the foreground color. By clicking the

foreground color indicator, you can display the Color Picker dialog box, which

you can use to select a new foreground color.

Background color indicator

The background color indicator on the toolbox displays the current background

color. The background color is used as the background in new documents and

appears in place of parts of the image you cut or delete. By clicking the back-

ground color indicator, you can display the Color Picker dialog box, which you
can use to select a new background color.
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Screen mode controls 

The screen mode buttons on the bottom of the toolbox control the window 
display. The currently selected screen mode option is underlined in the toolbox. 
These options allow you to display the image inside the document window with 
the menu bar visible; at full-screen size without the document window and the 
menu bar visible; or, at full-screen size without either the document window or 
the menu bar. 

To display the image inside the document window with the menu bar (this is the 
default screen mode), click the left screen mode button on the toolbox. 

To display the image at full-screen size without the menu bar, click the right 
screen mode button on the toolbox. 

To display the image at full-screen size with the menu bar, click the center screen 
mode button on the toolbox. 
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Chapter 4: Controlling the Artwork and Screen Display 

The Adobe Photoshop program provides various ways to change the view of an 
image. In addition to the scroll controls and other window controls, you can use 
the grabber tool to scroll in two directions simultaneously. You can use the zoom 
tool and Zoom commands to obtain a magnified or more distant view of an 
image. 

For information about using the standard Macintosh window controls, like the 
scroll bars, resize, and zoom boxes, see your Macintosh user guide. 

Zooming in and out from an image 
The zoom tool in the toolbox and the Zoom commands in the Window menu 
allow you to zoom in on an image for a magnified view, or zoom out for an over
all perspective. The 1:1 view displays the image based upon the screen resolution 
and the image resolution, not the actual height and width dimensions of the 
image. Because the Adobe Photoshop program displays images at a screen resolu
tion of 72 pixels per inch, images with greater resolution will appear enlarged on
screen. For example, when displayed at a 1:1 view, an image with a resolution of 
200 pixels per inch will appear larger than its actual size because the screen can 
only display 72 pixels per inch. You can edit an image at any magnification. 

The zoom tool changes by a factor of two (2x) each time you click the mouse 
button (2x, 4x, 8x, and 16x). The title bar always displays the current zoom level, 
for example, 2:1 fo r a magnification by a factor of two. A plus sign (+) in the zoom 
pointer indicates that you are ready to zoom in, while a minus sign (-) indicates 
you are ready to zoom out. The maximum zoom levels for an image is +16x and 
-16x. 

The Zoom In and Zoom Out commands (and their Command-key equivalents) 
allow you to magnify or shrink a view. In addition, you can use the Zoom Factor 
command to zoom in or zoom out to a specified zoom level. 

To use the zoom tool to zoom in on an image: 

1. Click the zoom tool in the toolbox. 

2. Position the zoom pOinter on the part of the image you want to magnify. 

Notice that a plus sign (+) appears in the zoom pointer. 

3. Click the mouse button. 

The image is magnified by a factor of two. 
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4. Continue clicking the mouse button until the view you want is displayed, or 
until you reach the maximum zoom level. 

To zoom out from an image: 

1

1. Click the zoom tool in the toolbox. 

2. Position the zoom pointer on the image. 

3. Press down the Option key. 

4. Holding down the Option key, click the mouse button. 

I S. Continue clicking the mouse button until the view you want is displayed, or 
until you reach the minimum zoom level. 

16. Release the Option key. 

I 
Note: You can quickly return to the 1: 1 view of an image by double-clicking the zoom 
tool. Also, you can activate the zoom tool from the keyboard by holding down the 
Command key and the spacebar, placing the pointer inside the active ~indow, and 
clicking the mouse button. This activates the zoom-in mode. To activate the zoom
out mode, hold down the Option key and the space bar. 

I 

Using the Zoom commands 

36 User Guide 

The Zoom commands allow you to change your view of an image similar to the 
zoom tool. The major advantage of using the Zoom In and Zoom Out commands 
over the zoom tool is that you can implement them directly from the keyboard. 
The disadvantage to using the Zoom commands is that you can't specify the area 
you want to magnify as you can with the zoom tool. When you use the Zoom In 
command, the Adobe Photoshop program magnifies the area in the 
center of the active window. 

The Zoom In command magnifies the view of the image by a factor of 1 (lx, 2x, 
3x, and so on) each time you choose it until the maximum zoom level of +16 is 
attained; the Zoom Out command zooms out by a factor of 1 each time you 
choose it until the maximum zoom level of -16 is attained. 

) 
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4. Continue clicking the mouse button until the view you want is displayed, or

until you reach the maximum zoom level.

#7 oala [4:11 —-—-.'—— ____. _.

 
To zoom out from an image:

Click the zoom tool in the toolbox.

Position the zoom pointer on the image.

Press down the Option key.

Holding dawn the Option key, click the mouse button.E-"EP‘EJ’EQE‘
Continue clicking the mouse button until the view you want is displayed, or

until you reach the minimum zoom level.

6. Release the Option key.

Note: Yon can qnickiy return to the 1:1 view ofan image by double-choking the zoom

toot. Also, you can activate the zoom tooi from the keyboard by holding down the

Command key and the spacebar, piacing the pointer inside the active window, and

ciicking the mouse button. This activates the zoom-in mode. To activate the zoom-

ont mode, hold down the Option key and the space bar.

Using the Zoom commands

The Zoom commands allow you to change your view of an image similar to the

zoom tool. The major advantage of using the Zoom In and Zoom Out commands

over the zoom tool is that you can implement them directly from the keyboard.

The disadvantage to using the Zoom commands is that you can’t specify the area

you want to magnify as you can with the zoom tool. When you use the Zoom In

command, the Adobe Photoshop program magnifies the area in the
center of the active window.

The Zoom In command magnifies the view of the image by a factor of I (1x, 2x,

3x, and so on} each time you choose it until the maximum zoom level of +16 is

attained; the Zoom Out command zooms out by a factor of 1 each time you
choose it until the maximum zoom level of ~16 is attained.

35 User Guide Petitioner Exhibit 1026 Page 60



To use the Zoom In command, choose Zoom In from the Window menu, or type 
Command + (plus sign). 

To use the Zoom Out command, choose Zoom In from the Window menu, or 
type Command - (minus sign). 

Specifying a zoom factor 

You can immediately magnify or reduce your view when you are working on a 
large, high-resolution image by using the Zoom Factor command. The Zoom 
Factor command specifies a magnification or reduction factor of a view. When 
you specify a zoom factor, the Adobe Photoshop program immediately displays 
the specified zoom level. 

To use the Zoom Factor command: 

1. Choose Zoom Factor from the Window menu. 

The Zoom Factor dialog box appears. 

Zoom Factor. .. 

Factor: II I 
o Magnification 
@ Reduction 

( OK » 
( Cancel 1 

2. Click Magnification to zoom in; click Reduction to zoom out. 

3. Type a value from 1 to 16 for the zoom factor you want. 

4. Click OK. 

The specified zoom level is displayed on-screen. 

Scrolling in two directions 
When you are working on an image that extends beyond the borders of the 
document window, you can use the grabber tool to scroll in two directions 
simultaneously. 

To use the grabber tool to scroll across an image: 

1. Click the grabber tool in the toolbox. 

2. Position the grabber pointer on the image. 

3. Press down the mouse button. 
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To use the Zoom In command, choose Zoom In from the Window menu, or type

Command + (plus sign).

To use the Zoom Out command, choose Zoom In from the Window menu, or

type Command - (minus sign).

Specifying a zoom factor

You can immediately magnify or reduce your view when you are working 011 a

large, high-resolution image by using the Zoom Factor command. The Zoom

Factor command specifies a magnification or reduction factor of a view. When

you specify a zoom factor, the Adobe Photoshop program immediately displays

the specified zoom level.

To use the Zoom Factor command:

1. Choose Zoom Factor from the Window menu.

The Zoom Factor dialog box appears.

Zoom Factor... -
Factor:

OMagnification
(3} Reduction 

2.. Click Magnification to zoom in; click Reduction to zoom out.

3. Type a value from 1 to 16 for the zoom factor you want.

4. Click OK.

The specified zoom level is displayed on—screen.

Scrolling in two directions

When you are working on an image that extends beyond the borders of the

document window, you can use the grabber tool to scroll in two directions

simultaneously.

To use the grabber tool to scroll across an image:

1. Click the grabber tool in the toolbox.

2. Position the grabber pointer on the image.

3. Press down the mouse button.
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4. Holding down the mouse button, drag in the direction opposite the part of the 
image you want to display. For example, to display the lower right corner of the 
image, drag toward the upper left corner of the image. 

5. Release the mouse button when you have displayed the part of the image you 
want. 

I Note: Double-click the grabber tool to display the entire image in the largest size 
possible on your screen. 

Using rulers 
I You can display rulers along the top and left side of the active window to make 

measurements on an image. The rulers measure sizes in inches, centimeters, 
points, or picas. You can choose the units of measurement for each ruler separate
ly. The rulers also allow you to specify columns to simulate a page layout. 

38 User Guide 

When you move a pointer inside the window, markers appear on the rulers to 
show the pointer's position relative to the zero origins of the rulers. The markers 
reflect the position of the pointer's "hot spot" in the window. 

The ruler origin is tied to the document, not the window. As you scroll and zoom 
around the document, the rulers adjust accordingly. 

To display the rulers, choose Show Rulers from the Window menu. To hide the 
rulers, choose Hide Rulers from the Window menu. 

When you choose Show Rulers, a horizontal and vertical ruler appear along the 
top and left side of the active window. 

You can change the rulers' zero origins. This allows you to make measurements 
from a specific point on an image. 

To change the rulers' zero origins: 

1. Position the pointer in the upper left corner of the window, directly beneath the 
close box. 

2. Press down the mouse button. 
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4. Holding down the mouse button, drag in the direction opposite the part of the

image you want to display. For example, to display the lower right corner of the

image, drag toward the upper left corner of the image.

. Release the mouse button when you have displayed the part of the image you
want.

Note: Double-click the grabber tool to display the entire inmge in the largest size

possible on your screen.

Using rulers

User Guide

 

You can display rulers along the top and left side of the active window to make

measurements on an image. The rulers measure sizes in inches, centimeters,

points, or picas. You can choose the units of measurement for each ruler separate-

ly. The rulers also allow you to specify columns to simulate a page layout.

When you move a pointer inside the window, markers appear on the rulers to

show the pointer’s position relative to the zero origins of the rulers. The markers

reflect the position of the pointer’s “hot spot” in the window.

The ruler origin is tied to the document, not the window. As you scroll and zoom

around the document, the rulers adjust accordingly.

To display the rulers, choose Show Rulers from the Window menu. To hide the
rulers, choose Hide Rulers from the Window menu.

When you choose Show Rulers, a horizontal and vertical ruler appear along the

top and left side of the active window.

You can change the rulers’ zero origins. This allows you to make measurements

from a specific point on an image.

To change the rulers’ zero origins:

. Position the pointer in the upper left corner of the window, directly beneath the
close box.

2. Press down the mouse button.
 

Koala [l:1]
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3. Holding down the mouse button, drag onto the image. 

A set of crosshairs appears. 

4. Drag until the center of the cross hairs is on the pOint you want to use as the zero 
origin for the rulers. 

S. Release the mouse button. 

Specifying units of measurement 

By default, the Adobe Photoshop program uses inches as the units of measure in 
documents. However, you can use centimeters, points, and picas instead. You can 
use different units of measurement for each ruler. For example, you could use 
points for the horizontal ruler and picas for the vertical ruler. 

The size units you specify for the rulers are used in dialog boxes that allow you to 
specify size units. For example, the size unit choices for the horizontal ruler are 
used in the Resample dialog box in the Image menu for the Width parameter, and 
the units for the vertical ruler are used for the Height parameter. 

To select the units of measurement you want for a ruler: 

1. Choose Page Setup from the File menu. 

The Page Setup dialog box appears . 

=l=as=e=r=w=r=i=te=r=p=a=g~e==Se=t=u=p========================6.=O== t OK » 
Paper: @ US letter 0 A4 letter 

o US legal 0 B5 letter 0 I Tabloid [ cancel) 

Reduce or 1111111 1"10 
Enlarge: 

Printer Effects: 
o Font Substitution? 

(Options) 

Help 
Orientation 

Screens ... 

Transfer ... 

( Size / Rulers ... J 

o TeHt Smoothing? 
o Graphics Smoothing? 

o Faster Bitmap Printing? 

( Border... J 0 labels 0 Negatiue 
o Crop Marks 0 Emulsion Down 

( Caption ... ) 0 Calibration Bars 

o Registration Marks 
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3. Holding down the mouse button, drag onto the image.

A set of crosshairs appears.

4. Drag until the center of the cross hairs is on the point you want to use as the zero

origin for the rulers.

5. Release the mouse button.

Specifying units of measurement

By default, the Adobe Photoshop program uses inches as the units of measure in

documents. However, you can use centimeters, points, and picas instead. You can

use different units of measurement for each ruler. For example, you could use

points for the horizontal ruler and picas for the vertical ruler.

The size units you specify for the rulers are used in dialog boxes that allow you to

specify size units. For example, the size unit choices for the horizontal ruler are

used in the Resarnple dialog box in the Image menu for the Width parameter, and

the units for the vertical ruler are used for the Height parameter.

To select the units of meaSurement yen want far a ruler:

1. Choose Page Setup from the File menu.

The Page Setup dialog box appears.  
Laserwriter Page Setup 53

Paper: {é} us Letter CI H4 Letter _
0 us Legal 0 35 Letter 0 Tabloid
Reduce or Printer Effects:

Enlarge: -% IE] Font Substitution?

Orientation IZITth Smoothing?

 

IZI Graphics Smoothing?

IE] Faster Bitmap Printing?

a a Nee-eves
. [:I Crop Marks [:1 Emulsion flown

|:| Cafibration Bars

Size/Rulers... I] Registration Marks
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2. Click Size/Rulers. 

The Image Size/Ruler Units dialog box appears. 

I mage Size / Ruler Units ... 

Width: 17.111 II (inches) 

Height: 17.111 II (inches) 

Resolution: I_II (piHels / inch) 

E OK U 
( Cancel) 

The two boxes beside the Width and Height text boxes are used to access pop-up 
menus. You use the Width pop-up menu to choose the units for the horizontal 
ruler; you use the Height pop-up menu to choose the units for the vertical ruler. 

To choose the units of measurement you want for a ruler: 

1. Position the pointer on the Width or Height box next to the ruler you want. 

2. Press down the mouse button. 

A pop-up menu listing the available units of measure appears . 

I mage Size/Ruler Units ... 

Width: 17.111 

Height: 17.111 

Resolution: 

E OK D 
( cancel) 

3. Holding down the mouse button, drag to highlight the units you want. 

4. When the desired units appear in the box, release the mouse button. 

S. Click OK. 

\ ) 
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2. Click SizeIRulers.

The Image SizefRuler Units dialog box appears.

Image Sizei’Huler Units...

Illidth: 7.11!

Height: 7.11]

Resolution: ?2 [pixels/inch] 
The two boxes beside the Width and Height text boxes are used to access pop—up

menus. You use the Width pop~up menu to Choose the units for the horizontal

ruler; you use the Height pop-up menu to Choose the units for the vertical ruler.

To choose the units of measurement y0u want for a ruler:

1. Position the pointer on the Width or Height box next to the ruler you want.

2. Press down the mouse button.

A pop«up menu listing the available units of measure appears. 

Image Size/Ruler Units...

width: Jlinches]

. lcrni

Resolution: [Dicasl
[columns] 

3. Holding down the mouse button, drag to highlight the units you want.

4. When the desired units appear in the box, release the mouse button.

5. Click OK.
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Specifying a column size 

You can use columns as a way to simulate page layouts in the Adobe Photoshop 
program. A column can be any size you specify. A column includes a specified 
width and gutter size. You can specify a particular column and gutter size to 
match the page layout of the page that will hold the final image. This allows you 
to make sure that the image will fit in your layout if you use the cropping tool or 
the Resample command in the Image menu to resize an image, or use the Size/ 
Rulers option in the Page Setup dialog box to print out an image at a certain size. 
You can only use columns for horizontal measurements. 

As an example, you can specify a size of 1 inch for columns, and .25 for the 
gutter, then specify 2 columns for the width parameter in the Cropping Tool 
Options dialog box and crop an image. The width of the cropped image will be 
2.25 inches, which represents a width of 2 columns and 1 gutter size between the 
columns. 

The Preferences dialog box in the Edit menu allows you to specify size units for 
the column width and gutter. Pop-up menus let you choose the size units, either 
inches, centimeters (cm), points, or picas. 

To specify column dimensions: 

1. Choose Preferences from the Edit menu. 

The Preferences dialog box appears . 

Preferences ... 

Display: 

[8) Colored separations 

D Use system palette 

[8) Use DirectSetEntries 

Clipboard EHport: 

o Disabled 
o 1 bitipiHel 
o 2 bits/piHel 
o 4 bits/piHel 
08 bits/piHel 
@ 8 bits/piHel, System Palette 
o 16 bits/piHel 
o 32 bits/piHel 

Separation Setup ... K OK D 
( Cancel 1 

Column Size: 

Width: 1m.11 (picas) 

I nterpolation Method: 

o Nearest Neighbor 
o Bilinear 
@ Bicubic 
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Specifying a column size

"" You can use columns as a way to simulate page layouts in the Adobe Photoshop

program. A column can be any size you specify. A column includes a specified

-’ ' width and gutter size. You can specify a particular column and gutter size to

match the page layout of the page that will hold the final image. This allows you

‘" to make sure that the image will fit in your layout if you use the cropping tool or

the Resample command in the Image menu to resize an image, or use the Size.l

"' Rulers option in the Page Setup dialog box to print out an image at a certain size.

You can only use columns for horizontal measurements.

As an example, you can specify a size of 1 inch for columns, and .25 for the

gutter, then specify 2 columns for the width parameter in the Cropping Tool

Options dialog box and crop an image. The width of the cropped image will be

2.25 inches, which represents a width of2 columns and 1 gutter size between the
columns.

a The Preferences dialog box in the Edit menu allows you to specify size units for

the column width and gutter. Pop-up menus let you choose the size units, either

inches, centimeters (cm), points, or picas.

To specify column dimensions:

1. Choose Preferences from the Edit menu.  
The Preferences dialog box appears.  

Preferences...

IE Colored separations Cancel

_ El Use system palette Column Size:

._ E Use flirectSetEntries width:
Clipboard Export: .

I____ 0 Disabled flutter. El
{3 I Ditz‘piuel
O 2 bitsx'piuel

O 4 bitsz’piuel O Nearest Neighbor
0 s bitsz'piael O Bilinear
(El 8 bitsz’pinel, System Palette {é} Blcuhlc
C) Is hits/pine]

'“ C3 32 hits/pine!

Interpolation Method: 
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2. Use the Width and Gutter pop-up menus to choose the units of measure you 
want for the column width and gutter. 

3. Enter the width you want for the column. 

14. Press the Tab key or double-click the Gutter text box. 

S. Enter the size you want for the gutter. 

6. Click OK. 
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Chapter 5: Using the Painting Tools 

This chapter describes how to use the painting tools. The painting tools in the 
toolbox allow you to add paint to a selected image or area. Painting changes the 
colors of pixels in an image. The painting tools include the pencil tool, the line 
tool, the paint brush tool, the airbrush tool, and the rubber stamp tool. 

Each tool includes several options, which are accessed via a dialog box that 
appears when you double-click the tool in the toolbox. Some options common 
to all of the painting tools include the ability to paint or edit along a straight line, 
and to use color modes to paint or edit areas that are only lighter or darker than 
the foreground color. Chapter 7, "Painting and Editing Tool Options," discusses 
the options common to several tools . 

If you are using a painting tool on an image that is larger than the window, you 
can scroll through the image by switching temporarily to the grabber tool. This 
allows you to scroll in any direction without using the scroll controls. 

Unless otherwise noted, the painting tools by default all paint with the fore
ground color. The foreground color is displayed in the center square within the 
rectangle at the bottom of the toolbox. The background color, which is displayed 
in the rectangle surrounding the square, is used for making blends and erasing. 
You can change the foreground and background color using the eyedropper tool. 
"Using the eyedropper tool" in Chapter 11, "Selecting Colors," contains more in
formation about selecting colors using the eyedropper tool. 

To change the foreground color to another color in an image: 

1. Click the eyedropper tool in the toolbox. 

2. Position the eyedropper pointer on the color you want to use as the foreground 
color. 

3. Click the mouse button. 
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To scroll across an image while using a painting tool: 

1. Hold down the space bar. 

2. Position the painter on the image. 

The pointer changes into the grabber. 

3. Press down the mouse button. 

4. Drag in the direction you want the image to move. For example, if you want to 
view the left of the image, drag right to make the image move right. 

s. Release the mouse button. 

6. Release the space bar to resume painting. 

Using the pencil tool 

44 User Guide 

The pencil tool creates either freehand or straight lines. The lines are hard-edged. 
The pencil tool's Auto Erase option changes pixels that display the current fore
ground color to the background color. When you select the Auto Erase option, 
position the painter on a pixel that is the same color as the foreground color, and 
drag through the image. The pencil tool changes all pixels. 

To paint with the pencil tool: 

1. Click the pencil tool in the toolbox. 

2. Position the painter where you want to start painting. 

3. Holding down the mouse button, drag to paint a line. 

4. When you have finished painting, release the mouse button. 
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To scroll across an image while using a painting tool:

1. Hold down the space bar.

2. Position the pointer on the image.

The pointer changes into the grabber.

3. Press down the mouse button.

4. Drag in the direction you want the image to move. For example, if you want to

view the left of the image, drag right to make the image move right.

 
5. Release the mouse button.

6. Release the space bar to resume painting.

Using the pencil tool

The pencil tool creates either freehand or straight lines. The lines are hard-edged.
The pencil tool’s Auto Erase option changes pixels that display the current fore-

ground color to the background color. When you select the Auto Erase option,

position the pointer on a pixel that is the same color as the foreground color, and

drag through the image. The pencil tool changes all pixels.

'I‘o paint with the pencil tool:

1. Click the pencil tool in the toolbox.

2. Position the pointer where you want to start painting.

3. Holding down the mouse button, drag to paint a line.

4. When you have finished painting, release the mouse button.

J/j
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To draw a straight line with the pencil tool: 

1. Click the pencil tool in the toolbox. 

2. Press the Shift key, and click the mouse button at the beginning and end points 
of the line you wish to draw. 

3. Release the Shift key. 

To choose the Auto Erase option for the pencil tool: 

1. Double-click or Option-click the pencil tool in the toolbox. 

The Pencil Options dialog box appears. 

Pencil Options ... n OK J 
D· · • • • • ••••••• 

( Cancel) 

Spacing: 0 
Opacity: 111111'170 
o Auto Erase 

2. Click Auto Erase. 

Custom 

Mode: 

@ Normal 
o Color Only 
o Darken Only 
o lighten Only 

The Auto Erase box is checked, indicating the Auto Erase option is active. 

3. Click OK. 

4. Position the pointer on the area you want to paint. 

5. Holding down the mouse button, drag through the image. 

6. When you have finished painting, release the mouse button. 
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To draw a straight line with the pencil tool:

. Click the pencil tool in the toolbox.

. Press the Shift key, and click the mouse button at the beginning and end points

of the line you wish to draw.

. Release the Shift key.

To choose the Auto Erase option for the pencil tool:

. Double-click or Option~click the pencil tool in the toolbox.

The Pencil Options dialog box appears.

Pencil Options...

(9 Normal

0 Color Only
0 Darken Only

I] Fluto Erase O Lighten only

 
Click Auto Erase.

The Auto Erase box is checked, indicating the Auto Erase option is active.

. Click OK.

Position the pointer on the area you want to paint.

Holding down the mouse button, drag through the image.

When you have finished painting, release the mouse button.
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Using the line tool 
The line tool creates straight lines on an image. Line tool options allow you to 
specify the width of lines (in pixels) and create lines with arrowheads. Also, you 
can constrain the line tool to create horizontal or vertical lines, or lines con
strained at 4S-degree angles. You can choose to have the arrowheads appear at 
the start of the line, at the end, or at both ends. 

Unlike the marks created using the pencil tool, the lines you create using the line 
tool are anti-aliased. The smooth, anti-alia sed edges of the lines prevent the 
jagged edges that commonly appear in paint applications. 

To create a line using the line tool: 

I '" 11. Click the line tool in the toolbox. 

2. Position the line tool pointer where you want the line to start. 

I 3. Holding down the mouse button, drag in the direction you want to project the 
line. 

4. When the line is the desired length, release the mouse button. 

To create a constrained, straight line using the line tool: 

1. Click the line tool in the toolbox. 

2. Position the line tool pointer where you want the line to start. 

3. Hold down the Shift key to constrain the line in 4S-degree increments as you 
drag the mouse. 

4. When the line is the length you want, release the mouse button. 

Specifying line weights and arrowheads 
I 

User Guide I 

Before you create lines, you must choose the line weight and arrowhead options 
you want. 

You can control the shape of the arrowhead by specifying the height and width 
(in pixels) and the degree of concavity (as a percentage value) . The concavity pa
rameter defines the amount of curvature on the widest part of the arrowhead 
where it meets the line. 

Petitioner Exhibit 1026 Page 7046

Using the line tool

.1.
2.

3.

4.

1.

2.

3.

4.

The line tool creates straight lines on an image. Line tool Options allow you to

specify the width of lines {in pixels) and create lines with arrowheads. Also, you

can constrain the line tool to create horizontal or vertical lines, or lines con-

strained at 45-degree angles. You can choose to have the arrowheads appear at
the start of the line, at the end, or at both ends.

Unlike the marks created using the pencil tool, the lines you create using the line

tool are antiualiased. The smooth, anti«aliased edges of the lines prevent the

jagged edges that commonly appear in paint applications.

To create a line using the line too]:

Click the line tool in the toolbox.

Position the line tool pointer where you want the line to start.

Holding down the mouse button, drag in the direction you want to project the
line.

When the line is the desired length, release the mouse button.

 
To create a constrained, straight line using the line tool:

Click the line tool in the toolbox.

Position the line tool pointer where you want the line to start.

Hold down the Shift key to constrain the line in 45-degree increments as you

drag the mouse.

When the line is the length y0u want, release the mouse button.

Specifying line weights and arrowheads

User Guide

Before you create lines, you must choose the line weight and arrowhead options

you want.

You can control the shape of the arrowhead by specifying the height and width

(in pixels) and the degree of concavity (as a percentage value}. The concavity pa-
rameter defines the amount of curvature on the widest part of the arrowhead
where it meets the line.
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To choose options for the line tool: 

1. Double-click or Option-click the line tool in the toolbox. 

The Line Tool Options dialog box appears. 

line Tool Options '" 

Width: liM' (piHels) 

Arrow Heads: 

D At Start D At End 

Width: EJ (piHels) 

length: OIJ (piHels) 

Concauity: [] % 

n OK J 
[ cancel) 

2. Type the width you want for lines (in pixels). 

3. Specify where you want arrowheads to appear by clicking the At Start option to 
create lines with arrowheads at the starting pOints; the At End option to create 
lines with arrowheads at the ending points; or both options to create lines with 
arrowhead on both ends. 

When the option is checked, arrowheads will appear on the specified end or ends 
of lines you create with the line tool. 

To specify the attributes for arrowheads with the line tool: 

1. Double-click in the Width text box. 

2. Enter a value from 5 to 99 for the arrowhead width. 

3. Press the Tab key or double-click in the Length text box, and enter a value from 
7 to 99 for the arrowhead length. 

4. Press the Tab key or double-click in the Concavity text box, enter a value from 0 
to 50 for the concavity of the arrowhead. 

Concavity value: 0% 

Concavity value: 25% 

Concavity value: 50% 
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To choose options for the line tool:

1. Double-click or Option-click the line tool in the toolbox.

The Line Tool Options dialog box appears.

..-— Line Tool options...

a. width: [E (piflelsl
Brrow Heads:

El Ht Star! I] Flt End 
2. Type the width you want for lines {in pixels).

3. Specify where you want arrowheads to appear by clicking the At Start option to

r. create lines with arrowheads at the starting points; the At End option to create

lines with arrowheads at the ending points; or both options to create lines with
arrowhead on both ends.

When the option is checked, arrowheads will appear on the specified end or ends

-'_ of lines you create with the line tool.

To specify the attributes for arrowheads with the line tool:

1. Double-click in the Width text box.

 
"' 2. Enter a value from 5 to 99 for the arrowhead width.

3. Press the Tab key or double-click in the Length text box, and enter a value from

7 to 99 for the arrowhead length.

_.— 4. Press the Tab key or double-click in the Concavity text box, enter a value from 0

to 50 for the concavity of the arrowhead.

a. ---———-——-.r Cencavity value: 0%

'“ —)'- Concavity value: 25%

*- Concavity value: 50%
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When you have finished choosing options for the line tool, click OK. 

Using the paint brush tool 
The paint brush tool paints the foreground color into an image. The paint brush 
tool, unlike the pencil tool, applies the paint with soft edges. The paint brush tool 
works on all types of images, except bitmapped and indexed color images. 

paint brush tool 

pencil tool 

To paint with the paint brush tool: 

1.1 11. Click the paint brush tool in the toolbox. 

2. Position the paint brush pointer where you want to begin painting. 

3. Holding down the mouse button, drag to lay down a brush stroke. 

4. To end the brush stroke, release the mouse button. 

Using the airbrush tool 

48 User Guide I 

The airbrush tool lays down a diffused spray of paint on an image. The tool works 
only on gray-scale and RGB images. You can specify the rate at which the airbrush 
tool deposits paint on the image. The higher the value you specify, the faster 
paint is deposited on the image. The Pressure parameter controls the rate of paint 
flow. 

I 
.-' 
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When you have finished choosing options for the line tool, click OK.

Using the paint brush tool

The paint brush tool paints the foreground color into an image. The paint brush

tool, unlike the pencil tool, applies the paint with soft edges. The paint brush tool

works on all types of images, except bitmapped and indexed color images.

paint brush tool

pencil tool 
To paint with the paint brush tool:

1. Click the paint brush tool in the toolbox.

2. Position the paint brush pointer where you want to begin painting.

3. Holding down the mouse button, drag to lay down a brush stroke.

4. To end the brush stroke, release the mouse button.

Mi

Using the airbrush tool

The airbrush tool lays down a diffused spray of paint on an image. The tool works

only on gray«scale and RG13 images. You can specify the rate at which the airbrush

tool deposits paint on the image. The higher the value you specify, the faster

paint is deposited on the image. The Pressure parameter controls the rate of paint
flow. ' '
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To paint with the airbrush tool: 

[&1. Click the airbrush tool in the toolbox. 

2. Position the pOinter where you want to begin spraying paint. 

3. Holding down the mouse button, drag to spray-paint the image. 

4. When you have finished airbrushing, release the mouse button. 

To specify the pressure for the airbrush tool: 

1. Double-click or Option-click the airbrush tool in the toolbox. 

The Airbrush Options dialog box appears. 

Airbrush Options ... n OK D 

• • • • • [ cancel) 

~ .•.... 
Spacing: EJ 

Fade-out: D 
Repeat Rate: ~ 

Pressure: le"- I % 

Custom 

Mode: 

® Normal 
o Color Only 
o Darken Only 
o lighten Only 

2. Enter a value from 1 to 100 in the Pressure text box. 

3. Click OK. 
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To paint with the airbrush tool:

1. Click the airbrush tool in the toolbox.

2. Position the pointer where you want to begin spraying paint.

3. Holding down the mouse button, drag to spray-paint the image.

4. When you have finished airbrushing, release the mouse button.

.36

To specify the pressure for the airbrush tool:

1. Double-click or Option-click the airbrush tool in the toolbox.

The Airbrush Options dialog box appears. 

Flirbrush Options...

 
Spacing: Mode:

©Normal

0 color Only

0 flarken Only
{3 Lighten Only

Fade—out:

Repeat Hate:

Pressure:

 
 

2. Enter a value from 1 to 100 in the Pressure text box.

3. Click OK.
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Using the rubber stamp tool 
The rubber stamp tool differs from other painting tools because it allows you to 
paint more than just a color onto an image. You can use the rubber stamp tool to 
pick up a sample of an image, pattern, or texture and place an exact copy (called 
a "clone") or a modified version of what you picked up on the same image or 
some other image. 

The rubber stamp tool includes options that control how you can paint a pattern, 
texture, or part of an image onto the image. The options include the aligned and 
non-aligned Clone options, the aligned and non-aligned Pattern options, and the 
Texture, Impressionist, and Revert options. The default rubber stamp option, 
which is the aligned Clone option, allows you to pick up an image, and paint in 
an exact duplicate of that image. 

To use the rubber stamp tool with its default options: 

I £ 11. Click the rubber stamp tool in the toolbox. 

2. Position the rubber stamp pointer on the part of the image you want to use. 

3. Hold down the Option key. 

4. Click the mouse button to take a sample of the image. 

S. Release the Option key. 

To paint with the rubber stamp tool using the selected image: 

1. Position the rubber stamp pointer where you want to begin painting. 

2. Hold down the mouse button. 

3. Drag to paint in the selected image. 

4. Release the mouse button. 

Rubber stamp tool options 

SO User Guide 

The Clone options allow you to choose part of an image and paint an exact copy 
of it elsewhere. The Revert option allows you to restore part of an image to the 
way it appeared the last time you saved the image. The Pattern options allow you 
to paint the current pattern on an image. The Texture option lets you select part 
of an image and paint a modified version of that part elsewhere. The Impression
ist option lets you create an impressionistic effect on an image. The selected op
tion is used throughout your Adobe Photoshop session until you choose another 
option. 
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To select the rubber stamp tool option you want to use: 

1. Double-click or Option-click the rubber stamp tool in the toolbox. 

The Rubber Stamp Options dialog box appears. 

Rubber Stamp Options ... 

• • • • • 
~ .•.... 

Custom 

Option: 

@ Clone (aligned) 
o Clone (non-aligned) 
o Reuert 
o TeHture 
o Pattern (aligned) 
o Pattern (non-aligned) 
o Impressionist 

[ OK ) 

( cancel) 

Spacing: 0 
Opacity: 1"IHlI'1o 

Mode: 

@Normal 
o Color Only 
o Darken Only 
o Lighten Only 

2. Click the name of the rubber stamp tool option you want. 

The radio button beside the selected option is highlighted. 

3. Click OK. 
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To select the rubber stamp tool option you want to use:

1. Double-click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.

Rubber Stamp Options...

(3} Clone (aligned)
C- Elone (non—aligned]
C} Reuert Mode:
OTeuture © Normal

C) Pattern [aligned] 0 Color Only
0 Pattern (non—aligned] O [Iarken Only

0 Impressionist C) Lighten only

 
2. Click the name of the rubber stamp tool option you want.

The radio button beside the selected option is highlighted.

3. Click OK.  
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The Clone option 

User Guide 

The Clone option for the rubber stamp tool allows you to paint an exact copy of 
a selected image. The Clone option lets you take a sample of the entire image, 
then paint the sampled image, starting at the point from which you took the sam
ple. Each stroke of the tool paints more of the image you sampled. 

To select the part of the image you want to clone, you select the rubber stamp 
tool and Option-click. When you position the pointer on the image and drag, a 
marker mirroring the painter's movement appears near the point where you 
Option-clicked. This marker identifies the part of the image you are currently 
painting. 

When you begin painting, what appears first is the part of the image that was 
under the rubber stamp pointer when you picked up your sample. As you stroke 
through a wider area, more of the image is reproduced. 

Two Clone options, aligned and non-aligned, determine what part of the 
sampled image appears first when you release the mouse button and start paint
ing elsewhere on the image with the tool. The aligned option paints the sampled 
image continuously, as if you continued to drag the rubber stamp tool to a new 
position. The non-aligned option always paints the sampled image from the 
paint where you started taking the sample. 

When the non-aligned option is active, each time you start painting in a different 
area, the sampled image is painted in starting from the point you originally 
Option-clicked on the image. This option is useful for painting in multiple copies 
of part of an image (such as a daffodil or tulip) on many different parts of an 
image. 

The aligned Clone option is useful in situations where you want to use different 
brushes to paint an image. You could select a large brush and paint the majority 
of the image, then select a small brush to paint the detailed areas. The aligned 
clone option ensures that the two different brush strokes (one with the large 
brush, the other with the small brush) create an image that lines up correctly. You 
could also use this option to paint two halves of an image, with one half on either 
side of another part of an image. 
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The Clone option

User Guide

The Clone option for the rubber stamp tool allows you to paint an exact copy of

a selected image. The Clone option lets you take a sample of the entire image,

then paint the sampled image, starting at the point from which you took the sam-

ple. Each stroke of the tool paints more of the image you sampled.

To select the part of the image you want to clone, you select the rubber stamp

tool and Option-click. When you position the pointer on the image and drag, a

marker mirroring the pointer’s movement appears near the point where you

Option-clicked. This marker identifies the part of the image you are currently

painting.

When you begin painting, what appears first is the part of the image that was

under the rubber stamp pointer when you picked up your sample. As you stroke

through a wider area, more of the image is reproduced.

 
Two Clone options, aligned and non—aligned, determine what part of the

sampled image appears first when you release the mouse button and start paint-

ing elsewhere on the image with the tool. The aligned option paints the sampled

image continuously, as if you continued to drag the rubber stamp tool to a new

position. The non-aligned option always paints the sampled image from the

point where you started taking the sample.

When the non-aligned option is active, each time you start painting in a different

area, the sampled image is painted in starting from the point you originally

Option-clicked on the image. This option is useful for painting in multiple copies

of part of an image (such as a daffodil or tulip) on many different parts of an

image.

The aligned Clone option is useful in situations where you want to use different

brushes to paint an image. You could select a large brush and paint the majority

of the image, then select a small brush to paint the detailed areas. The aligned

clone option ensures that the two different brush strokes (one with the large

brush, the other with the small brush) create an image that lines up correctly. You

could also use this option to paint two halves of an image, with one half on either

side of another part of an image.
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As an example, suppose you are working on an image that contains flowers and 
you want to paint an image of a tulip behind a leaf. To do this, you select the 
aligned Clone option from the Rubber Stamp Option dialog box, and Option
click on the image of the tulip, To paint the tulip behind the leaf, you position 
the tool on the left side of the leaf and paint the left side of the tulip, Then you 
release the mouse button, position the tool on the right side of the leaf and paint 
the right side of the leaf. This gives the effect of the tulip appearing behind the 
leaf. 

To use the non-aligned Clone option with the rubber stamp tool: 

1. Double-click or Option-click the rubber stamp tool in the toolbox. 

The Rubber Stamp Options dialog box appears. 

2. Select the Clone (non-aligned) option. Click OK. 

3. Position the pointer where you want to take a sample from the image, and Op-
tion-click. 

4. Position the pointer where you want to paint the cloned image. 

S. Holding down the mouse button, drag to paint the image. 

6. When you have finished painting the cloned image, release the mouse button . 

7. To paint in the cloned image starting again from the pOint you sampled the 
image, reposition the pointer, hold down the mouse button, and drag to paint 
the image. 

Clone (non-aligned) option selected 

First application of paint Second application of paint 
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To use the aligned Clone option with the rubber stamp tool: 

'1. Double-click or Option-click the rubber stamp tool in the toolbox. 

The Rubber Stamp Options dialog box appears. 

2. Select the Clone (aligned) option. Click OK. 

3. Position the pOinter where you want to take a sample from the image, and 
Option-click. 

4. Position the pOinter where you want to paint the cloned image. 

S. Holding down the mouse button, drag to paint the image. 

6. When you have finished painting in part of the cloned image, release the mouse 
button. 

7. Position the pOinter where you want to paint more of the cloned image. 

8. Holding down the mouse button, drag to paint the image. 

9. Continue repositioning the pointer and painting in the various parts of the 
cloned image until you have finished painting, then select a different tool. 

In the illustration below of the second application of paint, notice that the 
marker shows part of the original, sampled image you are currently painting. 

Clone (aligned) option selected 

First application of paint 

. .J 
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To use the aligned Clone option with the rubber stamp tool:

1. Double-click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.

2. Select the Clone (aligned) option. Click OK.

3. Position the pointer where you want to take a sample from the image, and

Option-click.

4. Position the pointer where you want to paint the cloned image.

5. Holding down the mouse button, drag to paint the image.

6. When you have finished painting in part of the cloned image, release the mouse
button.

7. Position the pointer where you want to paint more of the cloned image.

8. Holding down the mouse button, drag to paint the image.

9. Continue repositioning the pointer and painting in the various parts of the

cloned image until you have finished painting, then select a different too].

In the illustration below of the second application of paint, notice that the

marker shows part of the original, sampled image you are currently painting.

 
First application of paint Second application of paint
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r The Revert option 

The Revert option for the rubber stamp tool restores an area on the image to the 
way it appeared the last time you saved the document. This option allows you to 
experiment freely with an image, then selectively restore a portion of the image. 
The Revert option is similar to the eraser tool's magiC eraser mode, which restores 
part of an image to its state when you last saved it. The difference is that with the 
Revert option, you can specify a brush shape for the rubber stamp tool, and the 
brush is soft-edged rather than hard-edged. 

When you use the Revert option, the Adobe Photoshop program reads in the last 
saved version of the image from disk, and restores the portions of the image 
through which you drag the rubber stamp tool. When you begin painting using 
this option, it may take a few moments for the tool to start working while the 
image is read in from disk. 

To use the Revert option with the rubber stamp tool: 

1. Double-click or Option-click the rubber stamp tool in the toolbox. 

The Rubber Stamp Options dialog box appears. 

2. Select the Revert option from the Rubber Stamp Options dialog box. Click OK. 

3. Position the rubber stamp pointer where you want to begin restoring the image. 

4. Holding down the mouse button, drag until you have restored the desired 
portion of the image. 

5. Release the mouse button. 

Modified but unsaved version of image The Revert option restores the last saved 
version of the area through which you drag 
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The Texture option 

S6 User Guide 

The Texture option for the rubber stamp tool paints a modified version of a 
selected texture. You select the Texture option, then select a texture on an image. 
When you paint the image, the pixels in the texture are randomly distributed to 
prevent a repeating pattern from appearing. If you make several strokes through 
the same area, the pattern will be different each time. 

To use the Texture option with the rubber stamp tool: 

1. Double-click or Option-click the rubber stamp tool in the toolbox. 

The Rubber Stamp Options dialog box appears. 

2. Select the Texture option from the Rubber Stamp Options dialog box. Click OK. 

3. Position the pointer on the texture in the image you want, and Option-click. 

Texture selected 

4. Position the pOinter where you want to paint the texture. 

S. Holding down the mouse button, drag to paint the modified texture. 

6. When you have finished painting, release the mouse button. 

Image with texture added 
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The Texture option

The Texture option for the rubber stamp tool paints a modified version of a

selected texture. You select the Texture option, then select a texture on an image.

When you paint the image, the pixels in the texture are randomly distributed to

prevent a repeating pattern from appearing. if you make several strokes through

the same area, the pattern will be different each time.

To use the Texture option with the rubber stamp tool:

1. Double-click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.

2. Select the Texture option from the Rubber Stamp Options dialog box. Click OK.

3. Position the pointer on the texture in the image you want, and Option-click.

  

  

Texture selected

4. Position the pointer where you want to paint the texture.

5. Holding down the mouse button, drag to paint the modified texture.

6. When you have finished painting, release the mouse button.

Image with texture added
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The Pattern options 

Two Pattern options allow you to paint a pattern onto your image: the aligned 
Pattern option and the non-aligned Pattern option. Both Pattern options let you 
select a pattern, then use the rubber stamp tool to paint using the selected pat
tern. The aligned option repeats the pattern as contiguous, uniform tiles; even 
when you stroke several times over the same area, the pattern is repeated. The 
non-aligned option centers the pattern around the center of the rubber stamp 
pointer without maintaining the entire pattern for each stroke. 

To use the aligned Pattern option with the rubber stamp tool: 

1. Click the rectangular marquee tool in the toolbox. 

2. While holding down the mouse button, drag until you have selected the pattern 
you want to use; release the mouse button. 

3. Choose Define Pattern from the Edit menu. 

4. Double-click or Option-click the rubber stamp tool in the toolbox. 

The Rubber Stamp Options dialog box appears. 

5. Select the Pattern (aligned) option from the Rubber Stamp Options dialog box. 
Click OK. 
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6. Position the rubber stamp pointer where you want to begin painting. 

7. Holding down the mouse button, drag to paint in the pattern 

8. When you have finished painting, release the mouse button. 

First application of paint Second application of paint 

Aligned pattern 

To use the non-aligned Pattern option with the rubber stamp tool: 

1. Click the rectangular marquee tool in the toolbox. 

2. Holding down the mouse button, drag until you have selected the pattern you 
want to use. 

3. When you have selected your pattern, release the mouse button. 
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6. Position the rubber stamp pointer where you want to begin painting.

7. Holding down the mouse button, drag to paint in the pattern

8. When you have finished painting, release the mouse button.

 
First application of paint Second application of paint

 
Aligned pattern

To use the non~aligned Pattern option with the rubber stamp tool:

1. Click the rectangular marquee tool in the toolbox.

2. Holding down the mouse button, drag until you have selected the pattern you
want to use.

3. When you have selected your pattern, release the mouse button.
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4. Choose Define Pattern from the Edit menu. 

5. Double-click or Option-click the rubber stamp tool in the toolbox. 

The Rubber Stamp Options dialog box appears. 

6. Select the Pattern (non-aligned) option from the Rubber Stamp Options dialog 
box. Click OK. 

7. Position the rubber stamp pointer where you want to begin painting. 

8. Holding down the mouse button, drag to paint in the pattern. 

9. When you have finished painting, release the mouse button . 

First application of paint Second application of paint 

Non-aligned pattern 

The Impressionist option 

The Impressionist option for the rubber stamp tool creates textured designs based 
on the last saved version of a document. When you use the Impressionist mode, 
the Adobe Photoshop program reads in the colors from the last saved version of 
the area you drag through, and smears together the colors of the pixels beneath 
the brush to create an "impressionistic" effect. It may take a few moments for the 
rubber stamp tool to start working while the image is read in from disk. 
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To use the Impressionist option with the rubber stamp tool: 

1. Double-click or Option-click the rubber stamp tool in the toolbox. 

The Rubber Stamp Options dialog box appears. 

2. Select the Impressionist option from the Rubber Stamp Options dialog box. Click 
OK. 

3. Position the rubber stamp pointer where you want to begin painting. 

4. While holding down the mouse button, drag to paint the image. 

S. When you have finished painting, release the mouse button. 
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To use the Impressionist option with the rubber stamp tool:

1. Double~click or Option-click the rubber stamp tool in the toolbox.

The Rubber Stamp Options dialog box appears.

2. Select the Impressionist option from the Rubber Stamp Options dialog box. Click
OK.

3. Position the rubber stamp pointer where you want to begin painting.

4. While holding down the mouse button, drag to paint the image.

5. When you have finished painting, release the mouse button.

 

60 User Guide Petitioner Exhibit 1026 Page 84



r 
(' 

(""'\ 

(\ 

Chapter 6: Using the Editing Tools 

The Adobe Photos hop editing tools let you erase, smudge, blur, and sharpen 
specific parts of an image. The eraser tool changes pixels to the background color. 
The smudge tool simulates the effect of dragging a finger through wet paint. The 
blur tool diffuses the colors of pixels you drag the tool through, to create a less
focused image. The sharpen tool increases the contrast between adjacent pixels 
to sharpen an image. 

All of the editing tools include options. With the exception of the eraser tool, you 
can double-click a given editing tool to display the tool's options. The options 
include the ability to constrain an editing tool to a straight line, and edit only 
pixels that are lighter or darker than the foreground color. Chapter 7, "Painting 
and Editing Tool Options," describes the options common to all the editing tools. 

You can also use the Blur and Sharpen commands in the Image menu to blur or 
sharpen selected parts of an image or the entire image at once. The advantage of 
using the blur and sharpen tools is that they allow you to concentrate the blur or 
sharpen effect on a small area. 

For more information about the Blur and Sharpen commands, see the sections 
"Using filters to soften an image" and "Using filters to sharpen an image" in 
Chapter 17, "Using Filters to Modify Images." 

To use an editing tool: 

1. Click the desired editing tool in the toolbox. 

2. Position the tool pointer where you want to edit the image. 

3. Hold down the mouse button. 

4. Drag across the image. 

5. Release the mouse button when you have finished editing. 

Editing with the eraser tool 
The eraser tool changes pixels to the background color. This has the effect of 
"erasing" the pixels. You can erase just the pixels you drag through, or you can 
erase the entire image by double-clicking on the eraser tool in the toolbox. You 
can also use the eraser tool to restore part of the image to the last version you 
saved, using the magic eraser mode. You can undo your last erasure by immedi
ately choosing the Undo command from the Edit menu. 

You can use the eraser tool in the magiC eraser mode to restore part of an 
image to its state when you last saved the document. Unlike the Revert command 
in the File menu, which restores the entire image to its previous state, the eraser 
allows you to define specific parts of the image you want to restore. This opera
tion is similar to using the Revert option for the rubber stamp tool. However, the 
Revert option for the rubber stamp tool gives you more control over the area that 
is restored because you can specify the brush size for the tool. 
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The eraser tool always erases or restores the area beneath the tool pointer. The 
eraser always appears the same size, regardless of the magnification level. Thus, 
the size of the erased area depends on the magnification level of your view. For 
example, at a 1:1 view, the eraser pointer covers a 16-pixel-by-16-pixel area, 
whereas at a 16:1 magnification, it covers only a 1-pixel-by-1-pixel area . 

To erase part of an image by changing pixels to the background color: 

~l. Click the eraser tool in the toolbox. 

62 User Guide 

2. Position the eraser painter where you want to start erasing the image. 

3. Holding down the mouse button, drag through the part of the image you want 
to erase. 

4. When you have finished erasing the image, release the mouse button. 

To erase the entire image at once, double-click or Option-click the eraser tool in 
the toolbox. 

To use the eraser in the magic eraser mode to restore part of an image: 

1. Click the eraser tool in the toolbox. 

2. Position the eraser pointer where you want to begin restoring the image. 

3. Hold down Option key, then the mouse button. 

The pointer turns into the magic eraser pointer. 
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The eraser tool always erases or restores the area beneath the tool pointer. The

eraser always appears the same size, regardless of the magnification leve1.Thus,

the size of the erased area depends on the magnification level of your view. F0r

example, at a 1:1 view, the eraser pointer covers a 16-pixel-by-16-pixel area,

whereas at a 16:1 magnification, it covers only a l-pixel-by-l-pixel area.

To erase part of an image by changing pixels to the background color:

. Click the eraser tool in the toolbox.

2. Position the eraser pointer where you want to start erasing the image.

. Holding down the mouse button, drag through the part of the image you want
to erase.

4. When you have finished erasing the image, release the mouse button.

User Guide

 
To erase the entire image at once, double-click or Option-click the eraser tool in
the toolbox.

 
To use the eraser in the magic eraser mode to restore part of an image:

. Click the eraser tool in the toolbox.

Position the eraser pointer where yOu want to begin restoring the image.

. Hold down Option key, then the mouse button.

The pointer turns into the magic eraser pointer.
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4. Drag over the part of the image you want to restore. 

The area you drag through is restored to the way it looked when you last saved 
the document. 

Last saved version of image 

Magic eraser restoring part of image to last 
saved version 

Current, unsaved version of image 

5. When you have finished restoring the part of the image you want, release the 
mouse button and the Option key. 

Using the smudge tool 
The smudge tool allows you to simulate the effect of dragging a finger through 
wet paint. The smudge tool works on all types of images except bitmapped and 
indexed color images. When you use the smudge tool, the colors of the pixels you 
drag through are gradually dispersed until the colors dissipate completely. 

You can define the length of the smudge using the Pressure parameter. To 
produce a short smudge, specify a low value. To specify a smudge that continues 
until you stop painting with the smudge tool, specify the maximum value. 

To use the smudge tool: 

I f,J 11. Click the smudge tool in the toolbox. 
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2. Position the smudge pOinter on the area you want to smudge. 

3. Holding down the mouse button, drag to create the smudge. 

To specify a Pressure value for the smudge tool: 

1. Double-click or Option-click the smudge tool in the toolbox. 

The Smudge Tool Options dialog box appears. 

Smudge Tool Options ... ~ OK ) 

•• ( Cancel 1 ·G•••• • • • Custom 

Spacing: EJ Mode: 

D 
@ Normal 

Repeat Rate: o Color Only 

1~11·1"i~ 
o Darken Only 

Pressure: o lighten Only 
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2. Position the smudge pointer on the area you want to smudge.

 
3. Holding down the mouse button, drag to create the smudge.

 
To specify a Pressure value for the smudge tool:

1. Double-click or Option-click the smudge tool in the toolbox.

The Smudge Tool Options dialog box appears. 

Smudge Tool Options...

Spacing: El Mode:
{'9} Normal

Repeat Hate: El 830“: DHJQIor on n 9

Pressure: -% O Lighten Only
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2. Enter a value in the Pressure text box from 1 to 100. For a short smudge, specify 
a low value; for a smudge that continues until you stop painting, specify the 
maximum value of 100. 

3. Click OK. 

4. When you have finished smudging the image, release the mouse button. 

Before smudge 

Smudge tool : 30% pressure Smudge tool: 100% pressure 

Using the blur tool 
The blur tool makes part of an image less focused by diffusing the colors to which 
you apply it. The blur tool works on all types of images except bitmapped and 
indexed color images. You can control the intensity of the blur tool using the 
Pressure parameter. To apply a strong blur effect to an image, you specify a high 
Pressure value; to apply a weak blur effect, you specify a low Pressure value. 

To use the blur tool: 

[6J 1. Click the blur tool in the tool box. 

2. Position the blur pointer on the area you want to blur. 

3. Holding down the mouse button, drag to blur the image. 
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66 User Guide 

4. When you have finished blurring the image, release the mouse button. 

To control the intensity of the blur tool: 

1. Double-click or Option-click the blur tool in the toolbox. 

The Blur Tool Options dialog box appears. 

Blur Tool Options ... K OK D 

· G· • • ••••••• 
( Cancel) 

Spacing: 0 
Repeat Rate: ~ 

Pressure: MIMI '70 

Custom 

Mode: 

@ Normal 
o Color Only 
o Darken Only 
o lighten Only 
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4. when you have finished blurring the image, release the mouse button.

 
To control the intensity of the blur tool:

1. Double-click or Option-click the blur tool in the toolbox.

The Blur Tool Options dialog box appears.

Blur Tool Options...

('9) Normal

0 Color Only

0 Darker: Dnlg
O Lighten only
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2. Enter a value from 1 to 100 in the Pressure text box. Click OK. 

Before blur 

6 

Blur tool: 30% pressure Blur tool: 100% pressure 

Using the sharpen tool 
The sharpen tool allows you to make part of an image more focused . The sharpen 
tool works on all types of images except bitmapped and indexed color images. 
As you drag through part of an image, the sharpen tool increases the contrast 
between adjacent pixels. This results in a sharper, more focused image. 

You can control the intensity of the sharpen tool using the Pressure parameter. 
To apply a strong sharpening effect to an image, you specify a high Pressure 
value; to apply a weak sharpening effect, you specify a low Pressure value. 

To use the sharpen tool: 

US] 1. Click the sharpen tool in the tool box. 

2. Position the sharpen pointer where you want to start sharpening the image. 

3. Holding down the mouse button, drag to sharpen the image. 

4. When you have finished sharpening the image, release the mouse button. 

Chapter 6: Using the Editing Tools 67 Petitioner Exhibit 1026 Page 91

1333')"
'3

3573
U

2. Enter a value from 1 to 100 in the Pressure text box. Click OK.

 
Before blur

 
Blur tool: 30% pressure Blur tool: 100% pressure

Using the sharpen tool

The sharpen tool allows you to make part of an image more focused. The sharpen

tool works on all types of images except bitmapped and indexed color images.

As you drag through part of an image, the sharpen tool increases the contrast

between adjacent pixels. This results in a sharper, more focused image.

You can control the intensity of the sharpen tool using the Pressure parameter.

To apply a strong sharpening effect to an image, you specify a high Pressure

value; to apply a weak sharpening effect, you specify a low Pressure value.

To use the sharpen tool:

E 1. Click the sharpen tool in the tool box.
2. Position the sharpen pointer where you want to start sharpening the image.

3. Holding down the mouse button, drag to sharpen the image.

4. When you have finished sharpening the image, release the mouse button.

Chapmmmmmnuwmge 9157
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s. Release the mouse button when you have finished sharpening the image. 

To control the intensity of the sharpen tool: 

1. Double-click or Option-click the sharpen tool in the toolbox. 

The Sharpen Tool Options dialog box appears. 

2. Enter a value from 1 to 100 for the Pressure. 

Sharpen Tool Options ... 
[ OK D 

••••• ( Cancel) 

~ .•.... 
Custom 

Spacing: ~ Mode: 

D 
@Normal 

Repeat Rate: o Color Only 

IEii-11o o Darken Only 
Pressure: o Lighten Only 
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5. Release the mouse button when you have finished sharpening the image.

 
To control the intensity of the sharpen tool:

1. Double~click or Option-click the sharpen tool in the toolbox.

The Sharpen Tool Options dialog box appears.

2. Enter a value from 1 to 100 for the Pressure.

Sharpen Tool Options... 

Spacing: El

Repeat Hale: Cl 0 Color Only
0 Darken IJnIg

Pressure: “(L Q Lighten only

(9 Normal 
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3. Click OK. 

Before sharpening Sharpen tool : 100% pressure 
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3. Click OK.

 
Before sharpening

 
i

Sharpen tool: 100% pressure
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Chapter 7: Painting and Editing Tool Options 

All of the painting and editing tools include a variety of options that allow you 
to achieve particular effects. For each of the painting tools, you can choose a pre
set brush shape or customize your own. For either the painting or editing tools, 
you can specify which pixels are affected by the paint. You can also paint or edit 
with straight lines. For certain tools, you can control the opacity, distribution, 
repeat rate, and fade-out rate of the paint. 

Most of the options function in a similar manner. You can select a separate 
option for each specific tool, such as a different brush shape. The options you 
choose for each tool remain in effect during the current Adobe Photoshop session 
until you choose another option. 

Selecting a tool brush shape 
Brush shapes for the painting and editing tools include round, square, and linear 
shapes in different sizes. You can choose a brush shape two ways: using either 
the tool options dialog box, which appears when you double-click the tool in the 
toolbox; or using the Show Brushes command in the Window menu, which 
displays the Brushes window. 

The Brushes window allows you to select different brushes easily without having 
to open a dialog box each time. The Brushes window retains the brush settings 
for each tool. This allows you to select a different brush for each of the painting 
and editing tools. The active brush for the current tool is enclosed by a box. 

You can move the Brushes window to a convenient location on the screen by 
positioning the pointer on the gray bar at the top of the window and dragging. 

To remove the Brushes window from view, either click the window's close box, 
or choose Hide Brushes from the Window menu. 

To choose the brush shape you want for a particular tool: 

1. Double-click or Option-click the painting or editing tool in the toolbox you 
want. 
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The options dialog box for that tool appears. 

Paint Brush Options ... 

•• ·G•••• • • • Custom 

Spacing: D Mode: 

n OK D 
[ cancel) 

Fade-out: D @Normal 
o Color Only 

Repeat Rate: D o Oarlcen Only 
o lighten Only 

Opacity: 1"1111170 

2. Click the brush shape you want to use. 

3. Click OK. 

To select a brush from the Brushes window: 

1. Choose Show Brushes from the Window menu . 

The Brushes window appears. 

lDimmmnnniminninmmiiiiiiiigiiiiinimnnnnniniimmmiin .. -.. •••• • •• 
Custom 

2. Click the painting or editing tool you want in the toolbox. 

3. Click the brush you want. 

A box appears around the brush to show it is selected. 
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Selecting a custom brush shape 
You can define a custom brush shape to suit your needs. The brush shape you de
fine can be no more than 64-pixels-by-64-pixels in size and should appear on a 
solid white background. The custom brush you define is placed among the brush 
shape options for all of the painting tools . The brush is labeled "Custom" in the 
tool dialog boxes and the Brushes window. 

Only one custom brush shape at a time can be active for all the tools. However, 
you can create a variety of custom brushes, store them in a document, then open 
that document and select the one you want to use at a particular time. To define 
brushes with soft edges, you can select brush shapes composed of pixels with gray 
values other than 0 (black) and 255 (white). 

To define a custom brush shape: 

I [~J 11. Click the rectangular marquee tool in the toolbox. 

2. Holding down the mouse button, drag the marquee to enclose the part of the 
image you want to use as a custom brush. 

~*-----I I I 
I I 
I I 
I I 
L ______ ~ 

Selecting a custom brush Painting with a custom brush 

3. When the marquee encloses the part of the image you want, release the mouse 
button. 

4. Choose Define Brush from the Edit menu. 

The selected custom brush is placed in the Brushes window and in the painting 
and editing tools dialog boxes . 

• • • • • •••• • • • 
~I*I 
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Selecting a custom brush shape

You can define a custom brush shape to suit your needs. The brush shape y0u de-

fine can be no more than 64-pixels-by-64-pixels in size and should appear on a

solid white background. The custom brush you define is placed among the brush

shape options for all of the painting tools. The brush is labeled "Custom" in the

tool dialog boxes and the Brushes window.

Only one custom brush shape at a time can be active for all the tools. However,

you can create a variety of custom brushes, store them in a document, then open

that document and select the one you want to use at a particular time. To define

brushes with soft edges, you can select brush shapes composed of pixels with gray

values other than 0 (black) and 255 (white).

To define a custom brush shape:

-1 1. Click the rectangular marquee tool in the toolbox.

2. Holding down the mouse button, drag the marquee to enclose the part of the
image you want to use as a custom brush. 

 
  

Selecting a custom brush Painting with a custom brush

3. When the marquee encloses the part of the image you want, release the mouse
button.

4. Choose Define Brush from the Edit menu.

The selected custom brush is placed in the Brushes window and in the painting

and editing tools dialog boxes.
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Specifying paint distribution 
You can specify the distance between the pixels that are affected by each painting 
and editing tool. For example, if you specify 12 pixels as the spacing value for the 
pencil, the pencil lays down a mark once every 12 pixels as you drag across the 
image. If you specify 0, the distribution of paint is based on the speed of the 
mouse movement. If you drag quickly across an image, gaps probably will appear 
in the trail of pixels left by the tool. A spacing value other than 1 is useful when 
you paint with a large, custom brush. 

To specify a spacing value for a painting or editing tool: 

1. Double-click or Option-click the desired painting or editing tool in the toolbox. 
The options dialog box for the selected tool appears. 

2. Click in the Spacing text box. 

3. Enter a value from 1 to 999 for the spacing value you want. 

4. Click OK. 

" .. • • 

• 
• 

• • • • • • 

• • • • • • • • • 

Paint brush spacing parameter: 0 Paint brush spacing parameter: 40 

• • 

Specifying the paint opacity 

74 User Guide 

You can specify how opaque you want the paint in your image to be using the 
Opacity option for the painting tools. The Opacity option allows you to use paint 
that ranges from nearly transparent to opaque. To use transparent paint, you 
specify a low percentage value; to use opaque paint, you specify a high value. 

To specify a value for the opacity of the paint: 

1. Double-click or Option-click the desired painting tool in the toolbox. 

The options dialog box for the selected tool appears. 

2. Double-click in the Opacity text box. 

3. Enter a value from 1 to 100. 
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4. Click OK. 

Paint brush opacity value: 30% Paint brush opacity value: 80% 

Specifying the paint repeat rate 
With the exception of the pencil, line, eraser, and rubber stamp tools, you can 
specify the rate at which paint is deposited on the image by the painting and 
editing tools when the mouse is stationary. The higher the Repeat Rate value, the 
more paint is deposited on the image. 

In the case of the editing tools, like the blur tool, the Repeat Rate controls how 
fast the operation is performed when the mouse is motionless. For example, to 
blur an image a lot in a short time, you specify a high value for the Repeat Rate, 
and hold down the blur tool on the area you want to blur. 

To specify the repeat rate for a painting or editing tool: 

1. Double-click or Option-click the desired painting or editing tool in the toolbox. 

The options dialog box for the selected tool appears. 

2. Click in the Repeat Rate text box. 

3. Enter a value from 1 to 60. 

4. Click OK. 

Airbrush repeat rate: 50 Airbrush repeat rate: 1 
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4. Click OK.

Paint brush opacity value: 30% Paint brush opacity value: 80%

Specifying the paint repeat rate

With the exception of the pencil, line, eraser, and rubber stamp tools, you can

specify the rate at which paint is deposited on the image by the painting and

editing tools when the mouse is stationary. The higher the Repeat Rate value, the

more paint is deposited on the image.

In the case of the editing tools, like the blur tool, the Repeat Rate controls how

fast the operation is performed when the mouse is motionless. For example, to

blur an image a lot in a short time, you specify a high value for the Repeat Rate,

and hold down the blur tool on the area you want to blur.

To specify the repeat rate for a painting or editing tool:

1. Double-click or Option-click the desired painting or editing tool in the toolbox.

The options dialog box for the selected tool appears.

2. Click in the Repeat Rate text box.

3. Enter a value from 1 to 60.

4. Click OK.

  
Airbrush repeat rate: 50 Airbrush repeat rate: 1
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Specifying the paint fade-out rate 
You can specify the rate at which the paint brush and airbrush fade out as you 
paint with them to simulate an actual brush stroke. The fade-out rate determines 
how many pixels are colored with each stroke before the paint fades out com
pletely. The higher the fade-out value, the longer the paint will flow before it 
fades out. You can also specify a negative value to make the paint fade from the 
foreground color to the background color. 

To specify the fade-out rate for the paint brush and airbrush tools: 

1. Double-click or Option-click the paint brush or airbrush tool in the toolbox. 

The options dialog box for the selected tool appears. 

2. Click in the Fade Out text box. 

3. Enter a value from -999 to 999. 

4. Click OK. 

Airbrush fade-out rate: 60 Airbrush fade-out rate: 120 

Selecting a painting mode 

76 User Guide 

You can control which pixels are affected by paint according to the painting 
mode you choose for a painting or editing tool. The modes include Normal, 
Darken Only, Lighten Only, and Color Only. In the default Normal mode, all the 
pixels you apply paint to are changed to the foreground color. But you can also 
choose to work in a mode in which only pixels lighter or darker than the fore
ground color are changed. Or, you can choose a mode that changes only the hue 
and saturation of a pixel. 

To choose the painting mode you want for a painting or editing tool: 

1. Double-click or Option-click the desired painting or editing tool in the toolbox. 

The options dialog box for the selected tool appears. 

2. Click the mode you want. 

3. Click OK. 

Following are descriptions of how the modes work. 
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Specifying the paint fade-out rate

You can specify the rate at which the paint brush and airbrush fade out as you

paint With them to simulate an actual brush stroke. The fade-out rate determines

how many pixels are colored with each stroke before the paint fades out comn

pletely. The higher the fade-out value, the longer the paint will flow before it

fades out. You can also specify a negative value to make the paint fade from the

foreground color to the background color.

To specify the fade-out rate for the paint brush and airbrush tools:

1. Double-click or Option-click the paint brush or airbrush tool in the toolbox.

The options dialog box for the selected tool appears.

2. Click in the Fade Out text box.

3. Enter a value from -999 to 999.

4. Click OK.

 
Airbrush fade-out rate: 60 Airbrush fade—out rate: 120

Selecting a painting mode

User Guide

You can control which pixels are affected by paint according to the painting

mode you choose for a painting or editing tool. The modes include Normal,

Darken Only, Lighten Only, and Color Only. In the default Normal mode, all the

pixels you apply paint to are changed to the foreground color. But you can also

choose to work in a mode in which only pixels lighter or darker than the fore-

ground color are changed. Or, you can choose a mode that changes only the hue

and saturation of a pixel.

To choose the painting mode you want for a painting or editing tool:

. Double-click or Option-click the desired painting or editing tool in the toolbox.

The options dialog box for the selected tool appears.

. Click the mode you want.

. Click OK.

Following are descriptions of how the modes work.
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Normal 

When the Normal mode is active, each pixel you apply paint to is changed to the 
foreground color. This is the default option, and how the painting and editing 
tools normally operate. 

Darken Only 

When the Darken Only mode is active, only the pixels that are lighter than the 
foreground color are changed to the foreground color. Lightness is measured by 
the pixel's brightness value. The pixels that are darker than the foreground color 
are not changed. 

Lighten Only 

When the Lighten Only mode is active, only the pixels that are darker than the 
foreground color are changed to the foreground color. The pixels that are lighter 
than the foreground color are not changed. 
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Color Only 

When the Color Only mode is active, all of the pixels you apply paint to are 
changed to the foreground color, but their luminosity values are not changed. 
This preserves the texture in the image. This mode is useful for coloring mono
chrome images or for tinting color images. 

I 
NOTE: Luminosity is a color parameter that measures the brightness of a color. 
Luminosity is expressed as a value. The value is computed as the weighted average of 
the pixel's RGB values, expressed as a percentage. The expression is: Luminosity = 

(.30 x Red) + (.59 x Green) + (.11 x Blue). 

Painting and editing with straight brush strokes 

78 User Guide 

Using the Shift key, you can paint straight brush strokes with the pencil, paint 
brush, airbrush, and rubber stamp painting tools, and you can edit straight paths 
with the editing tools. 

To paint straight brush strokes or edit straight paths: 

1. Select the desired painting or editing tool from the toolbox. 

2. Click the image where you want the straight brush stroke or path to start. 

3. Hold down the Shift key. 

4. Position the pOinter where you want the straight brush stroke or path to end. 
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Color Only

when the Color Only mode is active, all of the pixels you apply paint to are

changed to the foreground color, but their luminosity values are not changed.

This preserves the texture in the image. This mode is useful for coloring mono-

chrome images or for tinting color images.

 
NOTE: Luminosity is a color parameter that measures the brightness ofa color.

Luminosity is expressed as a value. The value is computed as the weighted average of

the pixei’s KGB values, expressed as a percentage. The expression is: Luminosity =

(.30 at Red) + (.59 J: Green) + (.11 x Blue).

Painting and editing with straight brush strokes

Using the Shift key, you can paint straight brush strokes with the pencil, paint

brush, airbrush, and rubber stamp painting tools, and you can edit straight paths

with the editing tools.

To paint straight brush strokes or edit straight paths:

1. Select the desired painting or editing tool from the toolbox.

2. Click the image where you want the straight brush stroke or path to start.

3. Hold down the Shift key.

4. Position the pointer where you want the straight brush stroke or path to end.
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r 
r S. Click the mouse button. 

-------------- 8 
~--~-j.' 

6. Continue moving the pointer and clicking the mouse button until you have 
defined all of the straight brush strokes or paths you want. 

~~ 
----~-~- !J ----r 

To resume defining freehand lines: 

7. Release the Shift key. 

8. Drag to define a freehand line or an irregular path. 
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5. Click the mouse button.

M

6. Continue moving the pointer and clicking the mouse button until you have

defined all of the straight brush strokes or paths you want.

To resume defining freehand lines:

7. Release the Shift key.

8. Drag to define a freehand line or an irregular path.
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Chapter 8: Using the Type Tool 

The Adobe Photoshop program allows you to enter bitmapped type on an image 
using the type tool. This chapter describes how to use the type tool to enter type 
on an image. It covers how to select type options, including typeface, size, lead
ing, and styles; and how to add, edit, move, and align type. 

Bitmapped type is different from the outline type that is generated in object
oriented applications. Bitmapped type is rendered at the resolution of the image. 
For example, if the resolution of the image is 100 pixels per inch, the resolution 
of the type in the image is also 100 pixels per inch. 

Outline type is rendered at the resolution of the output device. If the output 
device's resolution is 2500 dpi, then the outline type is rendered at 2500 dpi. Also, 
you can edit (delete and change the font, size, and style of characters) outline 
type, but you cannot edit bitmapped type in the Adobe Photoshop program after 
you have placed it on the image. 

Normally, large bitmapped type appears jagged on the screen. But if you use 
Adobe Type Manager'" (ATM"') software, the type appears as smooth and as well
defined as outline type. 

You have a number of options to control the type you enter. You can specify the 
typeface and point size, and select style options like underlining and italics. The 
options you select remain in effect until you change them or quit the Adobe 
Photoshop program. 

Using type in an image 
To use type in an image, you select the type tool, click on the image where you 
want the type to appear, then enter the type you want into the Type dialog box. 
The same dialog box lets you select type options. When you close the Type dialog 
box, the type appears selected on the image. 

While the type is selected, you can move the entire text block or just individual 
characters. This allows you to kern, or adjust the letterspacing, in the type. 

To adjust the letterspacing, you can choose to either deselect certain characters 
in a text block and move the remaining selected characters, or select the charac
ters you want to move and deselect the other characters in the text block. Once 
you deselect the type, it becomes part of the image, and you can only change the 
type by editing the pixels that comprise the characters. 
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To enter type in an image: 

[TI 1. Click the type tool in the toolbox. 

2. Position the pointer where you want the type to appear on the image. 

82 User Guide 

The pointer changes to the I-beam painter. 

I 

3. Click the mouse button. 

The Type dialog box appears. 

Font: Geneua 

Leading: 

Spacing: 

Style: 

DBold 
D Italic 
D Underline 

Type 

D Outline 
D Shadow 
D Anti-aliased 

Alignment: 
@Left 

( OK n 
( Cancel 1 

o Center 
o Right 

~I 
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4. Enter the type you want in the text box, up to 255 characters at a time. The type 
automatically wraps at the right margin of the box, but appears as one continu
ous string on the image. To specify a line break, press the Return key; or click 
where you want the line to break, and press the Return key. 

Type 

Font: Geneua 

Size: 12 I I point I 
~==:I Leading: . 
~==: 

Spacing: I 
Style: 

DBoid o Outline 
o Italic o Shadow 
o Underline o Anti-aliased 

Alignment: 
@Left 

, OK » 
( cancel) 

o Center 
o Right 

To break a line, click where you want the Iline to break, 
and press the Return key. 

If you reach the bottom of the box while entering type, the type automatically 
scrolls up. 

S. Click OK. 

Scrolling the type 

To scroll the type up or down: 

1. Click in the text box. 

2. Holding down the mouse button, drag in the direction you want to scroll. 

The type scrolls in the direction you drag. 

3. When the type you want is displayed, release the mouse button. 
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4. Enter the type you want in the text box, up to 255 characters at a time. The type

automatically Wraps at the right margin of the box, but appears as one continu—

ous string on the image. To specify a line break, press the Return key; or click

where you want the line to break, and press the Return key.
     

Fllignment:

I] Outline © Left
|:| Shadow C) Center

I] Underline I] FInti—aliased Q Flight 

To break a line, click where you want the |Iine to break,
and press the Return keg. 

If you reach the bottom of the box while entering type, the type automatically

scrolls up.

5. Click OK.

Scrolling the type

To scroll the type up or down:

1. Click in the text box.

2. Holding down the mouse button, drag in the direction you want to scroll.

The type scrolls in the direction you drag.

3. When the type yOu want is displayed, release the mouse button.
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Editing type 

84 User Guide 

You can edit type in the Type dialog box using standard Macintosh text-editing 
procedures. There are two ways to select the type in the text box that you want 
to edit, described below. Once the text is placed on the image and deselected, you 
can no longer edit it. 

To delete type in the text box: 

1. In the text box in the Type dialog box, click to the right of the type you want to 
delete. 

2. Press the Delete key to backspace over type. 

Type 

Font: Geneua 

leading: 

Spacing: 

Style: R1ignment: 
@left 

n OK l 
( Cancel) 

D Bold 
D Italic 

D Outline 
D Shadow o Center 

D Underline D Rnti-aliased o Right 

To edit the type in the teHt bOH: 
1. Click behind the type you want to delete. 
2. Press the Delete key to backspaq ouer type. 

To select a single word, double-click the word. 

) 

\ , 
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To select a block of text, method 1: 

1. In the text box in the Type dialog box, click where you want the selection to 
begin. 

2. Holding down the mouse button, drag until the block of text you want is 
selected, then release the mouse button. 

Type 

Font: Geneua 

Size: 12 II point I 
:==:::::::1 Leading: 

Spacing: 

Style: 
D Bold 
D Italic 
D Underline 

D Outline 
D Shadow 
D Anti-aliased 

To select a block of text, method 2: 

1. Click where you want the selection to begin. 

Alignment: 
@ Left 

t OK 1 
( Cancel J 

o Center 
o Right 

2. Without pressing down the mouse button, position the pointer to the right of 
the text you want to select. 

3. Hold down the Shift key, and click the mouse button. 

The block is selected from the starting point to the end point you specified. 

The steps below describe how to choose attributes for type, including font, size, 
leading, and style. 
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To select a block of text, method 1:

1. In the text box in the Type dialog box, click where you want the selection to

begin.

2. Holding down the mouse button, drag until the block of text you want is
selected, then release the mouse button.
     

fllignment:

E] outline ("9) left

[I Italic I] Shadow 0 Center

[I Underline I] flnti-aliased O Flight 

. Click where you want the selection to begin:
'. Holding down the mouse button drag until the block of

tent you mantis selected, then release the mouse
 
 

To select a block of text, method 2:

1. Click where you want the selection to begin.

2. Without pressing down the mouse button, position the pointer to the right of
the text you want to select.

3. Hold down the Shift key, and click the mouse button.

The block is selected from the starting point to the end point you specified.

The steps below describe how to choose attributes for type, including font, size,

leading, and style.
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Choosing a font 
To choose the font you want to use: 

1. In the Type dialog box, position the pointer on the box next to Font. 

2. Hold down the mouse button. 

A pop-up menu listing the fonts available in your system appears . 

.... 
Geneua 
Heluetica 
Monaco 

3. Drag until the font you want is highlighted, and release the mouse button. 

The name of the font you chose appears in the box. 

Choosing a font size 

86 User Guide 

You can choose to specify the size for the type in either points or pixels, from 4 
to 1000. The size range may be less if points are the unit of measure and resolu
tion is not 72 dpi. 

To specify the unit of measure you want to use for the type: 

1. In the Size text box in the Type dialog box, position the painter on the box 
labeled either "point" or "pixel." 

2. Hold down the mouse button. 

A pop-up menu appears. 

3. Drag to highlight the unit of measure, and release the mouse button. 

~ 
~ 
The chosen unit of measure appears on the box. 

To specify the size of the type: 

1. Double-click in the Size text box. 

2. Enter a value from 4 to 1000. 

) 

) 

) 
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Choosing a font

To choose the font you want to use:

1. In the Type dialog box, position the pointer on the box next to Font.

2. Hold down the mouse button.

A pop-up menu listing the fonts available in your system appears.

A.

Geneua

Helueiica
Monaco 

3. Drag until the font you want is highlighted, and release the mouse button.

The name of the font you chose appears in the box.

Choosing a font size

You can choose to specify the size for the type in either points or pixels, from 4

to 1000. The size range may be less it points are the unit of measure and resolu-

tion is not 72 dpi.

To specify the unit of measure you want to use for the type:

1. In the Size text box in the Type dialog box, position the pointer on the box

labeled either "point" or “pixel.”

2. Hold down the mouse button.

A pop-up menu appears.

3. Drag to highlight the unit of measure, and release the mouse button.

 
The chosen unit of measure appears on the box.

To specify the size of the type:

1. Double—click in the Size text box.

2. Enter a value from 4 to 1000.
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Selecting style options for type 
You can apply Style options to type so that it appears underlined, in italics, 
shadowed, outlined, and bold. 

The Style options have a cumulative effect on type. For example, if you select 
Shadow and Underline, the type appears both shadowed and underlined on the 
image. 

To select the Style options you want, click the desired style options in the Type 
dialog box. 

As you select an option, the box beside it is checked. To revert to plain type, 
un check all of the Style options. 

g llmiM'tillf)lW ®if 
~~ glj 1!lIDW!~ 

~ 

Entering anti-aliased type 

The anti-aliased Style option lets you enter type with edges that appear smooth. 
The smooth edges allow the type to blend into the background. You will probably 
want to use anti-alia sed type in an image, except when you enter type in small 
paint sizes. 

The anti-alia sed Style option requires that you use a font that has a bitmapped 
screen font that is two, three, or four times the size of the type you are entering, 
unless you are using ATM software and the desired font is installed in your sys
tem. For example, if you apply the anti-alia sed option to 12-point Times, you 
must have installed on your system a 24-point, 36-point, or 48-point size Times 
screen font. 
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Selecting style options for type

You can apply Style options to type so that it appears underlined, in italics,

shadowed, outlined, and bolt].

The Style options have a cumulative effect on type. For example, if you select

Shadow and Underline, the type appears both shadowed and underlined on the

image.

To select the Style options you want, click the desired style options in the Type

dialog box.

As you select an option, the box beside it is checked. To revert to plain type,

uncheck all of the Style options.

 
Entering anti-aiiased type

The anti—aiiased Style option lets you enter type with edges that appear smooth.

The smooth edges allow the type to blend into the background. You will probably

want to use anti-aliased type in an image, except when you enter type in small

point sizes.

The anti-aliased Style option requires that you use a font that has a bitmapped
screen font that is two, three, or four times the size of the type you are entering,

unless you are using ATM software and the desired font is installed in your sys~

term. For example, if you apply the anti-aliased option to 12-point Times, you
must have installed on your system a 24-point, 36-point, or 48-point size Times
screen font.
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To apply the anti-aliased type option to your type, click the Anti-aliased Style 
option. 

A A 
Type with anti-aliasing Type without anti-aliasing 

Choosing the character spacing 

You can control the spacing between characters, called kerning, in a text block 
using the type tool's spacing parameter. The spacing parameter uses the same 
unit of measure that you specified for the font size. Enter positive values to 
increase the spacing; enter negative values to decrease the spacing. Spacing incre
ments can be as small as tenths of a point or pixel. 

To specify a value for character spacing: 

1. In the Type dialog box, click the Spacing text box. 

2. Enter a value from -99.9 to 999.9. 

Choosing the line spacing 

User Guide 

You can choose the line spacing, called leading, you want for type. The line 
spacing is measured from baseline to baseline of the lines of text. By default, the 
leading built into the font is used. The leading uses the same unit of measure you 
specify for the font size, either points or pixels. 

To specify the amount of line spacing you want to use: 

1. Click in the Leading text box in the Type dialog box. 

2. Enter a value from 1 to 1000 to specify the spacing between lines of text. 

) 
./ 

, 
~, 

J 
-./" 
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To apply the anti—aliased type option to your type, click the Anti—aliased Style

option.

Type with anti-aliasing Type without anti-aliasing

Choosing the character spacing

You can control the spacing between characters, called kerning, in a text block

using the type tool’s spacing parameter. The spacing parameter uses the same

unit of measure that you specified for the font size. Enter positive values to

increase the spacing; enter negative values to decrease the spacing. Spacing incre-

ments can be as small as tenths of a point or pixel.

To specify a value for character spacing:

1. In the Type dialog box, click the Spacing text box.

2. Enter a value from -99.9 to 999.9.

Choosing the line spacing

You can choose the line spacing, called leading, you want for type. The line

spacing is measured from baseline to baseline of the lines of text. By default, the

leading built into the font is used. The leading uses the same unit of meaSure you

specify for the font size, either points or pixels.

To specify the amount of line spacing you want to use:

1. Click in the Leading text box in the Type dialog box.

2. Enter a value from 1 to 1000 to specify the spacing between lines of text.

baseline 
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Aligning type 
You can choose how to align type according to the point you clicked on with the 
type tool pOinter. If you want to align the type so that it is centered on the image, 
choose the type tool, click on the center of the image, then choose Center align
ment in the Type dialog box. 

To choose the type alignment option you want, click the Left, Center, or Right 
button. 

left 
aligned type 

center 
aligned type 

Completing the type selection 

right 
aligned type 

When you have selected the type options you want to use and you have finished 
entering the type, click OK. 

The type appears selected on the image and is filled with the current foreground 
color. While the type is selected, you can modify it as you can any other selection. 
That is, you can fill it, rotate it, transform it, and so on. 

Once you deselect the type, it becomes part of the image. You can select the pixels 
in the type as you would other pixels in the image, then modify the pixels. How
ever, you cannot change the type attributes of type once it is placed on the image. 
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Aligning type

You can choose how to align type according to the point you clicked on with the

type tool pointer. If you want to align the type so that it is centered on the image,

choose the type tool, click on the center of the image, then choose Center align-

ment in the Type dialog box.

To choose the type alignment option you want, click the Left, Center, or Right
button.

left center right

aligned type aligned type aligned type 
Completing the type selection

When you have selected the type options you want to use and you have finished

entering the type, click OK.

The type appears selected on the image and is filled with the current foreground

color. While the type is selected, you can modify it as you can any other selection.

That is, you can fill it, rotate it, transform it, and so on.

 
Once you deselect the type, it becomes part of the image. You can select the pixels

in the type as you would other pixels in the image, then modify the pixels. How-

ever, you cannot change the type attributes of type once it is placed on the image.
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Moving type on the image 
You can move the text block, as long as it is still selected, to where you want it to 
appear on the image. 

To move the type: 

1. Position the pointer on one of the characters in the text block until the arrow 
pointer appears. 

2. Holding down the mouse button, drag the text block to where you want the text 
to appear. 

3. When you have positioned the type as desired, release the mouse button. 

01', ~.r...~. ~~.t',1~" 0:-

4 t-JC ) ~ '-J'JI 0"· 
v 'Mo:Virig~ type on 
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Special type selection options 

90 User Guide 

While a text block is selected on an image and the type tool is active, you can de
select individual characters and words in the text block, and move the characters 
that are still selected. This allows you to move characters closer to adjust the 
letterspacing, or kerning, or simply move certain characters to another position 
on the image. 

The type tool allows you to select the parts of an image you want to modify. 
While the type is still selected, the type tool is active, and when you press down 
the Command key and mouse button, the Type tool pointer changes to the lasso 
tool. The lasso tool then works in a special way to allow you to deselect characters 
in a text block. 

To deselect characters in a text block: 

1. Make sure that the type tool is selected. 

2. Hold down the Command key. 

The pointer turns into the lasso. 

3. Holding down the mouse button, drag the lasso around the character or charac
ters you do not want to adjust. 

) 

~' 

) 
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4. When the characters are enclosed by the lasso, release the mouse button and the 
Command key. 

The characters you encircled with the lasso are deselected. 

You can now move or modify the other characters in the text block without 
affecting the characters you deselected. 

If you want, you can use a similar procedure to select the characters you want to 
move and deselect the other characters. 

To select the characters you want to move: 

1. Hold down the Shift and Command keys . 

2. Holding down the mouse button, drag the lasso tool around the characters you 
want to remain selected. 

The characters you encircled with the lasso tool remain selected, and the other 
characters are deselected. You can now move the selected characters closer to the 
deselected characters to kern the type. 

3. When the characters you want are enclosed by the lasso tool, release the mouse 
button and the Shift and Command keys. 

;-[~ 1 . 00 

I NOTE: Make sure that you encircle the entire character you want to select; any portion 
of a character outside the lasso tool will not be selected. 
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4. When the characters are enclosed by the lasso, release the mouse button and the

Command key.

The characters you encirciecl with the lasso are deselected.

'lf‘ool 
You can now move or modify the other characters in the text block without

affecting the characters you deselected.

If you want, you can use a similar procedure to select the characters you want to
move and deselect the other characters.

To select the characters you want to move:

1. Hold down the Shift and Command keys.

2. Holding down the mouse button, drag the lasso tool around the characters you
want to remain selected.

The characters you encircled with the lasso tool remain selected, and the other
characters are deselected. You can now move the selected characters closer to the

deselected characters to kern the type.

3. When the characters you want are enclosed by the lasso tool, reiease the mouse

button and the Shift and Command keys.

I.'

ool  
NOTE: Make sure that you encircle the entire character you want to select; any portion

of a character outside the lasso tool will not be selected.
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92 User Guide 

To adjust the letterspacing: 

1. Position the painter on one of the selected characters. 

2. Hold down the mouse button. 

3. When the arrow pointer appears, drag the characters until you are satisfied with 
how the type looks. To constrain the movement to a straight line, hold down the 
Shift key. 

4. If you constrained the movement, release the mouse button and the Shift key. 

S. Deselect the type. 

I NOTE: You can use the arrow keys to move the selected characters in l-pixel incre
ments. Simply press the arrow key that points in the direction you want to move the 
type. 

. ) 

.-./ 

) 
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Chapter 9: Making Selections 

This chapter describes how to use the Adobe Photoshop program selection tools 
and commands to select parts of an image. The Adobe Photoshop program selec
tion tools allow you to select images in a variety of ways and with a range of 
precision. The chapter also describes alpha channels and how to modify, edit, 
and store selections. An alpha channel is an 8-bit, gray-scale representation of an 
image. 

In addition to the standard lasso and marquee selection tools, you can also use 
the magic wand tool to automatically select images. This tool lets you select parts 
of an image based on the similarity of colors. This way, you can easily select a 
specific part of an image without having to laboriously trace its outline. You can 
also add to and subtract from a selection. 

The selection remains in effect until you deselect it. Once you select a portion of 
an image, you can modify it without affecting the rest of the image. For example, 
if you drag the eraser through a selection and continue through a part of the 
image that isn't selected, the non-selected portion of the image remains un
changed. You can flip, rotate, and freely move selections, as well as adjust their 
color characteristics. 

Using the selection tools 
The selection tools include the lasso tool, the rectangular and elliptical marquees, 
and the magiC wand. These tools and their commands are described in the fol
lowing section. 

Using the lasso tool 

The Adobe Photoshop program lets you isolate areas of an image using several 
selection tools, including the marquee and lasso tools. The lasso tool is a freehand 
tool that lets you define any arbitrary selection area. You can use the lasso tool to 
trace the outline of a selection. Once you make a selection, you can add to it or 
subtract from it. You can also use the lasso tool to select straight line segments, 
or a combination of straight and freehand lines. The pixels in the selection will 
be affected by the changes you specify. 

To use the lasso tool: 

I p 11. Click the lasso tool in the toolbox. 

2. Position the lasso pointer where you want the selection to begin. 

3. Holding down the mouse button, drag to trace the outline of the selection area. 
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4. To close the selection border, release the mouse button. 

You can either drag to the starting pOint of the selection and release the mouse 
button to complete the selection, or release the mouse button when you have 
enclosed most of the selection. When you release the mouse button before the 
selection is completed, a straight line is projected to the beginning of the selec
tion to complete the selection for you automatically. 

Adding to and subtracting from a selection 

If you have not selected the area you wanted, you may alter the selection by 
adding to it or subtracting from it. 

To add to a selected area: 

1. Holding down the Shift key, then press the mouse button, drag to trace the out
line of your selection to add it to the original lassoed selection. 

I NOTE: If you click the mouse button without first pressing the Shift key, you will lose 
the first selection. 

2. When you have finished making your selection, release the Shift key and the 
mouse button. 

A new lasso appears around the two selections. 

.; 

Petitioner Exhibit 1026 Page 11894 User Guide

4. To close the selection border, release the mouse button.

 
You can either drag to the starting point of the selection and release the mouse

button to complete the selection, or release the mouse button when you have

enclosed most of the selection. When you release the mouse button before the

selection is completed, a straight line is projected to the beginning of the selec-

tion to complete the selection for you automatically.

 
Adding to and subtracting from a selection

If you have not selected the area you wanted, you may alter the selection by

adding to it or subtracting from it.

To add to a selected area:

. Holding down the Shift key, then press the mouse button, drag to trace the out-

line of your selection to add it to the original lassoed selection.

NOTE: Ifyou click the mouse button without firstpressing the Shift key, you will lose

the first selection.

. When you have finished making your selection, release the Shift key and the
mouse button.

A new lasso appears around the two selections.
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To subtract from a selected area: 

l. Hold down the Command key, and press the mouse button. 

2. Trace the outline of the selection. Make sure that you completely surround the 
first lasso border. If you do not connect the end points of the new lasso that is 
selecting the area to be removed, you will bisect the lasso into two, separate lassos. 

3. Release the Command key and the mouse button. The new, reduced lasso appears 
around the selection. 

Selecting a combination of straight and freehand lines with the lasso tool 

While you use the lasso tool, you can use the Option key to define straight line 
segments. This feature is useful for selecting parts of an image that contain recti
linear shapes, such as a window, a door, or a box. 

You can use a combination of straight line segments and freehand drawing with 
the lasso tool. This is useful on objects that combine straight lines and curves. As 
you select a combination of straight and freehand lines, you must continue 
holding down the Option key. Click to define starting and end pOints of straight 
line segments; to draw freehand lines, hold down the mouse button and drag. 

To select a combination of straight and freehand lines using the lasso tool: 

1. Press down the mouse button. 

2. To define the selection area, hold down the Option key. 

3. Release the mouse button where you want the straight line to start. 

4. Position the pointer where you want the line to end, and click the mouse button. 

A selection line is attached to the pOinter. 
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To define additional straight line segments, continue repositioning the pOinter 
and clicking the mouse button. 

I NOTE: You must continue to hold the Option key or a straight line will automatically 
be drawn between the two ends of the lasso. 

5. To resume defining freehand parts of the selection, press down the mouse button 
and drag instead of moving the pOinter and clicking. 

6. When you have finished making your selection, release the mouse button and 
the Option key. 

I NOTE: You can move a lassoed selection. To do so, position the lasso pointer inside 
the selection, press the mouse button, and drag the selection to the desired location. 
Release the mouse button. To undo the move, choose Undo from the Edit menu. 

Using the marquee tools 

96 User Guide 

The Adobe Photoshop program includes a rectangular marquee to make rectan
gular-shaped selections and an elliptical marquee to make elliptical-shaped selec
tions. The options available for both tools are very similar. You can specify a fixed 
size in pixels, as well as a height-to-width ratio, when using these tools. Both tools 
include the option of specifying the horizontal and vertical dimensions of the se
lection marquee. 

~, 

J 
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To define additional straight line segments, continue repositioning the pointer
and clicking the mouse button.

 
NOTE: You must continue to hold the Option key orn straight line witl automatically

be drawn between the two ends of the lasso.

5. To resume defining freehand parts of the selection, press down the mouse button

and drag instead of moving the pointer and clicking.

 
6. When you have finished making your selection, release the mouse button and

the Option key.

the selection, press the mouse button, and drug the selection to the desired location.I NOTE: You can move it inssoed selection. To do so, position the lasso pointer inside
Release the mouse button. To undo the move, choose Undo from the Edit menu.

Using the marquee tools

The Adobe Photoshop program includes a rectangular marquee to make rectan—

guiar-shaped selections and an elliptical marquee to make elliptical-shaped selec—

tions. The options available for both tools are very similar. You can specify a fixed

size in pixels, as well as a height-to-width ratio, when using these tools. Both tools

include the option of specifying the horizontal and vertical dimensions of the se-

lection marquee.
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( The rectangular marquee tool also lets you select a single row or column of pixels 
on the image. The options you select for the tools remain in effect throughout 
your Adobe Photoshop session or until you change the options. 

To use the rectangular or elliptical marquee tool: 

1. Click the desired marquee tool in the toolbox. 

2. Position the marquee pointer where you want to begin the selection. 

3. Hold down the mouse button, and drag in a diagonal direction to enclose the 
selection with the selection border. 

The selection border appears around the selection. 

4. When you have enclosed the selection with the border, release the mouse button. 

Selecting a single row or column of pixels 

You can use the rectangular marquee tool to select either a single row or a 
column, one-pixel wide, on the image. You can cut, copy, and otherwise modify 
the one-pixel line as you would any other selection. 

To select a row or column of pixels on the image using the rectangular 
marquee: 

I [~J 11. Double-click the rectangular marquee tool in the toolbox. 

2. Click Single Row to select a single horizontal row of pixels or click Single Column 
to select a single vertical column of pixels. 

3. Click OK. 

4. Position the marquee pointer near the row or column you want to select. 

5. Hold down the mouse button. 

6. Drag to position the selection border on the row or column you want to select, 
then release the mouse button. 
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A single selection line appears on the drawing. 

Creating selections from a corner or from the center 

You can define a selection from either a corner or from the center lof the rectan
gular or elliptical marquee. By default, when you define a marquee selection, you 
define it from a corner. You use the Option key to define the selection from the 
center. 

To create a marquee selection from the center: 

1. Click either the rectangular or elliptical marquee tool in the toolbox. 

2. Position the pointer where you want the center of the selection to appear. 

3. Hold down the Option key and mouse button, and drag to define the selection 
marquee. 

4. When you have defined your selection, release the mouse button. 

Defining a fixed size for the marquee tools 

You can define a fixed size for each of the selection marquees. Instead of defining 
the size of the selection border by dragging with the mouse, you can use this 
option to specify values for the height and width of the selection marquee. This 
option is useful when you want to select an area of a specific size. 

To specify a fixed size for a marquee tool: 

Double-click or Option-click either the rectangular or elliptical marquee tool in 
the toolbox. 

J 
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The dialog box for the selected marquee tool appears. 

Rectangular Marquee Options ... 

@ Normal 
n OK n 

o Constrained Aspect Ratio: [ cancel) 

Width: 11 
~~ 

Height: '-11 __ ---' 

o FiHed Size: 

Width: r-16-4---' (piHels) 

Height: 1-16_4_--, (piHels) 

o Single Row 

o Single Column 

2. Click Fixed Size. 

3. Enter the value you want for the width (in pixels). 

4. Press the Tab key or double-click in the Height text box. 

5. Enter the value you want for the height (in pixels). 

6. Click OK. 

To define a marquee with the dimensions entered above: 

1. Position the marquee pointer in the lower-right corner of the area you want to 
select. 

2. Holding down the mouse button, drag to position the marquee where you want it. 

Fixed size of 125 by 75 pixel marquee 

3. Release the mouse button . 

Chapter 9: Making Selections 99 Petitioner Exhibit 1026 Page 123

eweww

The dialog box. for the selected marquee tool appears.

6) Normal

0 Constrained Flspect Ratio:

width: I:

Height: |:|

Rectangular Marquee Options...

0 Filled Size:

width: [pinels]

Height: (pixels)

O Single Row

0 Single Column

 
 

. Click Fixed Size.

Enter the value you want for the width (in pixels).

Press the Tab key or double-click in the Height text box.

Enter the value you want for the height {in pixels}.

Click OK.

To define a marquee with the dimensions entered above:

. Position the marquee pointer in the lower-right corner of the area you want to
select.

Holding down the mouse button, drag to position the marquee where you want it.

 
. L

Fixed size of 125 by 75 pixel marquee

 

Release the mouse button.

RatfilpmrgEmiWPflmmsw
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Defining a size ratio option for the marquee tools 

The Adobe Photoshop program lets you specify a height-to-width ratio, called the 
"aspect ratio," for each type of marquee. To define a square-shaped marquee or a 
round marquee, you enter the same values for the height and width. If you want 
to use a marquee that is twice as wide as its height, you would enter 2 for the 
width and 1 for the height. You can use decimal values (2.5, for example) for the 
width and height. 

To specify the aspect ratio for either marquee tool: 

1. Double-click or Option-click the desired marquee tool in the toolbox. 

The options dialog box for the selected marquee tool appears. 

2. Click Constrained Aspect Ratio. 

3. Double-click in the Width text box, and enter the value for the width. 

4. Press the Tab key or double-click in the Height text box, and enter the value for 
the height. 

5. Click OK. 

To define a selection marquee with the ratio entered above: 

1. Position the marquee pointer where you want the selection to begin. 

2. Holding down the mouse button, drag the marquee to the desired position. 

3. When you have defined your selection, release the mouse button. 

Constrained aspect ratio of 2 by 1 

A selection marquee with the specified aspect ratio appears on the image. 

J 
.J 
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Defining a size ratio option for the marquee tools

The Adobe Photoshop program lets you specify a height-to-width ratio, called the

"aspect ratio, ” for each type of marquee. To define a square-shaped marquee or a

round marquee, you enter the same values for the height and width. If you want

to use a marquee that is twice as wide as its height, you would enter 2 for the

width and 1 for the height. You can use decimal values (2.5, for example} for the

width and height.

To specify the aspect ratio for either marquee tool:

1. Double-click or Option-click the desired marquee tool in the toolbox.

The options dialog box for the selected marquee tool appears.

2. Click Constrained Aspect Ratio.

3. Double-click in the Width text box, and enter the value for the width.

4. Press the Tab key or double-click in the Height text box, and enter the value for

the height.

5. Click OK.

To define a selection marquee with the ratio entered above:

1. Position the marquee pointer where you want the selection to begin.

2. Holding down the mouse button, drag the marquee to the desired position.

3. When you have defined your selection, release the mouse button.

 
ii-

Constrained aspect ratio of 2 by I
 

A selection marquee with the specified aspect ratio appears on the image.
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Defining a feather edge using the lasso and marquee tools 

You can apply a feather edge to a selection. A feather edge is an area around the 
border of a selection to which a change is partially applied. Both the lasso and 
marquee tools allow you to create a feather edge. If you fill a selection that has a 
feather edge, the color in the fill gradually blends in with the colors surrounding 
the selection and the colors within the feather edge radius inside the selection. 

A feather edge can range in width from 1 to 64 pixels. The value you specify for 
the feather edge indicates how far inside and outside the selection border you 
want the change to extend until it blends into the surrounding pixels. The value 
you enter for the feather edge must be less than the width of the selection. The 
lasso tool will not make the selection if the feather edge is larger than the selec
tion area. 

You can use the feather edge feature on a selection on which you are adjusting 
the contrast or color balance. In this case, the feather edge will soften the transi
tion between the selection and the surrounding pixels. You can also use the 
Feather command in the Select menu to feather a selection. 

The feather edge feature works on all image types except bitmapped and indexed 
color images. To use the feather edge feature on an indexed color image, first 
convert the image to an RGB image, make your selection and modifications, and 
then convert the image back to the indexed color format. 

To define the feather edge for the lasso tool: 

1. Double-click or Option-click the lasso tool. 

The Lasso Options dialog box appears. 

lasso Options ... R OK D 
Feather: III_I (piHels) ( cancel) 

2. Enter the range (in pixels) around the selection border that you want to be affected 
by changes. 
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-' ' You can apply a feather edge to a selection. A feather edge is an area around the

border of a selection to which a change is partially applied. Both the lasso and

'"' marquee tools allow you to create a feather edge. If you fill a selection that has a

feather edge, the color in the fiil gradually blends in with the colors Surrounding

--” the selection and the colors within the feather edge radius inside the selection.

A feather edge can range in width from 1 to 64 pixels. The value you specify for

the feather edge indicates how far inside and outside the selection border you

want the change to extend until it blends into the Surrounding pixeis. The value

you enter for the feather edge must be less than the width of the selection. The

lasso tool will not make the selection if the feather edge is larger than the selec-
tion area.

,_. YOu can use the feather edge feature on a selection on which you are adjusting

the contrast or color balance. In this case, the feather edge will soften the transi-

._ tion between the selection and the surrounding pixeis. You can also use the
Feather command in the Select menu to feather a selection.

F The feather edge feature works on all image types except bitrnapped and indexed

color images. To use the feather edge feature on an indexed color image, first

-" convert the image to an RGB image, make your selection and modifications, and

then convert the image back to the indexed color format.

To define the feather edge for the lasso tool:

1. Double-ciick or Option—click the lasso tool.

The Lasso Options dialog box appears.

Lasso Options...

Feather: [nil-IBIS] 
2. Enter the range (in pixels) around the selection border that you want to be affected

by changes.
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3. Click OK. 

Feather value: 5 Feather value: 25 

To specify the range (in pixels) of the feather edge for the marquee tools: 

1. Click either the rectangular or elliptical marquee tool in the toolbox. 

2. Select the part of the image to be modified. 

3. Choose Feather from the Select menu. 
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The Feather dialog box appears. 

Feather. .. n OK D 
Radius: IE I (piHels) ( Cancel) 

4. Enter a value from 1 to 64 (pixels) for the feather edge. 

The illustration below shows how a change is applied to the feathered edge of a 
selection. 

Feather value: 5 Feather value: 1 5 

Using the magic wand 

The magic wand tool is a versatile selection tool that allows you to select portions 
of images by simply clicking on them. The Adobe Photoshop program compares 
the color values of adjacent pixels to determine if they are within the color range 
(or "tolerance ") specified for the magic wand. The pixels within that color toler
ance are selected. In addition, the magic wand tool allows you to control the 
amount of feathering, or anti-aliasing, applied to a selection with the Fuzziness 
parameter. 

Because the pixels that form a specific part of an image may have similar color 
values, the magic wand tool allows you to select part of an image simply by click
ing on it. In addition, specifying the tolerance value for the color comparison 
enables you to choose how extensive you want the selection to be. For example, 
you can choose either to select just the dark hair of a person in an image, or the 
person's lighter clothing as well. 
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The Feather dialog box appears.

Feather...

Radius: initials} 
4. Enter a value from 1 to 64 (pixels) for the feather edge.

The illustration below shows how a change is applied to the feathered edge of a
selection.

 
Feather value: 5 Feather value: 15

Using the magic wand

The magic wand tool is a versatile selection tool that allows you to select portions

of images by simply clicking on them. The Adobe Photoshop program compares

the color values of adiacent pixels to determine if they are within the color range

(or "tolerance”} specified for the magic wand. The pixels within that color toler-

ance are selected. In addition, the magic wand tool allows you to control the

amount of feathering, or anti-aliasing, applied to a selection with the Fuzziness
parameter.

Because the pixels that form a specific part of an image may have similar color

values, the magic wand tool allows you to select part of an image simply by click-

ing on it. In addition, Specifying the tolerance value for the color comparison

enabies you to choose how extensive you want the selection to be. For example,

you can choose either to select just the dark hair of a person in an image, or the

person’s lighter clothing as well.
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The color comparison is based on three values: the color value of the pixel you 
click with the magic wand pointer, the tolerance value, and the adjacent pixels. 
If you specify a tolerance value of 25 and click a pixel with a color value of 100, 
the adjacent pixels with color values in the range 75 to 125 will be selected. 
Tolerance ranges from 0 to 255. 

To make a selection using the magic wand tool: 

1. Click the magic wand tool in the toolbox. 

2. Position the magic wand pointer on the part of the image you want to select. 

3. Click the mouse button. 

Specifying the color tolerance 

The Tolerance parameter for the magic wand tool specifies the color range of the 
pixels you will select using the wand. Enter a value close to 0 to select pixels with 
very similar colors; enter a value close to 255 to select pixels with dissimilar colors. 

To specify the color tolerance parameter: 

1')\,. 11. Double-click or Option-click the magic wand tool in the toolbox. 

104 User Guide 

The Magic Wand Options dialog box appears. 

Magic Wand Options ... 

Tolerance: lewl 
Fuzziness: EJ 

n OK J 
( Cancel) 

2. Enter a value from 0 to 255 for the tolerance level. 
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3. Click OK. 

Tolerance value: 45 Tolerance value: 100 

Controlling the amount of anti-aliasing in a selection 

The Fuzziness parameter controls the amount of anti-aliasing that is applied 
when you make a selection with the magic wand tool or fill in an image with the 
paint bucket tool. Whereas the Tolerance parameter controls how similar the 
colors in pixels have to be for the pixels to be selected, the Fuzziness parameter 
controls the amount of anti-aliasing that is applied to the edge of the selection. 
The amount of anti-aliasing is determined by the extent to which the pixels just 
beyond the selected pixels are partially selected. Fuzziness ranges from 0 to 255. 

You can experiment with different fuzziness values on your image, or you can 
determine a precise amount of fuzziness to apply, as described below. 

Normally, when you apply a change to an image, such as filling an image with a 
color or changing the colors in a selection, all of the change is applied to the 
selected pixels. When a pixel is partially selected, on the other hand, the changes 
you apply only partially affect that pixel. 
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If the fuzziness value is 0, the pixels surrounding the selected pixels, called the 
edge pixels, are not selected at all, and the edges around the selection are jagged. 
As you increase the fuzziness value, the edges become progressively less jagged, 
up to a certain point; after that point, the edges become jagged again because the 
edge pixels become selected to the point where all their color becomes visible and 
they form a new jagged edge. 

Several factors affect the fuzziness including the color value of the pixel you click, 
the color value of the edge pixels, and the fuzziness value itself. The extent to 
which the edge pixels are selected is determined using the following formula: 
(fuzziness value - out of tolerance band value)/fuzziness value = the extent to 
which an edge pixel is selected. 

The tolerance band is the range from the highest value to the lowest value of the 
pixels that are selected. For example, if the highest color value of the pixels in the 
selection is 100 and the lowest color value in the selected pixels is ISO, the toler
ance band is from 100 to SO. The pixels outside the tolerance band but within the 
fuzziness range are partially selected. 

When using the magic wand, you should specify a value for the fuzziness param
eter that produces a smooth edge along the selection. In most cases, the default 
fuzziness value (64) should produce acceptable results. Selections that contrast 
sharply with the background require higher fuzziness settings than selections 
that only contrast slightly with the background. If the selection is too jagged, you 
can experiment by entering higher or lower color values for the fuzziness. 

/ 
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To specify the amount of fuzziness to be applied to a selection: 

1. Double-click or Option-click the magic wand tool in the toolbox. 

The Magic Wand Options dialog box appears. 

2. Press the Tab key or double-click in the Fuzziness text box. 

3. Enter a value from 0 to 255. 

4. Click OK. 

Fuzziness value: 10 Fuzziness value: 150 

Deselecting all selections 
You can deselect all current selections by using the None command in the Select 
menu, or by clicking on the image with any of the selection tools except the 
magic wand tool. 

To deselect everything in the image: 

1. Choose None from the Select menu, or click one of the selection tools in the 
toolbox (except the magic wand tool). 

2. Click the image. 

All of the selections are deselected. 
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Editing selection borders 
A selection border is a border that defines a selected area. The selection tools 
allow you to edit a selection border. You can move the selection border, hide 
or show it, delete part of the selection border or add to it, or select intersecting 
borders to expand a selection. 

In addition, you can define the width of the border around a selection using the 
Fringe command in the Select menu. 

Selecting a border around a selection 

108 User Guide 

Once you make a selection, you can define the width of the border surrounding 
the selection. The Fringe command in the Select menu allows you to select a 
fringe area around the current selection. The fringe area is an area of a specified 
width around the selection border. 

The Fringe command works only on part of an image. If you select all of an image, 
the option will be dimmed. 

To specify the width of the selection border: 

1. Choose Fringe from the Select menu. 

The Fringe dialog box appears. 

Fringe ... E OK n 
Width: II I (piNels) ( cancel) 

2. Enter the width for the fringe border in pixels. 

3. Click OK. 

The selection border with the specified width appears around the selection. The 
area inside the selection border is not selected. 

Selection without fringe border Fringe value: S 
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Editing selection borders
A selection border is a border that defines a selected area. The selection tools

allow you to edit a selection border. You can move the selection border, hide

or show it, delete part of the selection border or add to it, or select intersecting

borders to expand a seiection.

In addition, you can define the width of the border around a selection using the
Fringe command in the Select menu.

Selecting a border around a selection

Once you make a selection, you can define the width of the border Surrounding

the selection. The Fringe command in the Select menu allows you to select a

fringe area around the current selection. The fringe area is an area of a specified
width around the selection border.

The Fringe command works only on part of an image. If you select all of an image,

the option will be dimmed.

To specify the width of the selection border:

1. Choose Fringe from the Select menu.

The Fringe dialog box appears.

Fringe...

width: Initials] 
2. Enter the width for the fringe border in pixels.

3. Click OK.

The selection border with the specified width appears around the selection. The
area inside the selection border is not selected.

 
Selection without fringe border Fringe value: .5

108 User Guide Petitioner Exhibit 1026 Page 132



( \ 

Moving a selection border 

Once you define a selection on an image, you can move the selection border 
around the image without moving the pixels inside the selection border. If you 
create a selection border that is the size you want, but you want to position it 
around another part of an image, this feature allows you to place the selection 
border where you want it, without having to define it again. 

To move a selection border: 

1. Click one of the selection tools in the toolbox. 

2. Position the pointer within the selection border. 

The pointer changes to the arrow pointer. 

3. Hold down the Command and Option keys and the mouse button, and drag the 
selection to the position you want it. 

4. Release the mouse button. 

Original selection Selection border moved to new position 

5. As an option, to move the selection border in I-pixel increments, hold down the 
Command and Option keys and press the arrow key pointing in the direction you 
want to move the selection border. 

Hiding and showing the selection border 

If you find the flashing black-and-white selection border distracting, or if it 
obscures changes that affect the edges of selections, you can use the Hide Edges 
command in the Select menu to temporarily hide the selection border. Any 
changes you specify, such as fills or color adjustments, are still applied to the 
current selection. 

The Hide Edges command only affects the current selection. The selection border 
reappears when you make another selection, and new selection borders appear 
around any additional selections you make. As with making any selection, once 
you hide a selection border, you must hold the Shift key before making a second 
selection. Otherwise, your first selection will be deselected. When you select the 
Hide Edges command and then make a second selection, both selections will be 
displayed. 
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To hide the selection border around the current selection, choose Hide Edges 
from the Select menu; the selection border is hidden from view. 

Selection borders visible Selection borders hidden 

To redisplay the selection border around the current selection, choose Show Edges 
from the Select menu. 

Editing a selection border 

110 User Guide 

If you have not selected the exact area you want, you can alter the selection by 
adding to the border using the magic wand tool, or subtracting from it using the 
magic wand, lasso tool, or type tool. You can use these tools to edit a selection 
border created with any of the selection tools. 

The magiC wand tool also allows you to both add to or subtract from a selection 
border. You use the magiC wand tool to add to a selection border, whether the 
original selection was made with the magiC wand tool or another selection tool. 
The magiC wand tool works differently than the lasso or type tool in subtracting 
from a selection. When you use the magiC wand tool to subtract from a selection, 
the pixels that are subtracted are within the color tolerance value specified for the 
magic wand tool. 

The lasso and the type tool only subtract from a selection border. When you use 
the lasso tool to delete part of a selection, the pixels you enclose with the lasso 
tool are deselected, regardless of their color values. You use the lasso tool to delete 
part of a selection border from a non-floating selection. 

If a selection is floating, you use the type tool to subtract a portion of it. A floating 
selection is a selection you moved or pasted into an image. If you're working with 
a floating selection and use the lasso tool to deselect a portion of it, you'll actually 
delete the selection, not deselect it. Once you select the type tool and hold down 
the Command key and drag, the lasso pointer appears automatically. 

.. :-/ 
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To add to a selection using the magic wand tool: 

1. Double-click or Option-click the magic wand tool in the toolbox. 

The Magic Wand Options dialog box appears. 

2. Enter a value from 0 to 255 for the tolerance value. Click OK. 

3. Position the magic wand pointer on the part of the selection you want to expand. 

4. Holding down the Shift key, click the mouse button. 

The selection border is expanded for the pixels that have color values within the 
tolerance range. 

To subtract from a selection using the magic wand tool: 

1. Double-click or Option-click the magic wand tool in the toolbox. 

The Magic Wand Options dialog box appears . 

2. Enter a value from 0 to 255 for the tolerance value. Click OK. 

3. Position the magic wand pointer on the part of the selection you want to deselect. 

4. Holding down the Command key, click the mouse button. 

The selection border is removed from the pixels that fall within the tolerance 
range specified for the magic wand tool. 

To subtract from a border around a non-floating selection using the 
lasso tool: 

1. Click the lasso tool in the toolbox. 

2. Position the lasso pointer where you want to start subtracting from the selection 
border. 

3. Holding down the Command key and the mouse button, drag to define the part 
of the selection border you want to deselect. 

4. When you have finished making your selection, release the mouse button and 
the Command key. 
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The area you defined is subtracted from the selection border. 

To subtract from a border around a floating selection using the type tool: 

1. Click the type tool in the toolbox. 

2. Position the I-beam pOinter where you want a selection to begin. 

3. Hold down the Command key and the mouse button. 

The type tool turns into the lasso pointer. 

4. Drag to define the part of the selection border you want to deselect. 

s. When you have finished making your selection, release the mouse button and 
the Command key. 

Selecting the intersection of selections 

112 User Guide 

The Adobe Photoshop program allows you to use any selection tool to select the 
intersection of two or more selections. (You make multiple selections by holding 
down the Shift key and clicking the areas you want to select, then releasing the 
Shift key.) If you have two or more selections on an image, you can use this 
feature to select an area that is common to the current selections. You can use the 
magic wand to select the intersection of selections. However, when you use the 
magiC wand, you click on the image to define the area of intersection, instead of 
dragging on the image. 
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The area you defined is subtracted from the selection border.

 
To subtract from a border around a floating selection using the type tool:

1. Click the type tool in the toolbox.

2. Position the I-beam pointer where you want a selection to begin.

3. Hold down the Command key and the mouse button.

The type tool turns into the lasso pointer.

4. Drag to define the part of the selection border you want to deselect.

5. When you have finished making your selection, release the mouse button and

the Command key.

Selecting the intersection of selections

The Adobe Photoshop program allows you to use any selection tool to select the

intersection of two or more selections. (You make multiple selections by holding

down the Shift key and clicking the areas you want to select, then releasing the

Shift key.) If you have two or more selections on an image, you can use this
feature to select an area that is common to the current selections. You can use the

magic wand to select the intersection of selections. However, when you use the

magic wand, you click on the image to define the area of intersection, instead of

dragging on the image.
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To select common areas using a selection tool: 

1. Click one of the selection tools (except the magic wand tool) in the toolbox. 

2. Position the pOinter where you want the selection to begin. 

3. Hold down the Command and Shift keys and the mouse button. 

4. Drag to define the area of intersection that you want to select. 

S. When you have finished making your selection, release the mouse button and 
the Command and Shift keys. 

The areas in the selections that are within the selection border are selected, as 
illustrated below. 

Extending selections 
The Adobe Photos hop program provides many different ways to select several 
parts of an image at the same time. This extended selection feature lets you add 
to the current selection. You can use the lasso and marquee tools to select parts 
of an image that are widely separated and have no color similarities, or the magic 
wand tool to select parts that are similar in color. You can also use the selection 
commands to select all of an image at once, to select parts of the image that are 
similar in color to the current selection, or to select only the border around an 
image. 

You can use the selection tools with the Shift key to select different parts of the 
image that have nothing in common with the current selection. 

To extend a selection: 

1. Click one of the selection tools in the toolbox. 

2. Hold down the Shift key and the mouse button. 

3. Use the selection tool to select the other part of the image. 
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The selection border appears around the second selection. 

Original selection Extended selection 

4. When you have finished making your selections, release the mouse button and 
the Shift key. 

Selecting an entire image 

When you want to cut, copy, fill, or otherwise edit an entire image, you can use 
the All command in the Select menu. 

To select all of the image at once, choose All from the Select menu. 

The selection border surrounds the entire image. 

Selecting similar colors 

114 User Guide 

The Grow and Similar commands in the Select menu allow you to expand a 
selection to include parts of the image that are similar in color to the current 
selection. The color comparisons are based upon the Tolerance and Fuzziness 
settings in the Magic Wand Options dialog box. 

The Grow and Similar commands compare the colors of pixels based on the range 
of color values of the pixels within the current selection. 

Petitioner Exhibit 1026 Page 138



The Grow command extends the selection to include pixels adjacent to the selec
tion that fall within the specified Tolerance and Fuzziness range, as illustrated 
below. The Similar command selects pixels throughout the image, not just the 
ones next to the selection, that fall within the specified range. If the Similar 
command does not select all the areas you want, you can select a part of the 
image that contains colors that are representative of the colors you want to select, 
and then choose the Similar command again. 

The Similar and Grow commands do not work on bitmap-type images. 

To extend the selection to include adjacent pixels within the color range specified 
for the magic wand in the Magic Wand Options dialog box, choose Grow from 
the Select menu. 

The selection border appears around the adjacent pixels within the color range. 

Original selection Grow command applied 

To extend the selection to pixels anywhere on th,e image that fall within the 
specified color range, choose Similar from the Select menu. 

The selection border appears around all of the pixels throughout the image that 
fall within the color range. 

Similar command applied 
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Selecting the non-selected parts of an image 

At times, it might be more convenient to select large parts of an image by first 
selecting the parts you don't want to modify, and then automatically selecting 
the larger portions of the image. The Inverse command in the Select menu allows 
you to do this. 

To select the part of the image that is not currently selected, choose Inverse from 
the Select menu. The remaining, unselected portion of the image is selected. The 
originally selected part of the image is deselected. 

Removing "fringe" around a selection 

116 User Guide 

When you make a selection, some of the surrounding pixels normally are included. 
Once you copy the selection and paste it elsewhere, some of the surrounding pixels 
are copied and pasted along with the selection, which is now called a floating 
selection. At times, you may want to eliminate the excess pixels, called "fringe," 
around a floating selection. (A floating selection is a selection that was moved or 
pasted on in image. It floats above the pixels in the underlying image until you 
deselect it.) 

For example, if you select part of an image and paste it onto a white background, 
you may want to trim the fringe or excess pixels around the selection. The fringe 
pixels contain a mixture of the colors in the selection and background colors 
around the selection. 

The Defringe command in the Select menu allows you to remove the fringe 
around a floating selection. The Defringe command replaces the color of the 
fringe pixels with the colors of nearby pixels that contain the pure colors in the 
selection. The pixels with pure colors are the pixels that do not contain any of the 
background colors. 

You can specify how far within the selection you want the Adobe Photoshop 
program to look for the pixel colors that will be extended outward to replace the 
fringe pixels. In most cases, a distance of one or two pixels is sufficient to locate 
pixels that will effectively remove a fringe. 
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Selecting the non-selected parts of an image

At times, it might be more convenient to select large parts of an image by first

selecting the parts you don’t want to modify, and then automatically selecting

the larger portions of the image. The Inverse command in the Select menu allows

you to do this.

To select the part of the image that is not currently selected, choose Inverse from

the Select menu. The remaining, unselected portion of the image is selected. The

originally selected part of the image is deselected.

 
Removing "fringe” around a selection

User Guide

When you make a selection, some of the surrounding pixels normally are included.

Once you copy the selection and paste it elsewhere, some of the surrounding pixeis

are copied and pasted along with the selection, which is now called a floating

selection. At times, you may want to eliminate the excess pixels, called "fringe,"

around a floating selection. (A floating selection is a selection that was moved or

pasted on in image. It floats above the pixels in the underlying image until you
deselect it.)

For example, if you select part of an image and paste it onto a white background,

you may want to trim the fringe or excess pixels around the selection. The fringe

pixels contain a mixture of the colors in the selection and background colors
around the selection.

The Defringe command in the Select menu allows you to remove the fringe

around a floating selection. The Defringe command replaces the color of the

fringe pixels with the colors of nearby pixels that contain the pure colors in the

selection. The pixels with pure colors are the pixels that do not contain any of the

background colors.

You can specify how far within the selection yOu want the Adobe Photoshop

program to look for the pixel colors that will be extended outward to replace the

fringe pixels. In most cases, a distance of one or two pixels is sufficient to locate

pixels that will effectively remove a fringe.
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To use the Defringe command: 

1. Move the selection that contains the fringe you want to remove to make it a 
floating selection. 

2. Choose Defringe from the Select menu. 

3. Enter a value for the distance used to locate fringe pixels. 

4. Click OK. 

The colors of the fringe pixels are replaced by the color of the pixels within the 
selection. 

Original selection 

Before Defringe Defringe value: 5 

Moving a selection 
You can move a selection around an image by dragging the selection. When you 
drag a selection, its outline remains visible to provide a reference for placing it. 
You can use the Shift key to constrain a selection to 4S-degree increments as you 
move it. You can also automatically create a duplicate of a selection and move a 
selection in I-pixel increments using the keyboard. See the next section "Moving 
a selection in I-pixel increments./J 

Once you move a selection, it covers up the part of the image beneath it. The 
current background color fills the area left by the moved selection. The default 
background color is white; if white is the current background color, the area 
appears to be blank. 
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You can use the paste controls to control the effect of the pixels in the floating 
selection on the underlying image when you deselect the floating selection. See 
Chapter 12, "Cutting and Pasting Selections" for information about using paste 
controls. 

To move a selection: 

1. Click one of the selection tools in the toolbox. 

2. Position the selection pointer on the selection. 

The selection pointer turns into the arrow pointer. 

3. Holding down the mouse button, drag the selection into the position you want it. 

4. When you have moved the selection to the desired position, release the mouse 
button. 

If you drag one selection while there are multiple selections, all of the selections 
follow the movement of the mouse. 

I 
NOTE: If you are using one of the painting or editing tools or the eyedropper tool, you 
can temporarily activate the arrow pointer to move a selection by pressing down the 
Command key and positioning the tool pointer on the selection. 

Moving a selection in l-pixel increments 

118 User Guide 

The arrow keys allow you to move a selection in I-pixel increments. To move a 
selection using the arrow keys, press down the arrow key pointing in the direc
tion you want to move the selection. The selection moves in the direction of the 
arrow key you press. 
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You can use the paste controls to control the effect of the pixels in the floating

selection on the underlying image when you deselect the floating selection. See

Chapter 12, "Cutting and Pasting Selections” for information about using paste
controls.

To move a selection:

1. Click one of the selection tools in the toolbox.

2. Position the selection pointer on the selection.

The selection pointer turns into the arrow pointer.

3. Holding down the mouse button, drag the selection into the position you want it.

4. When you have moved the selection to the desired position, release the mouse
button.

  
If you drag one selection while there are multiple selections, all of the selections
follow the movement of the mouse.

NOTE: ifyon are using one ofthe painting or editing tools or the eyedropper tool, you

can temporarily activate the arrow pointer to move a selection by pressing down tire

Command key and positioning the tool pointer on the selection.

Moving a selection in T-pixel increments

The arrow keys allow you to move a selection in l-pixel increments. To move a

selection using the arrow keys, press down the arrow key pointing in the direc-

tion you want to move the selection. The selection moves in the direction of the

arrow key you press.
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Constraining the movement of a selection 

You can constrain the movement of a selection to a 45-degree angle by pressing 
the Shift key. 

To constrain the movement of a selection to a 4S-degree angle: 

1. Click one of the selection tools in the toolbox. 

2. Position the selection pointer on the selection you want to move. 

The selection pointer turns into the arrow pointer. 

3. Holding down the mouse button, begin dragging in the direction you want to 
move the selection. 

4. Hold down the Shift key. 

The selection moves along a straight line in the direction you drag. 

Selection moved at a 45 0 angle 

5. Release the mouse button and the Shift key when the selection is in the pOSition 
you want it. 

Duplicating a selection 

You can use the Option key to automatically make a copy of a selection as you 
drag it. You can either drag the selection to duplicate it, or press an arrow key. 

To make a duplicate of a selection: 

1. Click one of the selection tools in the toolbox. 

2. Position the selection pointer on the selection you want to duplicate as you move it. 

The selection pointer turns into the arrow pointer. 

3. Press and hold first the Option key, then the mouse button. Drag the duplicate 
to the position you want it. 
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4. When you have positioned the duplicate as desired, release the mouse button and 
then the Option key. 

To create multiple duplicates of a selection using the arrow keys: 

1. Hold down the Option key. 

2. Press the arrow key pointing in the direction you want to project the duplicates 
from the selection. 

Each time you press the arrow key, a duplicate of the selection is created and 
offset by I -pixel from the last duplicate. 

3. When you have finished making duplicates, release the Option key. 

Using alpha channels to alter selections 

120 User Guide 

At times you may want to adjust part of an image while you are working on it. In 
the previous image of a pump in a barn, you might want to edit the wheel on the 
pump or the wooden boards in the barn. To alter the image, you can use the 
Adobe Photoshop program selection tools to select a component of your image, 
and copy it into an individual alpha channel. You create an alpha channel using 
the Selection->Alpha command in the Select menu. 

An alpha channel is a "scratch channel"-essentially a separate, 8-bit gray-scale 
image within a document, used for isolating, modifying, and storing masks. The 
alpha channels and masks you create are saved automatically with a document 
unless you delete them, so you can create and reuse masks for all the components 
of the image you want to edit. For example, you can create a separate mask for 
the wheel and the wooden boards. But note that alpha channels substantially 
increase the disk space required by an image. If you have a shortage of disk space, 
you may want to delete alpha channels before saving your document . 

An alpha channel is one of many types of channels that can comprise an image. 
The Adobe Photos hop program treats images as a series of channels. Bitmapped, 
gray-scale, and indexed color images are Single-channel images. RGB, HSL, and 
HSB images have three channels, and CMYK images have four channels. 
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4. When you have positioned the duplicate as desired, release the mouse button and

then the Option key.

 
To create multiple duplicates of a selection using the arrow keys:

1. Hold down the Option key.

2. Press the arrow key pointing in the direction you want to project the duplicates
from the selection.

Each time you press the arrow key, a duplicate of the selection is created and

offset by l-pixel from the last duplicate.

3. When you have finished making duplicates, release the Option key.

Using alpha channels to alter selections

At times you may want to adjust part of an image while you are working on it. In

the previous image of a pump in a barn, you might want to edit the wheel on the

pump or the wooden boards in the barn. To alter the image, you can use the

Adobe Photoshop program selection tools to select a component of your image,

and copy it into an individual aipha channel. You create an alpha channel using

the Selection—>Alpha command in the Select menu.

An alpha channel is a "scratch channel”—essentially a separate, 8-bit gray-scale

image within a document, used for isolating, modifying, and storing masks. The

alpha channels and masks you create are saved automatically with a document

unless you delete them, so you can create and reuse masks for all the components

of the image you want to edit. For example, you can create a separate mask for

the wheel and the wooden boards. But note that alpha channels substantially

increase the disk space required by an image. If you have a shortage of disk space,

you may want to delete alpha channels before saving yOur document.

An alpha channel is one of many types of channels that can comprise an image.

The Adobe Photoshop program treats images as a series of channels. Bitmapped,

gray-scale, and indexed color images are single-channel images. RGB, HSL, and

HSB images have three channels, and CMYK images have four channels.
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The Adobe Photoshop program lets you view the individual channels of an image 
so that you can work on each channel separately. You can work on just an 
individual channel. You can also create an alpha channel to work on a selected 
part of an image. 

An image can have up to 16 channels per document. The red, green, and blue 
channels are the first three channels of an RGB image; you, therefore, can create 
13 alpha channels. The first alpha channel in an RGB image is labeled 4 at the top 
of the screen because it is the fourth channel. If you create additional alpha 
channels, they will be numbered 5, 6, and so on. 

The section" About channels and image types" in Chapter IS, "Converting 
Images and Working With Channels," discusses channels in greater detail. 

Working on a selection in an alpha channel has several advantages. You can 
easily see a selection independently of the surrounding image, edit the selection, 
and store the selection so that you don't have to reselect it. You can alter a selec
tion in an alpha channel using any of the painting and editing tools . You can 
paint on a selection, change its borders, use filters, and so on. 

By placing a selection in an alpha channel, you create a mask that covers the 
precise area you want to edit; you can then transfer the mask in the alpha channel 
back into the originally selected part of the image to edit the exact area you want. 
In this way, you can easily select and apply changes to specific parts of an image 

. without affecting the rest of the image. 

A mask is similar to a rubylith used to mask a mechanical. The mask floats above 
the underlying image. What you have selected appears transparent over the 
underlying image; the remainder of the mask is opaque. As long as a selection is 
active, it is called a selection mask; once stored in an alpha channel, it is called a 
mask. 

The alpha channel displays a mask as a gray-scale representation. When you view 
the selection mask superimposed on any image, you see only the flickering black
and-white edges of the mask. When you transfer the selection to an alpha channel 
using the Selection->Alpha command, however, you see the selection in white, 
and the rest of the image in black. If the selection is feathered, the feather edge 
will appear as a gray area. 

The black area is masked off from the selection, and is impervious to painting and 
filtering. The gray areas are partially affected by any image manipulations. (The 
partially selected pixels are the pixels with color values that fall within the fuzzi
ness range specified for the magic wand tool, or the pixels that fall within the 
feather radius specified for the selection tool you used.) Only the white selection 
is affected by editing, painting, and filtering. 
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You can think of the black areas as the mask that protects the areas you want to 
remain unaffected by the changes you make. You can use the painting tools to 
apply black paint in the areas you want to include in the mask. The masked areas 
are excluded from the selection and will not be affected by changes you make. 

If you use gray paint in the alpha channel, the areas covered with gray paint will 
be partially transparent to painting or filtering. The degree of transparency 
depends on the gray paint's color level. 

If you want to select all the pixels inside the selection border, you can use the 
eraser tool to convert the non-selected and partially selected pixels to white to 
include these pixels in the selection. The partially selected pixels are partially 
affected by changes you make. How much the pixels are changed depends on the 
extent to which they are selected. The extent to which a pixel is selected is indi
cated by its gray level value. A pixel that is one-half selected has a gray level value 
of 128; this pixel will be affected SO percent by changes you make. 

To create a mask and place it in an alpha channel: 

1. Select the part of the image for which you want to create the mask, using one of 
the selection tools. 

I NOTE: The magic wand tool is especially useful in selecting areas for selection masks 
because it is designed to allow you to select discrete parts of an image. 

2. Choose Selection->Alpha from the Select menu. 

Petitioner Exhibit 1026 Page 146

You can think of the black areas as the mask that protects the areas you want to

remain unaffected by the changes you make. You can use the painting tools to

apply black paint in the areas you want to include in the mask. The masked areas

are excluded from the selection and will not be affected by changes you make.

If you use gray paint in the alpha channel, the areas covered with gray paint will
be partially transparent to painting or filtering. The degree of transparency

depends on the gray paint’s color level.

If you want to select all the pixels inside the selection border, you can use the

eraser tool to convert the non~selected and partially selected pixels to white to

include these pixels in the selection. The partially selected pixels are partially

affected by changes you make. How much the pixels are changed depends on the

extent to which they are selected. The extent to which a pixel is selected is indi-

cated by its gray level value. A pixel that is one-half selected has a gray level value

of 128: this pixel will be affected 50 percent by changes you make.

To create a mask and place it in an alpha channel:

1. Select the part of the image for which you want to create the mask, using one of
the selection tools.

 
NOTE: The magic wand tool is especially usefiil in selecting areas for selection masks

because it is designed to allow you to select discrete parts afar: image.

2. Choose Selection—>Aipha from the Select menu.
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The selected area appears in an alpha channel. The alpha channel is assigned a 
number as its name, which appears in the title bar. 

Mask of selected area 

To define the masked areas: 

1. While still in the alpha channel, select black as the foreground color by clicking 
the foreground color square in either the toolbox or color palette. 

2. ' Select one of the painting tools in the toolbox. 

3. Position the pOinter on the image where you want to start painting. 

4. Hold down the mouse button. 

5. Paint in the white area you want to protect from change. 

Only the white area is affected by the paint, and pixels within the white area will 
be selected. The black area is impervious to paint. 

6. When you have finished painting, release the mouse button. 

7. To copy the mask back to the selection in the image, choose Alpha- >Selection 
from the Select menu. 
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The selection border appears on the image. The changes you now make to the 
image are applied only to the specific areas inside the selection border. 
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The selection border appears on the image. The changes you now make to the

image are applied only to the specific areas inside the selection border.

 

124 User Guide Petitioner Exhibit 1026 Page 148



( \ 

Chapter 10: Using the Fill Tools 

This chapter describes how to use the fill tools, including the paint bucket and 
blend tools, and the Fill command to fill selected parts of an image with the 
current foreground color or with a selected pattern. The paint bucket tool lets you 
fill a selection with the foreground color. The blend tool lets you create gradient 
fills that show a transition from the foreground color to the background color. 
The default foreground color is black, and the default background color is white. 

You can also use the Fill command to fill a selection with a color or pattern, and 
to fill the borders of a selected area. 

Using the paint bucket tool 
Like the magic wand tool, the paint bucket tool includes options for specifying 
how similar the colors of pixels must be to be filled (tolerance), and how much 
anti-aliasing (fuzziness) is applied when a selection is filled. Anti-aliasing pre
vents jagged edges from appearing in a filled selection. You can use the default 
tolerance and fuzziness values in most cases. If you want to change these values, 
you must do so before you use the tool to fill a selection. 

Because you can specify the tolerance value, you can choose the extent to which 
you want the image filled. For example, you can choose either to fill just the dark 
trim of a building, or to fill the building's light-colored walls, as well. 

Specifying the color range (tolerance) for selections 

The paint bucket tool fills pixels that display similar colors. The Tolerance param
eter determines how similar pixels have to be in order to be filled. Specify a low 
value to fill only pixels with very similar colors; specify a high value to fill pixels 
that are dissimilar in color. 
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To specify the color range for the paint bucket using the Tolerance parameter: 

I ~ 11. Double-click or Option-click the paint bucket tool in the toolbox. 

The Paint Bucket Options dialog box appears. 

Paint Bucket Options ... 

Tolerance: 19'"1 
Fuzziness: ~ 

n OK D 
( Cancel) 

2. Enter a value from 0 to 255 for the tolerance level. 

3. Click OK. 

D 

Tolerance value: 15; Fuzziness value: 64 Tolerance value: 150; Fuzziness value: 64 

Specifying the amount of anti-aliasing for the paint bucket 

126 User Guide 

The Fuzziness parameter controls the amount of smoothing, or anti-aliasing, that 
is applied when you make a selection with the magiC wand tool or fill an image 
with the paint bucket tool. You specify the fuzziness for the magiC wand tool and 
the paint bucket tool separately. 
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To specify the color range for the paint bucket using the Tolerance parameter:

1. Double-click or Option-click the paint bucket tool in the toolbox.

The Paint Bucket Options dialog box appears.

Paint Bucket Options...

Tolerance:

Fuzziness: 
2. Enter a value from 0 to 2.55 for the tolerance level.

3. Click OK.

 
    
Tolerance value: 15; Fuzziness vaiue: 64 Tolerance value: 150; Fuzziness value: 64

Specifying the amount of anti-aliasing for the paint bucket

The Fuzziness parameter controls the amount of smoothing, or anti-aliasing, that

is applied when you make a selection with the magic wand tool or fill an image

with the paint bucket tool. You specify the fuzziness for the magic wand tool and

the paint bucket tool separately.
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